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WHAT’S NEW IN GLIMPSEV1.17?

Compared to GLIMPSE v1.0, GLIMPSE v1.1 includes the following major changes:

e The version of GCAM included with GLIMPSE has been updated to GCAM 7.0 from GCAM 5.4. Changes
across GCAM versions are described here: http://jgcri.github.io/gcam-doc/updates.html
e Enhancements to the GLIMPSE Scenario Builder include:
o Inclusion of an updated Reference Case built upon the GCAM-USA 7.0 Reference Case.
o Improvements to the “New Scenario Component Creator” dialog, including providing filtering in

technology selection and dollar-year conversions when specifying subsidies and taxes.
o Miscellaneous bug fixes.
e Enhancements to the GLIMPSE Modelinterface include:
o Reorganization of menus to improve usability.
o Improvements to sorting in the table, including sorting numbers based on their values instead of
strings.
New functionality to convert the units associated with model results.
Updated query file, including a new grouping that makes use of the unit conversions (e.g.,
reporting greenhouse gas emissions in units of mmCO2eq and electricity prices in $/kwh).
o Miscellaneous bug fixes.
e Updates to the GLIMPSE Users’ Guide include:
o Reorganization and inclusion of a List of Tables and a List of Figures.
o Description of the new Reference Case.
o Revised tutorials that reflect the transition to GCAM-USA 7.0 and the updated Reference Case
and that also include an exercise investigating a Net-Zero decarbonization target.


http://jgcri.github.io/gcam-doc/updates.html
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INSTALLATION INSTRUCTIONS

SYSTEM REQUIREMENTS

The GCAM model itself is computationally and memory intensive. At least 16 GB is required, and 20 GB or more is
preferred if state-level renewable portfolio standards are included in scenarios. The hard drive should have at
least 80 GB of free space to accommodate storage of model results and the virtual memory by used GCAM.

Typical runtimes of GCAM-USA range from 30 minutes to several hours, depending on computational power,
memory, and the complexity of the scenarios being simulated.

While GLIMPSE is soon expected to be able to operate on PCs, Macs, and Linux, GLIMPSE is currently available on
Windows PCs only.

The GLIMPSE software is written in the Java programming language and requires the 64-bit version of the Java
Runtime Environment (JRE), version 8, which is also referred to as JRE 1.8. We include Amazon’s Corretto version
of the JRE as part of the GLIMPSE package, although users are able to configure GLIMPSE to use other versions of
JRE 1.8. Note that GLIMPSE will not work with OpenJDK since it does not include the JavaFX library that is used by
GLIMPSE.

INSTALLATION STEPS

Please read these instructions in full before installing.

STEP 1: DOWNLOAD “GLIMPSE-V1.1.ZIP” FROM THE LINK THAT IS PROVIDED BY EPA.

The GLIMPSE package is approximately 1.2 GB in its zipped form.

STEP 2: UNZIP “GLIMPSE-V1.1.ZIP” TO INSTALL THE GLIMPSE PACKAGE.

When selecting a location, it is suggested that you choose a hard disk with fast read/write speeds and at least
several hundred free GB of storage space. Furthermore, since GCAM generates 1 to 2 GB of output with every
execution, it is advisable to select a location that is not automatically backed up. For example, some users have
experienced difficulties when installing GLIMPSE on OneDrive. Finally, the location should not have spaces in any
of the folders that make up its path since these can result in errors in filename parsing within GLIMPSE.

One option is to create the following folders and install GLIMPSE there:
“C:\Users\INSERT_USERNAME\Documents\local_folder\GLIMPSE-v1.1”
For the purpose of these instructions, GLIMPSE is being installed in the following location:

“C:\Projects\GLIMPSE-v1.1”

1 https://docs.aws.amazon.com/corretto/latest/corretto-8-ug/downloads-list.html
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This folder should now include the contents shown in the image below:

Figure i-1: The GLIMPSE folder.

GLIMPSE-v1.1 X + - - X

'C'B' Mew Tl sort == View sae
< v « (5Disk (C:) » Projects » GLIMPSE-v1.1 v G Search GLIMPSE-v1.1 o

amazon-corretto-8.382,05.1-windows-x64-jre GLIMPSE-Modellnterface

Contrib =] options_GCAM-USA-Tpd

Daocs [ZTrun_GLIMPSE_GCAM-USA-Tp0

GCAM-Maodel

GLIMPSE-Data

GLIMPSE-GUI
3 iterns = 0d

When unzipping, please note that various unzip programs treat the root folder of the zipped file differently, and a
common installation issue is the nesting of folders:

“C:\Projects\GLIMPSE-v1.1\GLIMPSE-v1.1"

If this is the case in your installation, please move the contents of the nested GLIMPSE-v1.1 folder
(C:\Projects\GLIMPSE-v1.1\GLIMPSE-v1.1) to the parent folder (C:\Projects\GLIMPSE-v1.1). You can then delete
the nested folder (C:\Projects\GLIMPSE-v1.1\GLIMPSE-v1.1).

STEP 3: TEST THE GLIMPSE SOFTWARE.

To test your installation, start GLIMPSE by double-clicking on “run_GLIMPSE_GCAM-USA_7p0.bat”. A black system
window (also known as the Cmd.exe or DOS window) will appear, and text printed to that window will indicate
that options are being loaded from the “options_ GCAM-USA-7p0.txt” file. Note: additional diagnostic information
will be output to this window during your GLIMPSE session. You can generally ignore this information; however, if
you have issues with GLIMPSE or GCAM, it may be useful for debugging. Closing the Cmd.exe window will
terminate your GLIMPSE session.

Several seconds after the Cmd.exe window appears, the GLIMPSE Scenario Builder will appear. If the GLIMPSE
window does not appear, a common cause is that Windows is preventing execution of the “run_GLIMPSE_GCAM-
USA-7p0.bat” file since execution of “.bat” files can be a security issue. To signal to Windows that it is OK to allow
this file to be run, right-click on the file, choose “properties,” and then check the box next to “unblock execution.”
Then try double-clicking on the file again.
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Once GLIMPSE appears, the Component Library in the top left pane should include a number of scenario

components, and there should be at least one scenario listed in the Scenario Library table at the bottom. If there

are no scenario components, this indicates that the installation was not successful, and that GLIMPSE cannot find

the correct folder.

Figure i-2: The Scenario Builder.

B3 GLIMPSE Scenario Builder

File Edit View Tools Help

Component Library

Search: |

B X O

Create Scenario

Component Name

GLIMPSE-1.1-Ref 2023-11-01: 1510

Compaonent Name Created

Calib-Bio-and-CCS-limits-in-NewEngland.csv 2023-08-23: 13:25

Calib-coal egqu_2020.txt 2023-02-08: 08:45

Calib-LDW-EV-AED2020.cov 2023-02-08: 08:45 Mo content in table

Calib-Lower_Income_Elasticity_Tran.txt 2023-02-08: 08:45

Calib-Lo_alt_biofuel SW.csw 2023-02-08: 08:45

Calib-NE_fixed_nuke_output.csv 2023-02-08: (

Calib-NF_fixed mike outont Thria 2020 csv 2023-02-08 0845
Scenario Library Search: 1 =4 o= B = B O
i ' i =
Scenario Name Created Completed Status ProbMkts Runtime
GCAMT.0 2023-11-01: 1510 2023-11-13: 1322 Success 0 hr 26 min
]

Resources... CPU: 29% | RAM: 16GB Free:50% | Disk: 303GB available | Swap: 18GB Free:45% // Database: database-v1 Size: 10.4GB Used:26%

Next, click on “Tools—>Check Installation” from the main menu bar of the Scenario Builder. When you do this,

GLIMPSE analyzes the options that were loaded from the “options_ GCAM-USA-7p0.txt” file, noting when critical

options have not been specified or where folders specified in the file do not exist.

Then, GLIMPSE checks for a frequent problem when installing updates to GLIMPSE that leads to an incorrect folder

structure. Finally, GLIMPSE checks the JAVA_HOME environmental variable that was specified in
“run_GLIMPSE_GCAM-USA_7p0.bat” to ensure that this version of Java is on the system. The results of these
checks are reported to a popup window. If all checks are successful, the text will include: “Installation appears to

be correct.”
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Figure i-3: Output from the “Check Installation” option.

" Analysis of GLIMPSE setup _ o %

-——--- Analysis of GLIMPSE setup ——-—-

No problems found with parameters or folders.

Mo problem was found with nested GLIMPSE folders.

Your JAVA_HOME folder, CAProjects\GLIMPSE-v1.1\\amazon-cormretto-8.382.05.1-windows-x64-jre, was successfully found.
Installation at location CA\Projects\GLIMPSE-v1.1 appears to be succesful.

------ Check to verify that key files exist as specified --------

XML header file: C:\Projects\GLIMPSE-v1.1\GLIMPSE-GUI\templates\glimpseXMLHeaders_v7p0.txt - true

Tech Bound file: C\Projects\GLIMPSE-v1. \GLIMPSE-GUINtemplatesitech_bnd_list_usa_Tp0.txt - true

Configuration template file: C:\Projects\GLIMPSE-v1. NGLIMPSE-GUN templatest\configuration_GCAM-USA-Tp0_template.xm| - true
Query file: CAProjects\GLIMPSE-v1. \GLIMPSE-Modellnterface\exe\Main_gueries_GLIMPSE-Tpl.xml - true

GCAM executable: C\Projects\GLIMPSE-v1. 1\GCAM-Modelgcam-v7.0\exe\gcam-epa.exe - true

Modellnterface executable: C\Projects\GLIMPSE-v1.1\GLIMPSE-ModelInterface\exe\ORDModelinterface jar - true

-—---- Computer Informaticn -———--—-—--
-- Memory analysis --

Total physical memory: 16.0 GB
Free physical memory: 7.5 GB

-- Disk space analysis --
Total space: 397.2 GB
Free space: 208.0 GB
Total swap space: 25.9 GB
Free swap space: 13.9 GB

-- Processor analysis --
Available processor cores: 8
Current usage: 6.8%

Close

N
As a last step, click on the “results” button, ooo , that is located on the button bar in the Scenario Library area.
After several seconds, the GLIMPSE Modelinterface should appear. The “Scenarios” pane at the top left should
include at least one scenario.
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Figure i-4: The GLIMPSE Modelinterface.

i GLIMPSE Modelinterface [C\Projects\GLIMPSE-v1. 1\GCAM-Model\gcam-v7.0cutput\database-v1]
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Eneray inputs to electricity production
Enerqgy inputs to electridty production (detail)
Energy inputs to refining activities

Technologies
Electridity generation by region (centralized)

Total Collapse

STEP 4 (OPTIONAL): CONFIGURE GLIMPSE TO USE SPECIFIC TEXT AND XML EDITORS

By default, GLIMPSE is configured to use Window’s Notepad application to open text and XML files. Alternatively,
you can specify that GLIMPSE use different applications to open these files. For example, Notepad++ is an open-
source text editor that will automatically color-code and format XML files. To change the specified editors, open

the “options_GCAM-USA-7p0.txt” file and find the lines starting with “textEditor” and “xmlEditor”. Change these to

refer to your preferred applications using the full path to the executable for that software. If you have installed
Notepad++ on your computer, you can also remove the comment symbol, #, from “#textEditor” and “#xmlEditor”

and add it to the start of the prior lines. Lines beginning with “#” will not be read by GLIMPSE.

This change will not take effect until you either restart GLIMPSE or choose “File->Reload Options” from the main

pulldown menu of the Scenario Builder.

NEXT STEPS

At this point, GLIMPSE should be set up correctly on your computer. We recommend reading “Chapter 1:
Overview” and “Appendix A-3: The GLIMPSE Reference Scenario,” then going through the tutorials that are

provided in Appendix B.

If GLIMPSE does not start or you run into additional issues that are not described in these installation instructions,
please see Chapter 5.4 “Troubleshooting” in this document. If your problem cannot be resolved, please contact
Dan Loughlin at Loughlin.Dan@epa.gov with a detailed description of your problem and a summary of the

approaches you have taken to solve it.
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CHAPTER 1. OVERVIEW

GLIMPSE is a decision support tool being developed at the U.S. EPA to assist the EPA, states, and others with long-
term climate, environmental, and energy planning. GLIMPSE is an acronym for the “GCAM Long-

Term Interactive Multi-Pollutant Scenario Evaluator,” where GCAM is the “Global Change Analysis Model.” GCAM,
a human-Earth systems model developed by Pacific Northwest National Laboratory (PNNL), simulates the co-
evolution of the economy, energy, water, land use, and climate systems, including how this co-evolution is shaped
by policy and other external factors. GLIMPSE acts as a graphical user interface for GCAM.

Using GLIMPSE, decisionmakers and analysts at the national, regional, and state levels can examine potential
policies, investigate the impacts of emerging technologies, develop cost-effective strategies for meeting air
pollutant and greenhouse gas (GHG) mitigation targets, and explore the tradeoffs at the nexus of energy, water,
and land use. Additionally, GLIMPSE can be used in a classroom setting, providing students with the ability to use a
state-of-the-art human-Earth systems model to explore policy options or investigate alternative scenarios of the
future.

1.1 BACKGROUND

GLIMPSE can be used with GCAM or with variants of GCAM that have additional spatial resolution, such as GCAM-
USA, which represents the U.S. energy system at the state level.

Among the attributes of GCAM (and GCAM-USA) that led to its inclusion in GLIMPSE are:

e spatial coverage and resolution (global, with available state-level resolution for the U.S.), allowing
examination of national and state actions in a global context;

e temporal range and resolution (2010-2100 in 5-year increments by default), supporting long-term air-
climate-energy planning;

e runtime of 30 minutes to several hours, depending on which policies are included in the simulation,
facilitating sensitivity and scenario analyses;

e input and output formats that are amenable to integration with a user interface;

e emission outputs including both GHGs (CO2, CH4, N20O, HFCs and CFCs) and traditional air pollutants (NOx,
S0, CO, PMyz;s, VOCs, and NHs), covering major pollutants of concern in the US;

e characterization of water supply and demand across sectors, allowing investigation of water-energy-land-
agricultural dynamics in the context of a changing climate;

e no requirement for specialized hardware or proprietary software, thus lowering the barriers for adoption,

e the GCAM source code and data, both of which are regularly updated, existing in the public domain and
freely available, promoting transparency; and

e the model’s primary developers, the Joint Global Change Research Institute (JGCRI) of PNNL, provide
model documentation, have helped cultivate a broad user community, and hold an annual modelers’
workshop.
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JGCRI makes versions of GCAM and GCAM-USA available via GitHub.? Documentation is also available, and

tutorials and training are provided at annual GCAM Community Modeling Meetings.>*

We have adopted a publicly available versions of GCAM 7.0 and GCAM-USA 7.0 for use in GLIMPSE v1.1. GLIMPSE
v1.0 supported a modified version of GCAM-USA 5.4. Updating to 7.0 allows GLIMPSE users to take advantage of
many improvements, such as: emission factors updates; inclusion of direct air capture as a mitigation option;
improved representations of natural gas trade and hydrogen production; and an updated climate module.

Additionally, the GCAM 7.0 has a smaller memory footprint, and solver improvements have reduced runtime and

improved robustness.

Figure 1.1: GCAM inputs, outputs, and major components.

GCAM includes representations of energy, water, land use, agricultural, and climate systems, simulating their co-

evolution.
. GCAM
Scenario Outputs
assumptions Energy

Economic
growth

Resource
availability

Climate change

Technology
development

Behavior and
preferences

Policies

Simulates the co-evolution of these systems through time

Technology penetrations

Economic

Land and food prices

Climate

GHG emissions

Environmental

Air pollutant emissions

Water use

Health impacts

1.2 MOTIVATION

1.2.1 THE ENERGY SYSTEM

Understanding energy system concepts and terminology is important for understanding how GLIMPSE and GCAM-

USA can be used to explore GHG mitigation strategies, air pollution control strategies, and strategies for meeting

climate and air quality goals simultaneously.

2 https://github.com/JGCRI/gcam-core

3 http://jgcri.github.io/gcam-doc/

4 https://gcims.pnnl.gov/community
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In the context of GLIMPSE, the term “energy system” refers to all processes and fuels that extend from:

e importing or extracting raw forms of energy (e.g., crude oil, coal, natural gas, uranium, and wind);

e converting (e.g., in refineries and power plants) those raw forms of energy into useful forms of energy
(e.g., gasoline, diesel, and electricity); and

e applying useful energy to meet end-use energy service demands (e.g., passenger and freight travel, space
conditioning, water heating, and lighting).

The figure below shows a depiction of these components:

Figure 1.2: Schematic of the energy system.

The energy system extends from the import or extraction of primary energy, through its processing and conversion
into useful forms, through its use in meeting final end-use energy demands. In the figure below, the colored arrows
begin at the primary energy source and change colors to indicate that they have been transformed to a form of
final energy. Some primary energy sources, such as fossil fuels, are both consumed directly by end users and
transformed to other forms of energy.

Primary Processing and conversion of energy carriers Final energy
energy A .
/_/% r 7\'
.
E =Rt
Xé: Refining & Processing Transportation
Fossil Fuels ‘
=¥ S R =
- & ) =
=il s

Gasification  combustion-Based H,Generation

Electricity Generation

Conversion &

1ru"l

r )

Enrichment Carb Commercial
arbon
Sequestration
Bx +-—>
o > | >
Wind, Solar, LTS -
Hydro Direct Electricity
Generation Industry

Several important terms used when describing the energy system are defined below:

e  Primary, secondary, and tertiary energy. Primary energy is in the raw form in which it is first accounted for
in a statistical energy balance before any transformation to secondary or tertiary forms occurs. For
example, coal can be converted to synthetic gas, which can be converted to electricity; coal is primary
energy, synthetic gas is secondary energy, and electricity is tertiary energy. (Source: EIA)

e Final energy. The energy that is consumed by end-users, including for transportation, residences,
commercial buildings, and industry. Examples include electricity, gasoline, and natural gas.
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e Useful energy. The portion of final energy that is used to meet energy services. This portion does not
include energy that is wasted due to factors such as plug loss, leakage, and waste heat.

e Rejected energy. Energy that is lost through inefficiencies such as line loss, plug loss, leakage, and waste
heat.

e Energy services. Activities that require energy, including space conditioning, water heating, lighting, and
passenger and freight transportation. Energy services can be expressed in units of energy (e.g., exajoules),
but are also often expressed in physical units, such as lumens in lighting and passenger-km for travel.

As energy is transformed through the energy system, there are inherent inefficiencies and losses. In the U.S., the
quantity of useful energy is less than the quantity of rejected energy, as shown in the Sankey diagram below.

Figure 1.3: Energy flows and consumption in the U.S. in 2021.

This Sankey diagram tracks the flow of energy through the U.S. energy system, including useful and wasted energy.
Source: LLNL
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1.2.2 ENERGY AND THE ENVIRONMENT

The energy system has many intersections with the environment. For example, based on the 2021 EPA Inventory
of Greenhouse Gas Sources and Sinks, energy supply and use are responsible for more than 97% of U.S.
anthropogenic COz emissions and 82% of overall U.S. anthropogenic GHGs.> As a result, the energy system is a
major focus of climate action at the state and federal levels, including in the climate action plans enacted by more

5 https://www.epa.gov/system/files/documents/2023-04/US-GHG-Inventory-2023-Main-Text.pdf
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than half of states® and in federal regulations such as the Corporate Average Fleet Efficiency standards for onroad
vehicles.”

Energy is also a source of air pollutants. According to the EPA’s National Emission Inventory (NEI), the energy
system contributes 91% of U.S. anthropogenic NOx emissions, 75% of SOz, 74% of CO, 45% of VOCs, and 22% of
directly emitted fine PM in 2021.2 Combustion of fossil fuels is the main contributor to most of these emissions,
although natural gas leakage, evaporative processes, and cement and fertilizer production contribute as well.

Despite significant improvements in air quality over the past decades, more than 121 million people in the U.S. are
estimated to live within areas that exceed one or more National Ambient Air Quality Standards (NAAQS).® Thus,
reducing the contribution of the energy system to air pollutant emissions is a priority for agencies such as the U.S.
EPA.

6 https://www.c2es.org/document/climate-action-plans/

7 https://www.nhtsa.gov/laws-regulations/corporate-average-fuel-economy

8 https://www.epa.gov/air-emissions-inventories/air-pollutant-emissions-trends-data
% https://www3.epa.gov/airquality/greenbook/popexp.html
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Figure 1.4: Map of U.S. non-attainment areas.

Shaded counties did not attain one or more National Ambient Air Quality Standards as of Sept. 30", 2023. Source:
EPA Greenbook (https://www3.epa.gov/airquality/qreenbook/popexp.html)

Counties Designated "Nonattainment"
for Clean Air Act's National Ambient Air Quality Standards (NAAQS) *

'GU

Legend **

[ County Designated Nonattainment for 6 NAAQS Pollutants
County Designated Nonattainment for 5 NAAQS Pollutants
County Designated Nonattainment for 4 NAAQS Pollutants

|| County Designated Nonattainment for 3 NAAQS Pollutants
County Designated Nonattainment for 2 NAAQS Pollutants
County Designated Nonattainment for 1 NAAQS Pollutant

* The National Ambient Air Quality Standards (NAAQS) are health standards for Carbon Monoxide,
Lead {1978 and 2008), Nitrogen Dioxide, 8-hour Ozone (2008), Particulate Matter (PM-10
and PM-2.5 (1997, 2006 and 2012), and Sulfur Dioxide (1871 and 2010)

** Included in the counts are counties designated for NAAQS and revised MAAQS pollutants.
Revoked 1-hour (1979) and 8-hour Ozone (1997) are excluded. Partial counties, those with part
of the county I d i and part i are shown as full counties on the map.

Environmental impacts associated with energy are not limited to climate and air quality. In the U.S., freshwater
withdrawals for thermoelectric power plant operations in 2015 were nearly as great as those of agriculture, 41% vs
42%.1° As a result, cooling water requirements make the energy system susceptible to droughts. Furthermore,
used cooling water is typically discharged into rivers or lakes. Drought and high ambient temperatures can limit the
ability of these bodies to absorb additional heat without damaging sensitive aquatic ecosystems. These conditions
can result in the temporary shutdown of thermal generating capacity if the Total Maximum Daily Load (TMDL)

10 https://pubs.usgs.gov/fs/2018/3035/fs20183035.pdf
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limits for a discharge body are exceeded.!! Energy is also a major source of solid and liquid waste. Electricity
production, for example, was responsible for 450,000 tons of solid waste in 2019.%2

1.2.3 ENVIRONMENTAL MANAGEMENT

The traditional approach for addressing the environmental impacts of energy production and use has been to use
control devices to capture pollutants from exhaust gases and liquid waste streams. While pollution controls are
responsible for much of the environmental progress that has been made to date, controls can result in important
tradeoffs among pollutants and media. For example, scrubbers that remove SOz from exhaust gases generate a
liquid waste stream that must be treated. Also, carbon capture devices that remove CO; from an exhaust stream
are energy intensive; by requiring more fuel, pollution associated with coal and gas production may increase.

Non-traditional control options include reducing demands for energy through energy efficiency, switching to fuels
with lower emissions intensity, and the combination of electrifying end-use technologies in transportation and
buildings while simultaneously shifting electrification to clean sources. An important aspect of many of these
management strategies is that they have the potential to benefit climate and environmental endpoints
simultaneously.

Some non-traditional measures can result in changes in the types and locations of pollutants that are emitted. For
example, while considered to be a low-carbon fuel, biomass can have high air pollutant emissions, and there are
emissions associated with the manufacturing of batteries, solar panels, and wind turbines. There can also be cross-
sector interactions. For example, depending on how electricity demands are met, electrification can increase
electric sector emissions, as well as the emissions associated with natural gas production and transportation. Shifts
in energy supply and demand can also result in price-induced fuel switching in other sectors.

In this complex landscape, it is important for policymakers to be able to:

e quantify the benefits and co-benefits associated with various management options;

e understand cross-sector interactions, tradeoffs, and potential unintended consequences;

e evaluate how uncertainty in future conditions may present opportunities or challenges for climate action
and environmental management; and

e identify management options that are cost-effective and robust through approaches such as scenario
analysis.

Addressing these needs is the objective of the GLIMPSE project at the U.S. EPA.

1.3 GCAM-USA

The computational engine for GLIMPSE is GCAM. GLIMPSE v1.1 supports both GCAM 7.0 and GCAM-USA 7.0. This
Users’ Guide focuses on GCAM-USA, a version of GCAM that includes state-level resolution of the U.S. energy

1 hitps://www.epa.gov/tmdl/overview-total-maximum-daily-loads-tmdls
12 https://www.epa.gov/trinationalanalysis/electric-utilities-waste-management-trend
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system. GCAM-USA version 7.0 covers a time horizon of 2015 through 2100, with annual outputs that are reported
in 5-year time steps.

In GCAM-USA, the 50 U.S. states plus the District of Columbia are explicit regions that operate within the global
GCAM model. Energy transformation (electricity generation and refined liquids production) and end-use demands
(buildings, transportation, and industry) are modeled at the state resolution. Interstate trade of all energy goods is
simulated, and state-specific consumer price mark-ups assigned for coal, natural gas, and refined liquids are based
on price data from EIA 2017b.%3

Note that several aspects of the energy system are not disaggregated to the state level. Most notably, this applies
to primary production of fossil resources, including oil, gas, and coal, and to agriculture. The supply of biomass
energy feedstocks, which include residues and dedicated energy crops, is modeled at the level of 22 water basins
in the United States.**>% However, GCAM-USA tracks the carbon uptake associated with biomass growth at the
state level. See Section 4.4 for a description of biomass flows and the associated CO2 accounting.

13 https://jgcri.github.io/gcam-doc/gcam-usa.html#eia2017b
14 calvin et al. 2019

15 calvin et al. 2014

16 Wise et al. 2014
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Figure 1.5: GCAM Global Regions and GCAM-USA States Map.

Source: PNNL.
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Attributes of GCAM-USA are summarized in the table below:

Table 1.1: Summary of GCAM-USA attributes and links to documentation and source code.

See Chapter 5.5 “Glossary” for definition of abbreviations.

Attribute

Description

Type

Technology-rich, market-based human-Earth systems model

Solution approach

Partial equilibrium (GDP is determined exogenously)
Nonlinear programming to identify market clearing prices for all markets
Myopic (no foresight to future time periods)

Dynamic recursive (each time step starts with the prior time step’s solution)

Economic choice

Market shares of competing technologies are determined using a logit function,
which considers the relative costs of technology options, technology-specific
shareweights (representing bias, consumer preferences, and other factors that are
not modeled explicitly), and a logit exponent (reflecting the degree to which
differences in cost among technologies impact choices)
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Attribute

Description

Temporal coverage

2015-2100 (although typically run to 2050 in GLIMPSE applications)

Temporal resolution

5-year timesteps (although alternative values, including annual are possible)

Spatial coverage

Global

Spatial resolution

Energy and economic: 32 global regions, with the U.S. disaggregated by state

U.S. electric grid: 15 regions, similar to the NERC regions, but following state
boundaries

Water and land use: 235 regions, based on water basins

Sectoral coverage

Resources (extraction and mining), refining (oil and biomass), electricity production
(fossil and renewables), industry (manufacturing, non-manufacturing, and
nonroad), commercial, residential, passenger travel (onroad, air, rail), freight travel
(truck, rail, marine), and agriculture (livestock, poultry; biomass for energy, food,
feed)

Pollutant coverage

GHGs and SLCPs: CO2, CHa4, N20, BC, OC, HFCs
Air pollutants: NOx, SOz, CO, NHs, VOC, PM1o, PM2s

Policy representations

Emission taxes and caps, technology and fuel taxes and subsidies, technology
capacity and market share targets, and clean electricity and renewable portfolio
standards

Implementation

Model coding: Object-oriented C++
Data system: CSV tables that are converted to XML input files using R

Platforms

Windows, Apple, Linux (including high performance clusters)

Note: To date, GLIMPSE has only been tested on the Windows platform.

Computing requirements

At least 12 GB of RAM and 80 GB of free disk space are needed for core GCAM. 16
GB or more of RAM is required for running GCAM-USA via GLIMPSE, and we have
found that 20 GB or more is preferred state-level renewable portfolio standards are
included in scenarios.

Runtime

15 minutes to several hours on a typical desktop Windows computer, depending on
on the computer’s specifications (e.g., RAM and disk space) as well as the policies
and other modifications that are included in the scenario.

Source code and data

https://github.com/JGCRI/gcam-core (Open source)

Documentation

GCAM 7.0 documentation: http://jgcri.github.io/gcam-doc

GCAM Developer’s Guide: http://jgcri.github.io/gcam-doc/dev-guide.html

1.4 COMPONENTS OF GLIMPSE

GLIMPSE serves as a graphical interface to GCAM and GCAM-USA. We refer to both versions of the model as
“GCAM” from here on unless clarification is necessary. The graphical interface consists of two primary
components, the GLIMPSE Scenario Builder and the GLIMPSE Modelinterface.
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The Scenario Builder allows users to alter input assumptions and construct policy scenarios, as well as to manage
the execution of GCAM. Through its New Scenario Component Creator, users can construct GHG targets, sectoral
emission caps, technology subsidies, clean energy standards, electric vehicle market penetration targets, and
modify assumptions about technologies. The GLIMPSE Modelinterface builds upon the Modellnterface that PNNL
distributes with GCAM, providing additional capabilities for filtering, visualizing, analyzing, comparing, and
exporting model results. In this Users’ Guide, we refer to the GLIMPSE Scenario Builder and the GLIMPSE
Modelinterface as the Scenario Builder and Modellnterface, respectively.

These components are described and demonstrated in the tutorials included in Appendix B. Attendance of
GLIMPSE training sessions is highly recommended for those who are considering using GLIMPSE for their
applications.

1.5 DESIGN PHILOSOPHY

GLIMPSE has been developed to meet the needs of both experienced GCAM users and those who are new to
GCAM. For experienced users, the Scenario Builder will enhance their typical GCAM workflow by organizing a
library of scenarios and scenario components, managing single and batch execution, providing quick access to logs,
and archiving the files that are specific to a scenario. GLIMPSE also automates some activities that would be
tedious even for an experienced user, such as developing policy “add-on” files that implement an emissions cap,
clean energy standard, market share target, or tax or subsidy over a group of states.

Those who are new to GCAM will benefit by being able to rapidly set up, execute, and examine the results of
scenarios. Furthermore, conversations with prospective GCAM users have helped us identify and implement the
scenario “levers” that address many of their modeling needs, and these levers have been added to GLIMPSE. While
GCAM still has a substantial learning curve, GLIMPSE can address many of the barriers that new users face.

When GCAM'’s execution of a scenario begins, the model reads a configuration file which specifies many aspects of
the run, such as the number of time periods to simulate, the name of the output database into which results will
be placed, and which scenario components will be included. Scenario components are eXtensible Markup
Language (XML)-formatted files that provide the data used by the model, including parameterizations of the
electricity production, refining, industrial, commercial, residential, and transportation sectors. Scenario
components can also include representations of policies or alternative assumptions about technologies,
population, and GDP growth.

To simulate an alternative scenario, different or additional scenario components can be included in the
configuration file. The order in which these “add-on” scenario components are listed is important: if a parameter
value occurs in several scenario components, the last value overrides prior values. Thus, policies or alternative
assumptions about technologies typically can be specified in “add-on” files that are listed at the bottom of the
scenario component list.

GLIMPSE supports this workflow. GLIMPSE includes a template configuration file. Through the Scenario Builder the
user can easily create a scenario based on this template, modified to reflect the user’s choices of output database,
years to simulate, etc. Furthermore, the user can add new scenario components by selecting them from a
Component Library. The resulting scenario can then be saved to a Scenario Library. Scenarios in the library can be
executed individually or in batches, and the status of each is displayed.
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Figure 1.6: The GLIMPSE Scenario Builder.

The Scenario Builder facilitates development and execution of scenarios.
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GLIMPSE simplifies the process of creating add-on scenario components. GCAM modelers typically create add-on
files in one of several ways. Simple scenario components are often created by a user in a text or XML editor.
However, constructing complex scenario component files in this manner can be very tedious. Instead, GCAM
modelers often use a two-step approach. First, a table of data is saved as a CSV file. A header file defines how the
tabular data in the CSV file is to be converted to XML by the “CSVtoXML.jar” Java program that is integrated into
the Modelinterface. Even this process can be time consuming if there are many technologies or regions that are
being affected. For example, a state-level renewable portfolio standard CSV file may require hundreds of

thousands of rows.

The Scenario Builder includes a New Scenario Component Creator that provides an alternative way to construct
add-on files. Using this feature, users can implement a variety of policies and introduce alternative assumptions
about technologies and fuels. These modifications can easily be applied to a single region or to a group of regions.

Among the options available include:

e pollutant taxes or caps, introduced for a single sector or economy-wide;

e technology market share constraints as a fraction of new sales or of total stock;

e technology availability, including first and last year available;

e technology-specific taxes and subsidies;

e adjustments to consumer preferences via the share weight parameter; and
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e fuel price adjustments.

GLIMPSE automates the process of generating the appropriate CSV file, selecting the matching header, then
executing “CSVtoXML.jar” to produce the corresponding XML.

Figure 1.7: The New Scenario Component Creator.

This dialog allows users to create their own Scenario Components, including implementations of policies and
alternative assumptions about technologies.
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GLIMPSE also supports exploration of model results through the Modelinterface. With this tool, users can extract,
filter, rapidly visualize, and compare many outputs across regions or scenarios.

The Modelinterface uses queries to extract data from the GCAM output database. We have organized the query
list such that those queries that are anticipated to be of greatest utility to GLIMPSE users are grouped at the top.
Hovering the mouse over these queries will produce a “tooltip” that includes a brief description of the query. In
addition, the first query group “Converted Units” provides results for several of the most popular queries in units
that may be more meaningful for some users in the energy and air quality management fields (e.g., mmCO2eq
instead of MTC; kWh instead of EJ; short tons instead of metric tonnes; and 2020Ss instead of 1975Ss). In the
future, we plan to support additional types of graphics in the Modelinterface, including maps and Sankey diagrams.

While some graphical capabilities are provided by the ModelInterface, users can also readily export data for
analysis using other tools. For example, open query results can be saved to comma-separated-value (CSV) files.
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Alternatively, users can drag a table into Excel by dragging the tab associated with the table into an open Excel
workbook or copy the data from specific rows onto the operating system’s clipboard by selecting the rows and
pressing “Cntl-C”.

Figure 1.8: The GLIMPSE Modelinterface.

The Modelinterface supports exploratory investigation of GCAM results, including visualization and examining the
differences in model outputs from one scenario to another.
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One of the most powerful features of the Modellnterface is the “Diff Query”. With this feature, GLIMPSE users can
identify the model outputs that change more than a specific amount or percentage from one scenario to another.

1.7 ORGANIZATION OF THIS USERS’ GUIDE

This Users’ Guide includes installation instructions, a brief overview of how GCAM works, instructions on
performing common tasks, additional information for advanced users, descriptions of the components of the
graphical user interface, a trouble-shooting section for common problems, a glossary for key terms and acronyms,
a description of the GLIMPSE Reference Scenario and key results, and a multi-part tutorial.

1.8 GLIMPSE VERSION

This Users’ Guide has been developed specifically for GLIMPSE v1.1. If you are using a different version of GLIMPSE,
some of the information provided here may no longer be accurate. Furthermore, this User’s Guide will evolve as
users report their experiences.

GLIMPSE currently incorporates GCAM 7.0, which was released in the summer of 2023. GCAM releases typically
occur at least once per year. See https://github.com/JGCRI/gcam-core/releases for information on each GCAM

release, including new features.
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Future versions of the Users’ Guide will include information on how to update GLIMPSE to work with other
versions of GCAM. In general, updating can be straightforward, but changes to the model or technology names can
require non-trivial changes to GLIMPSE setup files and code.

1.9 ANOTE ON UNITS

As a result of GCAM'’s origins in GHG emission projections and climate analyses, the units in GLIMPSE and GCAM
may be different than those typical for applications in the air quality and energy fields, particularly in the U.S.

e  Metric units are used in all instances. In this documentation, we refer to metric tons as “tonnes”.
However, in the GCAM outputs, “tons” is used.

e  Energy values are typically provided in Exajoules, which are joules x 10718. For reference, one EJ is
277,778 Gigawatt hours (GWh) or 277.778 Terawatt hours (TWh). To put these values in context, the US
power sector produced approximately 16 EJ of electricity in 2020, and the onroad transportation sector
used approximately 21 EJ of gasoline, diesel, and ethanol in the same year.

e  Where CO: outputs are presented in the Modelinterface, these are in units of million metric tonnes of
Carbon, or MTC. To convert MTC to MTCO2, multiply by the ratio 44/12, which is based on the relative
molecular weights of CO2 (44) and C (12).

e Air pollutant emissions are reported in tera-grams (Tg), or grams x 10712. A Tg is equivalent to a million
metric tonnes, or a MT. One MT is equivalent to 1,102,310 US short tons.

e The $S-years for monetary values are different than today’s Ss, resulting in the need to adjust for inflation
when interpreting results.

o Prices and costs typically are reported in 19905Ss.
o Technology taxes and subsidies are represented in 1975Ss per unit of output
o Based on the Consumer Price Index,
= $1in1975Ssis equivalent to $2.40 in 1990Ss
= $1in1975Ss is equivalent to $5.66 in 2023Ss
= S$1in1990Ss is equivalent to $2.34 in 2023Ss.
e Travel demands are represented in million passenger-km or million tonne-km.

Note: The Modelinterface’s unit conversion features may be useful to many users for translating units to those
more commonly used in their work. Please see Section 3.18 for a discussion of this feature and examples. Also, the
Scenario Builder has been modified to allow users to specify taxes and subsidies in other dollar years (e.g., 20155s
or 2020Ss).

1.10 INTERPRETING GCAM RESULTS

While GLIMPSE simplifies tasks such as developing policy scenarios, executing GCAM, and analyzing results,
GLIMPSE users should keep in mind that neither it nor the underlying GCAM model, are commercial products.
Documentation is available, but support is limited. As of December 2023, GLIMPSE had been tested by users within
and outside the U.S. EPA, including having been used in four semesters of a graduate-level course on Integrated
Assessment Modeling. Nonetheless, there may be bugs or other issues with the software. Please consider
reporting back your experiences, feature requests, comments, and suggestions to glimpse@epa.gov or Dan
Loughlin (Loughlin.Dan@epa.gov) such that these can be considered as GLIMPSE development continues.
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Users should not expect GLIMPSE to provide “turnkey” answers. Analyses with tools such as GLIMPSE and GCAM
are iterative processes, with each iteration providing additional information about the problem, potential
solutions, and the representation of these in the model. It is common to make refinements to scenario
assumptions and policy implementations as part of this iterative process.

GCAM is a complicated model. Applying it for research and policy analyses requires experience and skill that takes
time to develop. For example, when assessing model results, it is recommended that users look beyond the high-
level results (e.g., whether emissions went up or down) and examine the detailed fuel- and technology-level
outputs, asking questions such as “Do these responses make sense?”, “Is this result reasonable, or did | uncover a
response that arose because the scenario pushed the model in a new direction?”, “How did limitations in the
model formulation affect this result?”, and “How were the results impacted by calibration to historical data or by
assumptions about future conditions?” Sensitivity analysis is encouraged, which will indicate how the model’s
results change in response to incremental perturbations in key input parameters.

To begin the process of learning how GCAM operates, we highly recommend that users read the “How does GCAM
work?” portion of this Users’ Guide, which includes information about the operation of markets, the logit function,
shareweights, and model calibration. We encourage GCAM-USA users to become familiar with the GCAM
documentation,’ and, in particular, the section on economic choice.*®

When presenting model results, it is important to avoid statements such as: “If policy X is implemented, Y will
happen.” Thus, to properly present and caveat findings, it is important for analysts to understand the operation of
the model, key assumptions, and limitations. Results are contingent on many factors, including the assumptions
about population growth and migration, economic growth, technology costs and efficiencies, climate change, and
human behavior and choices. Predicting these factors into the future is inherently uncertainty. Additionally, while
the logit algorithm that predicts market shares has been calibrated to past decisions, real-world human decision-
making involves many considerations beyond the relative costs of competing options.

While a Reference Case is included with GLIMPSE, it is provided for convenience and its inclusion does not imply
endorsement. In particular, GLIMPSE does not include the full set of environmental and energy policies that will
impact the evolution of the energy system into the future. GLIMPSE users may need to tailor scenarios to meet the
specific needs of their analysis.

When applying GCAM to particularly challenging policy scenarios (e.g., a Net-zero CO; target or to specific GHG
emissions targets), users should think holistically about the scenario and how Reference Case assumptions may
shift under such a target. For example, users may want to modify shareweights for electric vehicles to reflect
conditions that are not simulated by GCAM, such as the investment and build-out of a charging infrastructure. The
process of developing deep decarbonization scenarios, and others that diverge significantly from historic and
Reference Case conditions, may involve many such considerations.

1.11 KNOWN BUGS, LIMITATIONS, AND OTHER CONSIDERATIONS

GLIMPSE users should take note of the following.

17 http://jgcri.github.io/gcam-doc/toc.html
18 hitp://jgcri.github.io/gcam-doc/choice.html
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Unexpected termination — GCAM will occasionally terminate unexpectedly, reporting that the run did not
finish, “DNF”, to the Scenario Builder. There are several causes, including the computer’s available resources
being exhausted (e.g., RAM or disk space) and conflicts in the names of markets or policies. While we have
built tools into the Scenario Builder to avoid and help deduce the cause of these problems, some level of
“debugging” by users may be required. See Section 3.16 for more information.

Numerical issues — With GCAM'’s global coverage and representation of thousands of markets of diverse sizes,
the model’s solver must deal with numbers that vary greatly in magnitude. At the same time, the model takes
advantage of the multi-threading capabilities of modern computers to parallelize computations, reducing
runtime. However, parallelizing computations introduces small numerical errors that can sometimes lead to
the problem of “Unsolved Markets.” This Users’ Guide includes information about how unsolved market
messages can be interpreted and how to avoid numerical issues by turning off parallel computation or
adjusting the solver parameterization. See Section 4.3 for more information.

Transportation constraints — For legacy reasons, GCAM’s units used in internal calculations for the
transportation sector are million British Thermal Units, or MMBtu. One MMBLtu is equivalent to 1.054e-9 EJ.
The conversions required result in transportation policies and constraints being particularly prone to
numerical issues. While we have attempted to address these through scaling during new scenario component
creation and through modifications to the solver settings, some numerical issues may arise, particularly in
transportation market share scenarios.

Output database size limitations — GCAM uses the BaseX database software for storing model results. We have
found the BaseX software to be unable to open databases that exceed approximately 40 GB in size. For GCAM-
USA, this is the equivalent of 15 to 20 results. Once the database is too large to be opened, the data inside is
lost. We recommend that users pay particular attention to database sizes and to information in Section 3.5 of
this Users’ Guide about how to monitor database size, export and import results from a database, and create
new databases.

Modelinterface freezes — There are instances when the Modelinterface freezes. When this occurs, users can
terminate the Modelinterface task without terminating GLIMPSE by using the Windows Task Manager. See
Section 5.4 for instructions on terminating the ModelInterface when it is frozen.

Boundaries on system representations — In a complex model such as GCAM, decisions must be made by the
developers regarding where to draw the boundaries for various systems represented in the model. These
decisions are often impacted by factors such as data availability and computation requirements. Knowing
where these system boundaries are is important in understanding the responses of the model to policies and
other perturbations. An example is related to transportation of biomass. GCAM-USA 7.0 includes state-level
demands for freight travel via truck, rail, and marine vehicles. However, these freight demands are not
connected to the production of specific goods. As a result, a large increase in the demand for biomass would
not in GCAM result in a change in freight activity.

Feedbacks — In the real world, there are feedbacks that may impact the co-evolution of the economic, energy,
agricultural, land use, water, and climate sectors. For example, climate impacts may change the availability of
water, which would impact agricultural and energy choices. These would have ramifications for the economy.
While some feedbacks are incorporated in research versions of GCAM, they were not been included in the
publicly released version of GCAM-USA 7.0.

Myopic solution process — GCAM is a dynamic recursive simulation model. This means that the model steps
through time, using the solution from the last modeled time period as the starting point for the current time
period. Markets are solved in the current period by considering conditions in that period, but not taking into
consideration future conditions. As a result, GCAM'’s solution process cannot anticipate conditions in future
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time periods, such as the planned tightening of a carbon cap over time. As a result, the model may make
decisions in the short term that are not optimal from a long-term perspective.

e (Calibration — GCAM uses a logit function to assign market share to competing technologies. The parameters
used in the logit function for many technologies and markets are determined based upon conditions in the
calibration year, which is 2015 in GCAM-USA 7.0. For new and emerging technologies, these parameters are
based upon assumptions about the speed at which barriers and biases will be addressed. As a result, choice
function parameterization may not reflect behavior in the future, particularly for deep decarbonization
scenarios that differ significantly from historical decisions and Reference Case assumptions. Please see Section
4.5 for a discussion of adjustments that are recommended for consideration when modeling deep
decarbonization scenarios.

e Query results for the USA region — In GCAM-USA 7.0, most US sectors have been disaggregated to the state
level. Thus, state-level queries are used to obtain information about technology shares, fuel use, and
emissions in buildings, industry, and transportation. In contrast, the USA region of GCAM-USA predominantly
includes categories that are represented at the water basin level, such as water supply, agriculture, and other
land uses. The USA region also includes several industries that have not yet been disaggregated to the state
level, including coal mining and oil and gas production. Users should note that queries of the USA region in
GCAM-USA will not produce national totals. To obtain results for the U.S., select all states and the USA
region. To produce national totals, the “Total” check box will sum across all selected regions.

e This work was conducted under an approved Quality Assurance Project Plan (QAPP) that was developed in
accordance with guidance provided in EPA ORD’s quality assurance requirements for modeling and software
development. The QAPP ("GCAM-based Long-term Interactive Multi-Pollutant Scenario Evaluator (GLIMPSE),"
J-AESMD-0033472-QP-1-0) was approved by EPA prior to the initiation of GLIMPSE development.

1.12 WHERE TO LEARN MORE ABOUT GCAM AND GLIMPSE

If you would like to know more about GCAM, please see the model’s online documentation. Important links
include:

General GCAM documentation, including for the latest public release:

e  http://jgcri.github.io/gcam-doc/

GCAM-USA documentation:

e  http://jgcri.github.io/gcam-doc/gcam-usa.html

GCAM Users’ Guide:

e  http://jgcri.github.io/gcam-doc/user-guide.html

GCAM Discussions, including bug reporting, feature requests, and other topics:

e  https://github.com/JGCRI/gcam-core/discussions

GCAM Video Tutorials:

e  https://gcims.pnnl.gov/community

List of GCAM publications by PNNL authors:
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e  https://www.pnnl.gov/publications-reports?keywords=GCAM&field document type=3

For more information about the GLIMPSE software and the Environmental Protection Agency’s GLIMPSE project,
please see the following links:

GLIMPSE website:

e https://epa.gov/glimpse

In addition, we EPA GLIMPSE team has been involved with several publications that use GCAM-USA. These include:

e Ou, Yang, Gokul lyer, Haewon Mcleon, Ryna Cui, Alicia Zhao, Kowan T.V. O’Keefe, Menggi Zhao, Yang Qiu,
and D.H. Loughlin (2023). State-level energy-water-land-health analysis of the US net-zero emissions goal.
Energy and Climate Change, Oct. https://doi.org/10.1016/j.egycc.2023.100117.

e Ou, Yang, Noah Kittner, Samaneh Babaee, Steven J. Smith, Christopher G. Nolte, and Daniel H. Loughlin.
“Evaluating long-term emission impacts of large-scale electric vehicle deployment in the US using a
human-Earth systems model.” Applied Energy 300 (2021):117364. doi:10.1016/j.apenergy.2021.117364.

e Ou, Yang, J. Jason West, Steven J. Smith, Christopher G. Nolte, and Daniel H. Loughlin. “Air pollution
control strategies directly limiting future health damages in the US.” Nature Communications 11 (2020):
957, doi:10.1038/s41467-020-14783-2.

e Babaee, Samaneh, Daniel H. Loughlin, and P. Ozge Kaplan. “Incorporating upstream emissions into electric
sector nitrogen oxide reduction targets.” Cleaner Engineering and Technology 1 (2020):
doi:10.1016/j.clet.2020.100017.

e Ou, Yang, Steven J. Smith, J. Jason West, Christopher G. Nolte, and Daniel H. Loughlin. “State-level drivers
of future fine particulate mortality in the United States.” Environmental Research Letters 14 (2019):
124071, doi:10.1088/1748-9326/ab59ch.

e Ou, Yang, Wenjing Shi, Steven J. Smith, Catherine M. Ledna, J. Jason West, Christopher G. Nolte, and
Daniel H. Loughlin. "Estimating environmental co-benefits of U.S. GHG reduction pathways using the
GCAM-USA Integrated Assessment Model." Applied Energy 216 (2018): 482-493,
doi:10.1016.j.apenergy.2018.02.122.

e Shi, Wenjing, Yang Ou, Steven J. Smith, Catherine M. Ledna, Christopher G. Nolte, and Daniel H. Loughlin.
"Projecting state-level air pollutant emissions using an integrated assessment model: GCAM-USA."
Applied Energy 208 (2017): 511-521, doi:10.1016/j.apenergy.2017.09.122.

1.13 HOW TO GET STARTED USING GLIMPSE

To install GLIMPSE, please follow the instructions described in the Installation Instruction of this Users’ Guide.

A good place to start in understanding GLIMPSE’s underlying assumptions and capabilities is to read Appendix A,
section 3 of this Users’ Guide, which describes the GLIMPSE Reference Case. While key results are provided at the
national level, similar results can be generated at the state level or for other countries.

For those who would like to use GLIMPSE themselves, the GLIMPSE tutorials are the next step. These will take you
through important steps of setting up, running, and analyzing scenarios. The tutorials are in Appendix B of the
Users’ Guide.
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Once you have completed the tutorials, we recommend that you read Chapter 2, “How does GCAM work?” in the
Users’ Guide. This will provide an overview of how GLIMPSE simulates markets in determining the market shares of
technologies and fuels, as well as how markets are impacted by policies such as taxes and caps.

Next, try to develop and evaluate your own policy scenarios, using the information in Chapter 3 “How do 1?” and in
Chapter 5.4 “Troubleshooting,” as needed.

To develop a more detailed understanding of GCAM, please see the PNNL GCAM documentation:
http://jgcri.github.io/gcam-doc/user-guide.html.

Demonstrations and trainings are periodically available. To be informed of GLIMPSE updates, trainings, and other
relevant information, please subscribe to the GLIMPSE listserv by emailing glimpse-news-subscribe@lists.epa.gov.

1.14 WHERE TO GET ASSISTANCE OR PROVIDE FEEDBACK

If you have difficulties installing or running GLIMPSE, please refer to the “Troubleshooting” section of this Users’
Guide to see if your problem can be readily addressed. If the information there does not help solve your problem,
you can contact the GLIMPSE development team by emailing glimpe@epa.gov. Include detailed information about
your problem, as well as what steps you have already taken to address it. Thank you!

For GCAM-specific questions, we recommend consulting the GCAM documentation (http://jgcri.github.io/gcam-

doc/gcam-usa.html) and discussion area (https://github.com/JGCRI/gcam-core/discussions).

As this is the first edition of GLIMPSE and of its Users’ Guide, there are undoubtedly many ways that both could be
improved. Please send bug reports or feature suggestions to glimpse@epa.gov or Loughlin.Dan@epa.gov for

consideration in future updates.
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CHAPTER 2. HOW DOES GCAM WORK?

GCAM is a complex model and understanding how GCAM operates is beneficial to GLIMPSE users in constructing
scenarios and interpreting results. In this chapter, we describe the general solution process, including how GCAM
steps through time, its market-based approach, how market shares are determined via a logit equation, and how
logit parameters such as shareweights affect technology choice. This chapter is a work in progress. Interested

readers also are encouraged to read PNNL’'s GCAM documentation, including the section on technology choice.®

2.1 GENERAL SOLUTION PROCESS

GCAM is a dynamic-recursive, market-based simulation model. This description refers to the process by which
GCAM steps through time. In each time period, GCAM solves for the vector of prices at which quantities supplied
equals quantities demanded for all modeled markets. When all markets have been solved, GCAM transitions to the
next time period, starting with the solution from the prior period.

2.2 MARKETS IN GCAM

To illustrate how markets work in GCAM, we will focus on one sector, passenger travel demand. The figure below
illustrates the hierarchical structure of this sector. Horizontal boxes represent various subsectors and modes, while
the vertical boxes represent technologies.

19 https://jgcri.github.io/gcam-doc/choice.html
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Figure 2.1: Hierarchical representation of passenger travel in GCAM.

Passenger travel is subdivided into various subsectors, modes, and technologies. Options at each level compete for
market share.
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The quantity of passenger travel demand, represented in units of passenger-km, is a function of the size of the
population and the cost of travel. As population increases, the quantity of demand for passenger travel increases.
However, if travel costs increase, demand for passenger travel per person decreases; and if travel costs decrease,
per capita demand increases.

The “market” for passenger travel is apportioned across a range of modes, including “Walking,” “Cycling,” “Road,”
“Domestic Air,” “International Air,” “High Speed Rail (HSR),” and “Passenger Rail.” The relative costs of these
options influence the mixture used to fulfill overall passenger travel demand; decreasing the travel costs in any of
these modes will increase its share compared to competing modes.

The “Road” mode is subdivided further, with “Bus” competing with “Light-duty”. Within “Light-duty,” “2&3W” (2
or 3-wheeled vehicles, such as motorcycles) compete with “4W” (passenger vehicles with 4 wheels, such as cars,
SUVs, and trucks). For convenience, “4W” vehicles are lumped into the categories “Car” and “Large Car and Truck.”

At the bottom of the hierarchy are the technologies that are competing against each other. For example, for the
“Car” category, “Liquids” (conventional internal combustion engines) are competing with “Hybrid,” “CNG,” “Fuel
Cell,” and “EV.” This is the most granular level in GCAM’s market-based structure. The mix of technologies selected
at this level determines the levelized cost (S/passenger-km) of meeting travel demand by “Car.” How this cost
compares to that of “Large Car and Truck” determines how “4W” demand is apportioned as well as the overall cost
of “4W.” The relative costs of “4W” and “2&3W” determines apportionment of “Light-duty” across those two
categories. In this manner, costs cascade up the hierarchy, determining how passenger travel demand is allocated
to each branch of the tree.
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2.3 DETERMINING MARKET SHARE

In determining the relative market share of new purchases of competing technologies, GCAM uses a logit function.
For example, the share of new “Car” purchases assigned to technology i is calculated using the modified logit
formula:

7
aipi
F—
b - . T
/_.*j' ]ijj
where:

N is the total number of technologies competing for market share;
siis the market share of technology i;

piand pj are the prices of technologies i and j, respectively;

ai and aj are the shareweights of technologies i and j; and

yis the logit exponent.

The price of each technology is its levelized cost, which is determined from the capital, operation and
maintenance, and fuel costs and represented in units of $/pass-km. By convention, for all technologies, GCAM
assumes a 10-year amortization period and a 10% discount rate. In the USA states, passenger cars and trucks are
assumed to travel 19,204 km per year. Passenger cars are assumed to average 1.58 people per vehicle, while large
cars and trucks average 1.73 people per vehicle.

For a particular “Car” technology i with a capital cost of $20,000 and annual costs (including fuel costs) of $3,000,
the calculation of pi is shown below.

A=C*d/(1-(1+d)?(-t))+ 0 =S6,255/vehicle/year

pi=A/L/T=50.21/pass-km

where:

A is the amortized costs of the car

Cis the capital cost of the vehicle, $20,000/vehicle

d is the discount rate, 0.1

tis the number of years over which the capital cost is amortized, 10

O are the operational costs, $3000/vehicle/year

L is the load, which is the number of passengers per vehicle, 1.58 passengers/vehicle

Tis the annual travel of the vehicle per year, 19,204 km/vehicle/year
The technology-specific shareweight is a means of representing non-modeled issues, such as logistical barriers for
the adoption of a technology or bias against a new technology. By convention, a value of 1 indicates that the
technology is perfectly competitive, indicating that there is no bias and only relative costs come into play when

determining the technology’s market share. In contrast, a value of 0 indicates that the technology will not be
purchased regardless of cost.
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If a technology is assumed to be purchased at a lower rate than its cost would suggest, then its shareweight
typically is a value between 0 and 1. For example, in the “Car” category, a 0.2 shareweight for the “Fuel Cell”
technology could be used to reflect implicitly how the limited availability of hydrogen would dampen market
share. Similarly, a reduced shareweight for “EV” could be used to reflect factors such as limited charging network
and range anxiety. Shareweights can be above 1 as well, indicating unmodeled factors that favor the technology.

The logit exponent controls the degree to which cost differences among technologies determine their relative
market shares. A value of 0 means that the logit function will ignore cost differences. Assuming every technology
has the same shareweight, they would be assigned equal shares. Typical logit exponent values are -4, -6, and -8.
The more negative the value, the greater the weight that is given to cost differences. For the “Car” market, the
logit exponent is -8, indicating that consumer decisions on which technology to purchase are highly influenced by
cost. In contrast, the logit exponent that is used to allocate passenger travel between “2&3W"” and “4W" is -4,
indicating that this market is less sensitive to price.

2.4 CALIBRATION

The shareweights for most technologies in GCAM are estimated during the calibration process. For GCAM 7.0, the
calibration year is 2015. In the calibration year, GCAM starts with estimates of real-world market share for each
technology. The technology with the greatest market share in the calibration year is assigned a shareweight of 1.
Thus, in the “Car” market, “Liquids” would have a shareweight of 1.

Since the market shares and costs for competing technologies (e.g., “Hybrid,” “CNG”) are known for the calibration
year, and since a logit exponent has been assumed, GCAM can solve for the shareweights for each of these
technologies.

For technologies that did not exist in the calibration year, shareweights in that year are set to 0. In the “Car”
market, the calculated “Hybrid” shareweight for 2015 would be near 0, and the “Fuel Cell” and “EV” shareweight
would effectively be 0.

Note that the calculation of shareweight values is based upon overall stock of each technology in the market in the
calibration year, not on sales in that year. As a result, the shareweights can be biased toward historic factors as
opposed to any new technology or developments that may have impacted sales shares more recently.

2.5 RELAXING SHAREWEIGHTS OVER TIME

To allow more flexibility over time, the shareweights for many technologies are set to follow a linear or s-curve
path (depending on the technology) from their calibrated value to 1 over time, implying that logistical barriers and
biases in the calibration year would diminish over time. In many markets, technology shareweights are setto 1 in
2050, although for some technologies 2100 is used to indicate a very long technology development timeline is
assumed until all barriers have been addressed. These decisions have been made by the GCAM developers using
modelers’ judgement but can be overridden by GCAM users.

The best trajectory to use for a technology’s shareweight may be technology- and scenario-dependent. For
“Hybrid” cars, for example, there is no range anxiety or fueling infrastructure barriers. When introduced, there was
some hesitancy to adopt hybrid vehicles because they represented a new technology. Arguably, this barrier is
greatly diminished or no longer exists. It would be reasonable to have the “Hybrid” shareweight transition to 1 by

36



GLIMPSE Users’ Guide v1.1 Chapter 2. How does GCAM work?

2020 or 2025. In GLIMPSE, we use “2025,” “2035,” and “2040” as the years at which “Hybrid,” “EV,” and “Fuel Cell”
technologies, respectively, achieve a shareweight of 1 for the “Car” and “Large Car and Truck” categories.

Shareweight trajectories may also be modified to reflect a particular scenario. For example, in a scenario involving
deep decarbonization, there could be additional public investment in charging infrastructure and research and
development in improving battery cost and range. In such a scenario, it could be reasonable to adjust the
shareweight trajectory for EVs to reach 1 sooner.

2.6 ILLUSTRATING THE OPERATION OF THE “CAR” MARKET

Next, we provide simplified description of the “Car” market to illustrate how the logit factors into technology
choice in GCAM.

The “Car” market in GCAM is depicted in the figure below. In the calibration year, 2015, “Car” travel demand is
met by the initial stock of vehicles. This stock is assumed to retire over time, with that retirement curve
represented by the red line and defined by the lifetime (e.g., 30 years), half-life (e.g., 7 years), and slope. Thus, the
travel demand that is met by the initial stock declines over time while the overall demand for “Car” travel
increases.

Figure 2.2: Initial vehicle stock, retirement, and demand.

The initial stock retires following an s-curve that is defined by its half-life, slope, and vehicle lifetime.

Service demand met by Cars

Initial stock

Demand = f{population, cost)

Slope

pass-km

/Remaining stock

|
|
Half life |

2015 2020 2025 2030 2035 2040 2045
(30 years)

At each modeled time period (typically 5 years), GCAM must purchase “Car” capacity to bridge the gap between
demand and what can be met by the “Car” fleet remaining from the previous period.
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Figure 2.3: Vintaging and demand for new vehicles.

Each vintage retires following an s-curve. The difference between demand and remaining stock is made up through
the purchase of new stock in each modeled year.
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The logit function helps determine the technology composition and cost of “Car” travel for each vintage.

To do this, GCAM takes an iterative approach to determine the “Cost” of car travel. An initial guess is made. At this
price, GCAM estimates the amount of demand that would be allocated to “Car” in the passenger transportation
hierarchy, as well as the supply of vehicles that would be brought to market at that price. This supply is informed
by the logit function.
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In the illustration below, the guess for the initial price is low, resulting in demand for “Car” outstripping supply.

Figure 2.4: An initial guess for a market-clearing price.

At the initial guess, supply and demand values are determined.
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Next, a second guess is made. At this higher price, GCAM finds that supply would be greater than demand.

Figure 2.5: A second guess for a market-clearing price.

For the new price, quantities of supply and demand are again estimated.
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The guessing process continues via the bisection method until the difference between supply and demand is within
a specified tolerance, such as 0.001. Once this criterion is met, the market is considered to have been solved.

Figure 2.6: Identification of a market clearing price that solves this market.

Guessing continues until the difference between supply and demand is below the solution tolerance, indicating that

the market is cleared.
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We can visualize how the logit apportions market share to each technology if we think of technology costs as
distributions.

Figure 2.7: Conceptual diagram indicating how the logit allocates market share.

The price at which each technology can be brought to market is represented with a mean value and with a
distribution.
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For example, at our initial guess for price, the composition of sales is determined based on the relative areas under
the curves. In this illustrative example, at the initial price, 90% of sales are apportioned to “Liquids,” 10% to
“Hybrids.” Because sales are represented as distributions, the amount assigned to “EV” would be non-0, but very
small.
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The solution algorithm continues to search for a market clearing price, and, in this example, would result in sales
shares of 50% for “Liquids,” 38% for “Hybrid,” and 12% for “EV.”

Figure 2.8: Market shares of sales at the market-clearing price.

Shares are determined based upon the relative areas under the three distributions.
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This visualization also allows us to depict how reducing a technology’s shareweight would impact apportionment
of market share. For example, in the next figure, we illustrate market shares in which the shareweight for “EV” has

been reduced.

Figure 2.9: Impact of a reduced shareweight for EVs on market share allocation.

The market share for EVs is reduced as a result of its lower shareweight.
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A policy such as a carbon tax directly influences market share decisions. By increasing the operating costs for fossil
fuels, such a policy would modify the levelized costs of each technology. This would shift the distributions and
result in a change in the sales share apportioned to each technology.

Figure 2.10: Impact of a price on carbon on market share allocation.

The distributions shift along the x-axis, reflecting changes in the costs associated with each technology that result

from the price of carbon.
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The costs for technologies can also be shifted higher or lower based on user-specified technology-specific taxes or
subsidies. A tax or subsidy would directly affect the technology allocations in the logit. Alternatively, GCAM offers
the option of specifying a market share constraint, and GCAM then solves to determine the subsidy necessary to

achieve this share.
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For example, in this illustration, GCAM solves for the subsidy that would shift the EV cost distribution lower such

that a 45% market share is achieved.

Figure 2.11: Impact of a technology subsidy on market share allocation.

The subsidy shifts the distribution of the subsidized technology, increasing its market share allocation.
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2.7 MARKETS, LOGITS, SHAREWEIGHTS THROUGHOUT GCAM

While this example has focused on the “Car” market, the logit functions are used throughout GCAM in the solution
of thousands of markets in every modeled time period. In passenger transportation, logit functions are used to
apportion market share within each horizontal box in the figure below.
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Figure 2.12: Shareweights and logit exponents across the passenger transportation sector.

Each sector, subsector, and technology has a shareweight, and each market is assigned a logit exponent.
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These mechanisms govern shares in other components of the energy system, as well as in GCAM’s representation

of choice in allocating water and land use.

Figure 2.13: Shareweights are present across GCAM's systems and sectors.

The logit determines market share allocations throughout GCAM.
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2.8 THE LOGIT FUNCTION AND MARKET SHARE CONSTRAINTS

The logit-based estimation process will attempt to assign at least some market shares to each technology option,
with some exceptions (e.g., technologies with integrated carbon capture and storage are not available in scenarios
where there is no price on carbon). As a result, it may be difficult for GCAM to achieve market share targets in
which a technology or set of technologies is required to achieve 100% (or near 100%) market share. Users can
implement high market share targets by complementing the policy with low or zero shareweights for competing
technologies.

For example, California has recently specified a target that 100% of light duty vehicle sales be electric by 2035. One
way to implement this policy would be via the following combination:

e Using a market share constraint to increase the EV sales share to 33% in 2025, 66% in 2030, and 100% in 2035
e Setting the shareweights for non-EVs to 0 from 2035 through the final model year

Modifying technology and sectoral shareweights is a complicated process in GCAM-USA. Shareweights can be
specified for specific years and regions. However, these values are overridden if an interpolation rule is in place,
which can result in unexpected behavior. To assist with this challenge, GLIMPSE’s “Tech Param” tab allows the user
to specify new sector- or technology-specific shareweights. When creating the resulting policy file, GLIMPSE
attempts to automatically delete relevant interpolation rules. Users are encouraged to view the affected
technology’s shareweights via the Modelinterface to verify that the values used within the model reflect what was
expected.

A more detailed description of where shareweight rules are specified and how they are interpreted will be
included in future versions of this Users’ Guide.
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CHAPTER 3. HOW DO I....?

In this chapter, we describe how to accomplish important activities in the Scenario Builder.

3.1 HOW DO | CHANGE OPTIONS IN THE GLIMPSE OPTIONS FILES?

The “options_GCAM-USA-7p0.txt” file resides in the GLIMPSE-v1.1 folder. This file lists many GLIMPSE options that
are loaded when the program starts. Important settings include:

e the location of the GLIMPSE folder (glimpseDir),

e the location of your GCAM installation (gCamHomeDir),

e the name of the output database (gCamOutputDatabase),
e the number of model periods to execute (stop-period),

e theregion to use as the debug region (debugRegion),

e whether to create the debug file (debugCreate),

e which programs to use as text and XML file editors, and

e which query file to use with the ORDModelinterface.

There are a few things to note in the options file:

e Any line that starts with “#” in the first column is interpreted as a comment.

e Where “#iglimpseDir#” and “#gCamGuiDir#” appear to the right of an equal sign, the values of these
parameters that are defined above are inserted. These are the only two parameters that are replaced in
subsequent lines in this manner. For example, if you include “#scenarioDir#” to the right side of equals, it
will not be replaced with the value of “scenarioDir”.

Any changes that are made to the options file do not take effect until: (1) you restart GLIMPSE, or (2) you choose
“File->Reload Options”.

You also can access the options file from the Scenario Builder via “File>Edit Options,” which will display the
options file in a text editor. Any changes you make and save will not take effect until you choose “File->Reload
Options” from the main menu bar or restart GLIMPSE.

If you want to see the contents of the options file with the #glimpseDir# and #gCamGuiDir# parameters resolved,
choose “File>Show Options,” which will pop up a non-editable dialog window.

Please note that changes you make to options such as the “stop-period” or the “gCamOutputDatabase” are not
automatically reflected in scenarios that have already been created. These settings are reflected in scenarios that

are created via the “Create Scenario” button, ®, after the options file has been edited and re-loaded.

3.2 HOW DO | UPDATE THE JAVA_HOME ENVIRONMENTAL VARIABLE?

Periodically, your system administrators may update the version of Java on your computer. Depending on your
GLIMPSE setup, this may result in GCAM-USA no longer running. Typically, the command window will appear, then
disappear, within a second. In addition, the Modelinterface may not run when you press the Results button. If you
are experiencing these issues, the next step is to check your JAVA_HOME setting, which tells GLIMPSE know where
to find Java. You can do this using the following step:
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e  Open your run_GCAM-USA-7p0.bat file by right-clicking on the file and choose to edit the file.

e |dentify the JAVA_HOME setting.

e Identify the location of the JRE folder on your computer. It will be similar to the JAVA_HOME setting but
may have a different number appended.

e Update the JAVA_HOME setting in the run_GCAM-USA-7p0.bat file to reflect the folder number.

e Save the run_GCAM-USA-7p0.bat file.

e  Re-start GLIMPSE by double-clicking on the run_GCAM-USA-7p0.bat.

If this does not solve your problem, please see the Troubleshooting section of this Users’ Guide.

3.3 HOW DO | CREATE A NEW DATABASE?

GLIMPSE is shipped with a BaseX database named “database.”

There are several ways to create a new database, which you may want to do if “database” is getting close to 40 GB
in size.

One way to create a new database is to modify the database setting in the options file to provide a new database
name (e.g., database_v2). Re-load the options file or restart GLIMPSE. Then press the “Results” button.

If the new database does not exist, the following message will appear:

Figure 3.1: Warning message associated with creating a new database.

Open DB Error >

l Could not open the database. Atternpt to create a new onef?
“  WARNING deing so will delete all files in the directory.

In general, you can answer “Yes.” The new database will be created and placed in “GLIMPSE-v1.1\GCAM-
Model\gcam-v7.0\output”. You will still need to update the database specified in the options file, then reload the
options file, if you want this new database to be used in subsequent runs.

Alternatively, there is a “Create new GCAM output database” option in the Scenario Builder's tools menu. Select
this option and the following dialog window will appear:
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Figure 3.2: Dialog window for opening or creating a new database.

B Create new GCAM output database - O x

If specified database does not already exist, it will be created in the cutput folder.

MName:

Create Cancel

Enter the name of a database. If a database with that name exists, it will be opened in Modellnterface. The dialog
window shown in Figure 3.1 will appear. Click “Yes.”

Please note that each scenario’s configuration file includes a specification of the database to use for its results. The

database name is inserted at the time the scenario and its configuration file are created (e.g., when you press @
, then click “OK” in the “Creating Scenario” area of the Scenario Builder). Providing a new database name in the
options file does not change the database specified in any existing configuration files. You will need to either edit
existing configuration files or re-create the scenarios if you would like them to use the new database setting.

3.4 HOW DO | IMPORT AND EXPORT SCENARIOS FROM THE MODELINTERFACE?

Users may have reasons to export scenario results from the Modelinterface, such as:

e There are limits on the size of databases that the Modelinterface can open. In general, the limit is
approximately 15-20 scenarios (or approximately 40 GB in total size). After the database reaches the limit,
it can no longer be opened, and the data are inaccessible. Users thus may wish to maintain a smaller
database that includes only results of particular interest.

e Users may wish to compare two scenarios that are currently in different databases.

e Users may wish to archive model results for specific scenarios that have been run.

e  Users may wish to share scenario results with other GLIMPSE or GCAM users.

The Modelinterface includes features for importing and exporting scenarios to address these needs. To export one
or more scenarios from the Modelinterface, choose “File>Manage DB”. The “Manage Database” window appears:
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Figure 3.3: The Manage Database dialog.

. 1§ Manage Database W
Scenarios in Database:

GCAM?.0 2023-13-11T12:55:55-05:00
GLIMPSE-1.1-Ref 2023-20-11716:20:28-05:00

Add [ [ BT Done |

If you select a scenario from the list, you have the option to “Remove” it from the list, “Rename” it, or to “Export”
the scenario.

Note that “Remove” currently removes the scenario name from the scenario list; however, it does *not*
decrease the size of the database. Thus, this option does not solve the problem of a database getting too large.

Exporting a scenario writes the scenario’s contents to an XML file. This XML file is generally too large to open in an
editor. However, you can import the scenario into another database, thus facilitating sharing or keeping a smaller
database of import model results.

To import a scenario’s XML file into a database via the Modelinterface, choose “File>Manage DB,” then click on
llAdd”'

3.5 HOW DO | MANAGE DATABASE SIZE?

As mentioned previously, when the GCAM database reaches a size of approximately 40GB, the Modelinterface is
no longer able to open the database and access its contents. As a result, your data are effectively no longer
available.

To avoid this option, we suggest that you switch to a new database when yours includes the results of
approximately 20 scenarios. To create a new database, follow the steps outlined below:

e Use “Tools—>Create or open output database”. A dialog will appear in which you can specify a name for the
new database.

e Select “Create” to create the new database. Scenarios will not automatically output to this database.

e Update the database setting in your options file to refer to the new database.

e  Restart GLIMPSE or choose “Reload Options” for the change to take effect.
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Note that the new database will only be reflected in scenarios created after this action. Pre-existing scenarios in
the Scenario Library are not modified.

It also may be advantageous to export scenarios that you want to save for future use. These can be archived and
imported into a database when needed.

3.6 HOW DO | ARCHIVE SCENARIOS IN GLIMPSE?

When conducting studies with a model like GLIMPSE, repeatability is important. An archive feature has been added
to GLIMPSE to support repeatability. If you click on a scenario name in the Scenario Library list, then choose
“Tools=>Archive Scenario” from the main menu bar, the following steps are carried out:

e Adialog appears to confirm whether you would like to create an archive.

e If “Yes,” the scenario’s configuration file is parsed, and all of the scenario components listed in the file are
identified (this includes from lines that are “commented out” via “<!—" and “-->").

e These scenario components are copied to an “archive” subfolder within the scenario’s folder.

e If there are multiple scenario components with the same filename, a warning message appears and only
the last file with that filename is copied.

e Acopy of the scenario’s configuration file is created but modified to point to the scenario components
within the “archive” folder instead of their original location.

e The archive folder is zipped (although the unzipped folder is also currently maintained).

e This archive folder can also be found in the scenario’s folder.

When the user selects a scenario name in the Scenario Library table and presses play, GLIMPSE first checks to see if
an archive version of the configuration exists. If so, it asks whether the user would like to run the scenario from the
archive.

3.7 HOW DO | ACCESS AND INTERPRET THE MAIN_LOG FILE?

Most of the diagnostic information that is printed to the command terminal during GCAM execution is also saved
to the main_log.txt file that is in the “GCAM-Model\gcam-v7.0\exe\logs” folder. This information can be extremely
useful in diagnosing issues with the run, including identifying when during execution that problems occurred and in
identifying which time periods had unsolved markets. For a run that is ongoing, you can access the “main_log.txt"

By default, GLIMPSE saves the “main_log.txt” file that is associated with each run after that run terminates. You
can find a scenario’s “main_log.txt” file in the folder associated with the scenario via GLIMPSE’s Scenario Library.

file easily in one of two ways. First, you can select the menu item “View—>Current Main Log”. The file will be

displayed using the text editor that is specified in the options file. Alternatively, press the “EXE Log” button,

To access the folder, click on a scenario, then click the “Browse” button, . Alternative, you can click on the

Ly

-
scenario’s name in the Scenario Library, then click the “Log” button, Eﬂ .
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3.8 HOW DO | EDIT A SCENARIO’S CONFIGURATION FILE?

You can edit a scenario’s configuration file by double-clicking on the scenario name in the Scenario Library pane.
This will display the configuration file in a text editor. Settings such as the output database or stop period can be
edited and will be reflected when the scenario is executed.

3.9 HOW DO | IMPORT SCENARIOS INTO GLIMPSE?

Configuration files developed outside of GLIMPSE can be added as scenarios within the Scenario Library. To use
this function, use “File>Import Scenario”. Select the configuration file using the File Browser that appears.
GLIMPSE will then create a new Scenario entry in your Scenario Library and will make a copy of the configuration
file in that location. The scenario can be executed and archived as if it had been created in GLIMPSE. However, you
will not be able to edit its components.

3.10 HOW DO | IMPORT FILES INTO THE COMPONENT LIBRARY?

You can include XML add-on files in GLIMPSE in one of several ways.

e Using the New Scenario Component Creator, you can use the XML List feature to “point” to one or more
external XMLs. The resulting file list will be saved to the Component Library. Adding this scenario
component to a scenario will result in the files in the file list being inserted into the scenario’s
configuration file when it is created.

e You can place XML files directly into the Component Library folder. The XMLs will appear in your
Component Library and can be added to scenarios as you would add any other scenario component.

3.11 HOW DO | RECOVER DELETED SCENARIO COMPONENTS AND SCENARIOS?

You can view deleted scenario components and Scenarios by selecting “View—>Browse Folders=> GLIMPSE Trash
Folder” via the main menu of the Scenario Builder. Deleted scenario component files are located within this trash
folder, while deleted scenarios are subfolders within the trash folder.

If you have not emptied the GLIMPSE trash folder, you can restore deleted scenario components by placing them

B, in the

back in the Component Library folder. Access that folder by clicking on the Open Folder button,
Component Library section of the Scenario Builder.

Similarly, you can restore deleted scenarios by moving the sub-folder with the scenarios name from the trash
folder to the “GLIMPSE Scenarios Folder.” You can access the “GLIMPSE Scenarios Folder” via “View—> Browse
Folders=>GLIMPSE Scenario Folder” in the main menu of the Scenario Builder.

3.12 HOW DO | SAVE FILES ASSOCIATED WITH EACH RUN?

In the GCAM-USA output file, options_ GCAM-USA-7p0.txt, is an option “gCamOutputToSave,” which is followed by
a list of files to save for each run. Upon the completion of each run, these files are saved to the scenario folder.

Modify the gCamOutputToSave parameter to change the files to be saved. After the values have been modified,
select “File> Update Options” to update the settings in GLIMPSE.
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3.13 HOW DO | CLEAN UP SAVED FILES?

” o u

By default, after every run, GLIMPSE will save a number of log files, including “main_log.txt”, “solver_log.csv”,
“calibration_log.txt”, as well as “debug.xml”. These logs can be large. For example, the “solver_log.csv” file may be
several hundred MBs. The “main_log.txt file” should be saved since this file is analyzed to determine the status of
the scenarios in the Scenario Library. However, the other files are most useful for debugging, and it is not
necessary to save them for future use. Selecting “Tools=>Advanced—> Cleanup Saved Files” will delete the
unneeded log files.

3.14 HOW DO | USE THE CSVTOXML UTILITY?

There are several approaches one can use to develop input files for GCAM. One approach involves integrating the

new data and processing into the GCAM data system. This approach requires significant understanding of the data
system structure and operation. Please see PNNL’s github site for information about the datasystem, including an

online manual.?® See the next section for links to additional information on the data system.

Most GLIMPSE users may not need to use the data system. Instead, these users can create “add-on” files that are
formatted in XML. These add-on files could be created by hand, but the process can be tedious for complicated
files. Alternatively, the Modelinterface provides a “CSVtoXML” utility that can convert CSV-formatted files into
XML files using rules provided in a header file. For more information on using the “CSVtoXML” utility, please see
the instructions that are available via the GLIMPSE help menu option accessible from the Scenario Builder. Choose
“Help~>GLIMPSE Document Folder,” then navigate to the subfolder “Miscl” to “CreatingXMLs” and open the file
“Using the Model Interface to create XML files from CSV files.pdf.”

20 https://github.com/JGCRI/gcamdata
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3.15 HOW DO | KNOW IF MY COMPUTER’S RESOURCES ARE RUNNING LOW?

When GLIMPSE starts up, several computing system properties are evaluated. Results are displayed to the
Command window, including warnings if specific thresholds are not met. This analysis can be executed at any time
by selecting “Tools=>Check Installation” from the Scenario Builder's main menu. Thresholds include:

Table 3.1: Thresholds used for evaluating computer resources.

Resources are compared to these thresholds at GLIMPSE startup and when “Tools 2Check Installation” is selected.

Parameter Threshold
Total physical memory (RAM) for GCAM 12 GB
Total physical memory (RAM) for GCAM-USA 16 GB
Free hard disk space 100 GB
Swap space size 25GB

In addition, GLIMPSE checks computer resource status approximately every 20 seconds and updates the
information in the status bar at the bottom of the Scenario Builder. Status shown includes CPU usage, total RAM,
free RAM, total swap space, free swap space, the name of the current database, and its size and fraction of the
maximum recommended size that has been used.

These values are also compared against runtime thresholds:

Table 3.2: Runtime thresholds used for evaluating computer resources.

Resources are compared to these thresholds approximately every 20 seconds.

Parameter Threshold
Free physical memory (RAM) 5%

Free swap space 5%

Free hard disk space 40 GB
Free database size as a percentage of the max size listed in the options file 80%

Il!”rl

When specific thresholds have been exceeded, the status message is concatenated with and asterisks are
placed next to the values in exceedance. Additionally, this information is saved to a log file that can be accessed by
“View—>Resource Logs=>Current Session.” If GLIMPSE crashes and needs to be restarted, you will find information
from the prior session at “View—>Resource Logs—> Prior Session”. For each log entry there is a time stamp and the
name of the currently executing scenario. This information can be useful in debugging execution problems that are

caused by computer resource limitations.
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3.16 HOW DO | DETERMINE WHY A GCAM RUN DID NOT COMPLETE AND GLIMPSE REPORTS “DNF”?

There are several reasons why a GCAM run would not complete successfully. These include the following:

e JAVA_HOMIE is set incorrectly. GCAM relies on the Java virtual machine (JVM) for execution. The location of
the JVM is defined by the JAVA_HOME environmental variable in the run_GLIMPSE_GCAM-USA-7p0.bat. If
JAVA_HOMIE is set incorrectly, a gcam.exe window will appear then disappear nearly instantly. If you are using
a computer that is managed by an administrator, one potential cause is that a new version of Java may have
been installed on your computer, and the previous setting for JAVA_HOME is no longer correct. Please follow
the instructions in section 3.2, “How do | update the JAVA_HOME environmental variable?”

e There are errors in the formatting of the configuration file. Configuration files for GCAM are formatted in XML.
If there are errors in the formatting of this file, such as the use of incorrect syntax, GCAM’s XML parser will not
be able to read the configuration file. Similar to when JAVA_HOME is set incorrectly, the gcam.exe window will
appear then immediately disappear. For the scenario with the problem, open the scenario’s configuration file
and check the formatting. Some text editors can color-code the content of XML files and can check the
structure and format of the file, helping you identify if formatting is the problem.

e There are errors in a scenario component file. When GCAM starts, the parser will indicate in the gcam.exe
window when the process of reading in each scenario component begins. If the parser tries to load an
incorrectly formatted scenario component file, or if the file does not exist, GCAM will terminate and the
gcam.exe window will disappear. When this occurs, you can often examine the scenario’s main_log.txt file to
find the last file that the parser attempted to load. This file typically is the one that caused the run failure.
Make sure the referenced scenario component exists in the location at which it is referenced. If it does, check
its format for errors.

e Computer resources have been exceeded. Running out of available RAM, swap space, or disk space will result
in your GCAM run being terminated abruptly, with no message or sign in the main_log.txt file indicating the
reason for termination. If this appears to be the case, please use the “View->Resource Logs->Current Session”
option in the Scenario Builder main menu to see if there are any resource warnings that were reported around
the time the problem occurred. If the information in the log indicates that disk space or swap space were
limited, consider taking actions to free up hard disk space. If the warning indicates that RAM was the issue,
then you may need to revisit the policies represented in your scenario. For example, market share constraints
such as Renewable Portfolio Standards can be particularly memory intensive. You may want to consider
alternative approaches for simulating these types of policies, such as via the “Tech Bounds” or “Tech Avail”
scenario components, or by adjusting shareweights.

e There are naming conflicts for markets or policies. GCAM users have considerable flexibility in naming markets
and policies. However, if the same name is used for more than one market or for more than one policy, this
can create conflicts that may cause the model to terminate abruptly during the model run. GLIMPSE attempts
to address this by assigning unique names to markets and policies within scenario components that are
created within the system. However, if you have imported or referenced scenario components created outside
of GLIMPSE, there is the possibility that naming conflicts exist. Please check any add-on files constructed
outside of GLIMPSE to determine if there are conflicts.

e The scenario’s gcam.exe file was closed during execution. Closing the gcam.exe window that is displaying text
from the GCAM run will terminate the run.

If the GCAM run completes but GLIMPSE is reporting problem markets, please see “Section 4.3 Interpreting and
debugging unsolved markets.”
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3.17 HOW DO | ACCESS THE GCAM DATA SYSTEM AND FIND THE ORIGINAL SOURCES OF DATA?

The GCAM data system includes the underlying data used to generate the model’s XML-formatted input files. You
can access the data system at GCAM-Model/gcam-v7.0/input/gcamdata. This folder includes an xml folder that
contains the model’s input files, as well as many other folders that contain data and code that were used to create
the inputs.

Much of the input data can be found in the following subfolder: “GCAM-Model/gcam-
v7.0/input/gcamdata/inst/extdata”. Within this folder are subfolders that include data for the various human-
Earth systems represented in GCAM. These include:

e aglu (agriculture and land use files)
e emissions

e energy

e socioeconomics

e water

In addition, there is a subfolder named “gcam-usa” for GCAM-USA-specific data.

3.18 HOW DO | MODIFY THE UNITS OF THE DATA REPORTED IN THE MODELINTERFACE?

Recent updates to the Modellnterface support on-the-fly unit conversions. As the Modelinterface returns the
results of a query, the rows are compared with rules specified in the “units_rules.csv” file that is located in the
“GLIMPSE-Modellnterface\exe” folder.

A snapshot of the “units_rules.csv” file is shown below.
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Figure 3.4: The “units_rules.csv” file that contains rules for on-the-fly conversion of units.

L_{ E\Projects\GLIMPSE-v1.1\GLIMPSE-Modellnterfa nits_rules.csv - Notepad + + - O X
File Edit Search View Encoding Language Settings Tools Macro Run  Plugins Window 7 + ¥ X
cHEHEREE s Hilhoc iy 2% EEST1 EDEDA D =& EH#HE
=] units_rules.csv E]' bl g
1 fromUnit, toUnit, conversion,query,headingl,valuel, heading2, valueZ, heading3, value3,,
2 Tg,mmC0O2eq, 21, GHG emissions by pollutant and region (COZeq),GHG,CH4,,,,,.,
3 Tg,mmCOZeq, 21, GHG emissions by pollutant and region (COZeq),GHG,CH4_AWE,,,,,,
L} |Tg,mmC02eq,21, GHG emissions by pollutant and region (COZeq),GHG,CH4_AGR,,,,,,
5 Tg,mmC02eq, 310, GHG emissions by pollutant and region (CO2eq),GHG,N20,,,,,,
6 Tqg,mmCOZeq, 310,GHG emissions by pollutant and region (CO2eq),GHG,N20 AGR,,,,,,
1 Tg,mmCO2eq, 310, GHG emissions by peollutant and region (CO2eq),GHG,N20 AWB,,,,,,
8 Tg,mmC02eq, 9.2,GHG emissions by pollutant and region (CO2eq),GHG,C2F6,,,,,,
9 Tg,mmC02eq, 6.5,GHG emissions by pollutant and region (CO2eq),GHG,CF4,,,,,,
10 Tg,mmC0OZeq, 2.8, GHG emissions by pollutant and region (COZeq),GHG,HFC125,,,,,,
11 Tg,mmC0O2eq,1.3,GHG emissions by pollutant and region (CO2eq),GHG,HFCl3da,,,,.,
12 Tg,mmC02eq,1.03,GHG emissions by pollutant and region (COZeq),GHG,HFC245fa,,,,,,
13 Tg,mmC02eq, 23.900,GHG emissions by pollutant and region (CC2eq),GHG,SF6,,,,,,
14 MTC,mmCO2eq, 3.667,GHG emissions by pollutant and region (CO2eq),GHG,COZ2,,,,,,
15 Tg,million short tons,1.1023,"NOx,S02,PM2.5,VOC,CO,NH3 by region (short tons),,,,;srsr»
16 Tg,million short tons,1.1023, "NOx, SO2,PM2.5,V0C,CO,NH3 by aggregate sector (short tons),,,,
17 19755/GJ,20205/kWh, 0.017316,Elec prices by sector (20205/kwh),,svrres
18 19905/GJ,20205/GJ,1.98,Prices of all markets (202053),,,vrrr s
19 19755/GJ,20205/GJ,4.81,Prices of all markets (202053),,,vvrr s
20 19905/m"3,20205/m”3,1.98, Prices of all markets (2020538),,rrrvres
21 19755/m”3,20205/m"*3,4.81,Prices of all markets (202033),,,rrss+
22 19905/tC,20205/tC02,0.54,Prices of all markets (202033),,vrrvres
23 19755/tC,20205/tC02,1.31,Prices of all markets (2020353),,vrrres
24 19905/m3,20205/m3,1.98,Prices of all markets (202053),, 00 r ¢
25 19755/m3,20205/m3,4.81,Prices of all markets (2020%3),,,vrvrr s
26 19905 /mcal, 20205 /mcal,1.98,Prices of all markets (202053),,,rvr s
27 19755/mcal, 20205/mcal,4.81,Prices of all markets (2020353),,,rv0rs»
28 19905/kg,20205/kg,1.98,Prices of all markets (202058),,srrrr s
29 19755/kg,20205/kg,4.81,Prices of all markets (2020353),,ssr4rr s
. ____________________________________________________________________________________________________________________________|
Normal t length : 3,197 lines : 45 In:1 Col:1 Pos:1 Windows (CR LF) UTF-8 IN

The first rule defined in the file is on row 2. For results of the query “GHG emissions by pollutant and region
(CO2eq)” that have a column heading of “GHG” a row value of “CH4” and are in units of “Tg” the numerical values
are converted to “mmCO2eq” by multiplying by 21. In the converted table, the units are reported as “mmC0O2eq.”

From the “query” specification to the heading and value items to the right, no text between the comma separators
indicates that any value is a match. Therefore, if the line had been “Tg, MmC02eq,21,,GHG,CH4,,,,,,”, it would have
been applied to all queries.

This unit conversion feature is demonstrated for the results of the “GHG emissions by pollutant and region
(CO2eq)” query, applied to national results for GLIMPSE-1.1-Ref.

Figure 3.5: Example application of unit conversions.

[ GHG emissions by pollutant and region (CO2eq) E GHG emissions by pollutant and region (CO2eq)

Filter Graph Format

scenario region GHG 2015 2020 2025 2030 2035 2040 2045 2050 Units
GLIMPSE- Tota CH4 135 129 [134 [135 [137 140 143 145 mm|
GLIMPSE- ota Co2 5190 4710 4650 4420 [432 14300 4250 4210 mm|
GLIMPSE- ota HFC125 234 25.8 27.2 28.1 llB.“ 28.7 29.5 30.8 mm|
GLIMPSE- ota HFC134a 9 53.8 56.7 58.5 59.5 59.7 61 64.2 mm|
GLIMPSE- ota 93.0 81.2 82.7 78.9 76. 77.8 78 78.8 mm|
GLIMPSE- ota CH4_AGR 3 212 224 235 245 254 264 274 mm|
GLIMPSE- ola CH4_AWB 1.45 0.871 0.670 0.704 0.737 0.797 0.870 0.936 mmCQOZeq
GLIMPSE- Tota N20_AGR 402 432 462 488 212 246 291 633 m q
GLIMPSE- Tota N20_AWB 0.367 0.221 0.170 0.179 0.187 0.202 0.221 0.238 mmCQOZ2eq
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The Modelinterface includes an option for turning off unit conversions (Advanced—->Queries—> Disable Unit
Conversions). We can verify the conversions occurred successfully by disabling and performing the query again.

Figure 3.6 Example application of unit conversions.

scenario region GHG 2015 2020 2025 2030 2035 2040 2045 2050 Units
GLIMPSE Tota CH4 6.41 6.15 6.38 6.43 6.52 6.66 6.80 6.90 Tag
GLIMPSE [ota CO2 1420 1280 1270 1210 1180 1170 1160 1150 MTC
IGLIMPSE- ota HFC125 8.37 9.21 9.72 10.0 10.2 10.2 10.5 11.0 q
IGLIMPSE- ota HFC134a 37.6 41.4 43.6 45.0 45.7 45.9 47.3 49.4 q
GLIMPSE- ota N20 0.300 0.262 0.267 0.254 0.248 0.251 0.254 0.254 q
GLIMPSE- [ota CH4_AGR 9.65 10.1 10.7 11.2 11.6 12.1 12.6 13.1 Tq
GLIMPSE [ota CH4_AWB 0.0690 0.0415 0.0319 0.0335 0.0351 0.0379 0.0414 0.0446 Tq
IGLIMPSE [ota N20_AGR 1.30 1.39 1.49 1.57 1.65 1.76 1.91 2.04 Tq
GLIMPSE- ota [N20_AWB 0.00119 0.000713 0.000548 0.000576 0.000603 0.000652 0.000712 0.000766 q
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CHAPTER 4. ADVANCED TOPICS

In this chapter, we provide information about advanced concepts and operations, such as understanding how
GLIMPSE interacts with GCAM-USA, debugging model solution errors, and interpreting biomass flows.

4.1 WHAT IS HAPPENING BEHIND THE SCENES IN GLIMPSE...?

In this section, we describe actions taken by GLIMPSE when you perform various functions using GLIMPSE.

4.1.1 .. WHEN YOU CREATE A NEW SCENARIO COMPONENT?

When you press “Save” in the New Scenario Component Creator window, what happens next depends on what
type of scenario component you are creating. If you are creating an XML list (e.g., a text file that points to one or
more XML files), GLIMPSE prompts you for the file name, then saves the resulting file to the Component Library or
another location of your choice. For GLIMPSE to “see” the new Scenario Component, you will need to place it in
the Component Library or a subfolder of that library.

If you are creating one of the other types of Scenario Components, the first step that occurs is a quality assurance
step. GLIMPSE checks to see if all of the necessary options have been selected. If not, a warning message is
provided. Otherwise, you are prompted for a filename. At this point, GLIMPSE scans all of the policy names and
market names for the CSV-formatted Scenario Components. It chooses unique names when writing the current file
to disk to avoid naming conflicts with existing policy representations. This action will produce a CSV file, formatted
to match one or more headers in the GLIMPSE header file: “glimpseXMLheaders.txt.” Note that later, when the
scenario is created, its CSV files will be converted to XML files automatically using these headers.

4.1.2 ... WHEN YOU CONSTRUCT A NEW SCENARIO?

When you press the Create Scenario button, ®, GLIMPSE first checks to see if this scenario already exists. It
does so by checking if there is a subfolder in the Scenario Library folder with the same name. If there is, the user is
prompted to determine if they wish to continue. Next, GLIMPSE checks the size of the database in which the
scenario’s outputs are to be saved. If the database exceeds a specific size (default is 40 GB, although alternatives
can be specified in the options file), a warning is presented, and, again, the user has the option of continuing or
canceling. Next, a dialog appears. It lists the scenario name, the database to which the results will be stored, and
the size of that database. In addition, the user is given the options of whether to generate a debug file
(recommended) and which region to use for the debug region. The option is available to change the final year of
the run, and a comment area is provided for the user to leave any text that describes the scenario.

When you click “OK,” the scenario’s folder is created. Next, the Scenario Template file is accessed (typically,
“configuration_usa_7p0_template.xml”). Metadata is written to the top of the file, then the database, stop-year,
and debug information are updated to reflect what the user has selected.

Next, GCAM goes through the Scenario Components that have been selected for inclusion. When it reads an XML
list file, it places references to each of the indicated XML files at the bottom of the Scenario Components block
within the configuration files. When it reads an XML file, it places a reference to that file into the same location.
When it reads a CSV file, it identifies the matching headers in the glimpseXMLheaders.txt file, then uses the
CSV2XML.jar utility to convert the CSV file into an XML. The resulting XML is automatically placed in the new
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scenario folder, and a reference to it is placed in the configuration file. Finally, the edited configuration file is
renamed to reflect the scenario’s name and placed in the scenario’s folder.

4.1.3 ... WHEN YOU RUN A SCENARIO?

Selecting one or more scenarios in the Scenario Library, then clicking “Play” D adds those scenarios to the run
gueue. GCAM runs are made sequentially from the queue, on a first-in first-out basis. When running each scenario,
GLIMPSE calls the GCAM executable identified in the options file, using the “-C” argument to use that scenarios
configuration file. When a run has finished, whether successful or not, the “main_log.txt” file, several other log
files, and the debug file are copied to the scenario’s folder.

Every 20 seconds, GLIMPSE updates the information about each scenario in the Scenario Library. It does this by
traversing the GCAM-Data/GCAM-USA/ScenarioFolders folder. For each scenario’s folder within, it searches for the
main_log.txt file. If that file exists, then it is searched for the text “Model completed successfully,” “Model periods
not solved,” and for the runtime. If no main_log.txt file exists, GLIMPSE checks to see which run is currently
executing by checking the current main_log.txt file in the exe folder. Based on the results, GLIMPSE assigns status
as “Running,” “Success,” “PblmMrkts,” “DNF,” or blank. PrbmMrkts indicates that there were market errors in one
or more time periods. DNF stands for Did Not Finish.

4.2 GLIMPSE FOLDER STRUCTURE

In this section, we describe some of the most important folders in GLIMPSE.
e  GLIMPSE - The root folder for GLIMPSE. This may be different, depending on your installation.
The following folders contain the GCAM model and data.

e  GLIMPSE/GCAM-Model/gcam-v7.0 - The root folder for a particular version of GCAM 7.0.

e  GLIMPSE/GCAM-Model/gcam-v7.0/exe - Includes the GCAM executable (“gcam.exe”) and example
configuration files (e.g., “configuration_ref.xml” and “configuration_usa.xml”).

e  GLIMPSE/GCAM-Model/gcam-v7.0/exe/logs - Includes log files that are created during GCAM calibration
and execution, such as “main_log.txt”, “calibration_log.txt”, and “solver_log.csv”.

e  GLIMPSE/GCAM-Model/gcam-v7.0/input - Includes folders with input data used by GCAM or the GCAM
data system.

e  GLIMPSE/GCAM-Model/gcam-v7.0/input/policy - Includes example policy files for GCAM (but not for
GCAM-USA), including files that impose carbon taxes and that implement various global warming targets.

e  GLIMPSE/GCAM-Model/gcam-v7.0/input/gcamdata - Includes the gcam data system, an R-based system
that creates XML-formatted input files for GCAM from CSV-formatted source data.

e  GLIMPSE/GCAM-Model/gcam-v7.0/input/gcamdata/xml - Includes the xml-formatted input files that are
produced by the GCAM data system and read in by GCAM as scenario components.

e  GLIMPSE/GCAM-Model/gcam-v7.0/input/gcamdata/inst/extdata - Includes the CSV-formatted source
data. The CSV files have metadata identifying the original source of data tables.

e  GLIMPSE/GCAM-Model/gcam-v7.0/output - Includes GCAM’s output databases. Each database is a
subfolder that includes seven files with the “.basex” extension. These are binary files in which GCAM’s
XML-formatted outputs are stored.
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GLIMPSE folders:

e  GLIMPSE/Docs - Includes GLIMPSE documentation, such as this Users’ Guide.

e  GLIMPSE/GLIMPSE-Data/GCAM-USA/ScenarioComponents - Includes Scenario Components available to
GLIMPSE. These can be XML add-on files, text files that point to one or more external XML files, or CSV
files that are formatted specifically for use by GLIMPSE.

e  GLIMPSE/GLIMPSE-Data/GCAM-USA/ScenarioFolders - Includes folders for each scenario in the GLIMPSE
Scenario Library. These folders are where the scenario’s log files are stored after each run, as well as
where any scenario-specific XML files are stored. If the scenario is archived, the copies of all scenario
components will be placed in a subfolder named “archive.”

e  GLIMPSE/GLIMPSE-Data/GCAM-USA/trash - Includes deleted Scenario Component files and Scenario
folders. To restore from trash, move deleted components and scenarios back into “ScenarioComponent”
and “ScenarioFolders,” respectively.

e  GLIMPSE/GLIMPSE-GUI - Includes all of the files associated with the GLIMPSE graphical user interface
(GUI)

e  GLIMPSE/GLIMPSE-GUI/exe - Includes “ScenarioBuilder.jar”, the GLIMPSE GUI executable file.

e  GLIMPSE/GLIMPSE-GUI/templates - Includes files that are used as templates by GLIMPSE, such as the
template configuration file used when constructing new scenarios.

e  GLIMPSE/GLIMPSE-GUI/resources - Includes ancillary files used by GLIMPSE, such as button images and
the technology listing that is used the New Scenario Component Creator window.

e GLIMPSE/GLIMPSE-Modelinterface - Includes a modified version of PNNL’'s Modelinterface, which adds
features for filtering, graphing, and exporting data.

e  GLIMPSE/GLIMPSE-Modelinterface/exe - Includes “ORDModelinterface.jar”, the executable used to run
the program, as well as the “model_Interface.properties” file that has start-up settings and the
“Main_queries_GLIMPSE.xml” file that includes the queries used by GLIMPSE.

4.3 INTERPRETING AND DEBUGGING UNSOLVED MARKET INFORMATION IN THE MAIN_LOG.TXT
FILE.

The GCAM solver works by attempting to identify the price in each market at which supply equals demand. When
GCAM experiences an unsolved market, information about that market is reported to the “main_log.txt” file. Here
is an example of such a report:

Figure 4.1: Example of the table used to report market solution errors.

Writing restart file: ./restarc/restart.é... Done.
Period 7: 2030

. RES , Biofuel

eg_MktBiofuel All Reg ,
d resource

y domestic supplyDemand int,

. Normal
, Normal

Parameters of relevance are defined in the following table.
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Table 4.1: Parameters relevant to solver operations.

Parameter Description

X The current guess for the price that will solve the market.

XL XL and XR represent the previous two guesses, with XL being the lower of the two
values.

XR XR is the upper value of the prior two guesses.

ED At price X, ED represents the excess demand, or demand minus supply.

EDL At price XL, EDL represents the excess demand, or demand minus supply.

EDR At price XLR, EDR represents the excess demand, or demand minus supply.

RED Relative excess demand (RED) is the absolute value of ED divided by demand.

Supply The amount of supply at price X.

Demand The amount of demand at price X.

max-model-calcs The maximum number of solver calculations that will be conducted in a model
period, specified in the solver configuration file.

solution-tolerance A threshold against which the RED is compared to determine whether the market
has been solved, specified in the solver configuration file.

solution-floor A threshold against which the absolute value of ED is compared to determine
whether the market has been solved, specified in the solver configuration file.

The process GCAM'’s solver uses to determine the “market clearing” price is similar to the familiar “pick a number
between 1 and 100” game. An initial set of guesses for X are made, with XL being the lower of the two values and
XR being the higher. Excess demands are calculated for both XL and XR, providing EDL and EDR. These values are
used to determine the next guess for X. This value of X then displaces either XL or XR, new values for EDL and EDR
are calculated, etc.

The search for the best value for X ends when one of three stopping conditions is met:

e The calculation limit, max-model-calcs, has been exceeded.
e The value of RED at X falls below the specified solution-tolerance.
e Thevalue of |ED] at X falls below the specified solution-floor.

The second and third criteria are similar, but the normalization that occurs when evaluating RED is useful
evaluating convergence in small markets. The solution-floor is typically smaller than the solution-tolerance and can
also be interpreted as the difference between supply and demand being so small that it can be interpreted as
being zero.

If the calculation limit is reached, but not all markets have been solved, the markets that have not been solved are
reported to the “main_log.txt” file.

For the example report shown in Figure 4.1, there are 11 market failures reported in time period 7 of the model,
2030. The columns are not aligned well, but the fields in each row are separated by commas, and the proper
column for each value can be readily deduced. See Table 4.1 for a brief description of the parameters in the table.
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Here, the supply and demand for each market are quite similar and are often different at the 4™ or 5% decimal
point. This is evident in the RED column, where many of the values are small. The solution-tolerance for this run
was 0.0001, so many of these markets were close to having been solved. One approach to address very small
market errors is to relax the tolerance in the solver’s configuration. Alternatively, if these markets would have met
the relaxed tolerance, it may be possible to assume they have been solved. If this latter approach is taken, it is
suggested that the modeler carefully inspect model results for that time period for discontinuities or other
unexpected behavior.

In contrast, in the error table, the RED value for the “USArefining” market indicates that supply and demand were
different by 11%. That is a relatively large difference in an important market. Additional examination is necessary,
including evaluating whether any constraints in the model make the solution infeasible.

There are other causes of unsolved markets. In some instances, a particular policy or technology may have
introduced complexities that are resulting in the need for more computations to determine the market-clearing
prices. Increasing the max-model-calcs in the solver configuration file allows the search to perform additional
iterations. Modifying solution-tolerance and solution-floor may also provide some benefit, although changing
these values impacts the solution process and may not lead to the desired results.

Some markets may also be unsolvable or difficult to solve because of numerical issues involving very low demands
or extremely high prices, producing conditions that are incompatible with the scaling approach used by the solver.
State-level constraints on transportation technologies are particularly problematic because of the unit conversions
used specifically for that sector within the model. In the solver configuration included in GLIMPSE, we have
lowered the solution-tolerance and solution-floor from their default values, which has addressed many of these
instances.

For some of these markets that suffer from numerical issues, the multi-threading capability of GCAM may
exacerbate these errors by introducing additional small numerical errors. For scenarios experiencing errors in small
markets, turning off multi-threading may solve the problem at the expense of a longer runtime. This option is

®

At this time, our goal is to provide some insights that may help a GLIMPSE user understand and recover from some

available in the dialog window that appears when you click on the “Create Scenario” button,

market solution problems. As we seek to improve the solver settings and configuration to improve its robustness,
this section will evolve.

4.4 BIOMASS FLOWS AND CO2 ACCOUNTING IN GCAM-USA

As alluded to in the Tutorial, biomass has the potential to play a role in GHG mitigation strategies, including taxes
and caps, renewable portfolio standards, and clean energy standards. In this subsection, we investigate CO>
accounting associated with biomass as well as its use in the energy system. The information provided here was
developed by analyzing the results of the “inputs by tech” and “output by tech” queries, which are highly
recommended for assessing material flows in GCAM.

There are several pathways by which biomass can enter a solution, as shown in the following figure.
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Figure 4.2: Biomass and biofuel activities in GCAM-USA.
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Biomass (e.g., fiber, grass, tree, root/tuber, sugar, and corn) for use in bioenergy and biofuels is “grown” in GCAM
and GCAM-USA at the land-use resolution (e.g., water basins). Corn and oil crop can be used to create corn ethanol
and biodiesel. Alternatively, these crops and other forms of biomass can enter states as “regional biomass” which,
in turn, can feed applications in the electric sector and advanced biofuel production. In addition, regional biomass
can be converted into “delivered biomass,” which is used in the residential, commercial, and industrial sectors.

From a CO; accounting standpoint in GCAM, combustion of biomass results in the release of CO2 emissions (just as
it does in the real world). To counter these releases, GCAM represents the CO; uptake from the atmosphere that is
associated with biomass grown for bioenergy or biofuels. This uptake is accounted for at the state level (see “Up”
on the biomass flow diagram), allowing bioenergy use and biofuel production to play a role in meeting an
economy-wide CO2 cap or for reducing costs under an economy-wide CO> tax.

There are several limitations to this method of accounting. One limitation is that a state would not receive “credit”
for reducing transportation emissions by increasing the biofuel content at the pump. Instead, the credit for that
ethanol would occur in the state where the ethanol was produced. Furthermore, a cap on CO; emissions from the
electric sector would not increase biomass use in that sector since the credit for biomass growth would be
occurring in the state’s “regional biomass” sector instead.

4.5 CONSIDERATIONS WHEN APPLYING GCAM-USA TO STATE-SPECIFIC APPLICATIONS

Users who are interested in using GLIMPSE for state-specific applications are advised to consider factors such as:
e Some sectors are not represented at the state level. For example, in GCAM-USA 7.0, air pollutant

emissions from oil and gas operations and from mining and agricultural energy consumption are tracked
in the USA region and thus will not be represented in a query for a specific state. Similarly, agricultural
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production and associated emissions are tracked at the water basin level, not at the state level. Obtaining
state-level results for these outputs will require the user to do their own “downscaling.”

e Interstate dynamics are highly stylized. Electricity trade is a good example. In GCAM-USA, power
generators at the state level place electricity on a (typically) multi-state grid region that roughly
corresponds to North American Electric Reliability Corporation (NERC) regions. Electricity demand and
supply within a grid region is balanced. There is no representation of state-level grid capacity, bottlenecks,
or of grid expansion logistics. There can be trade between pairs of grid regions, but this trade is one-
directional and cannot reverse in the future. This representation is sufficient to capture grid operation
under most scenarios, but there may be some scenarios (e.g., large offshore wind capacity introduced in
New England that would allow regional export) that would not be supported under the default model
configuration.

e (CO:2accounting in GCAM-USA impacts the model’s decarbonization decisions. “Credit” is given for the CO2
uptake from biomass production in the state where the biomass is transformed into bioenergy. Thus, a
national CO2 constraint would potentially drive CO2 reductions from biomass growth in high ethanol-
producing states, and those states would be assigned the negative CO2 emissions for those reductions. In
contrast, in the model, a state-level CO2 reduction tax or cap for a state without corn ethanol production
would not see corn ethanol as a viable mitigation option because that would not receive the negative CO>
emissions credit for corn ethanol production.

e  State-specific policies aside from regionalized RPSs generally are not included in the Reference Case. While
GCAM-USA can represent many such policies, their inclusion has been beyond the scope of GCAM-USA
and GLIMPSE development to date. An example of a state-specific application of GCAM-USA in which the
model was tailored to the state’s policies is the Maryland’s Climate Pathway project.?!

e In some instances, scaling has been done such that national results are accurate, but this scaling may not
reflect state-level differences. An example is in aircraft air pollutant emission factors, for which national
emission factors are used in GLIMPSE. GCAM-USA 7.0’s emission outputs for this sector represent the
entire operation of aircraft, including the portion that is elevated or outside of U.S. territory. However, for
applications of GLIMPSE to U.S. air quality, we have scaled aircraft emission factors to provide values
equivalent to the “airport” category in the U.S. EPA’s National Emissions Inventory, which include aircraft
engine emissions during landing and takeoff as well as from ground support operations. The result is that
GLIMPSE’s emissions projections replicate the inventory at the national level well. However, the mix of
domestic and international air travel from each state differs, and the national-level scaling may not
replicate state-level emissions well. Note further that CO2 emissions from aircraft are calibrated to a
national average of short-haul (“domestic”) vs. long-haul (“international”) air travel and do not reflect
state level differences, nor do these divisions match EPA’s GHG inventory definitions.

In light of these factors, users are encouraged to use the GLIMPSE Reference Case as a starting point, but to tailor
their scenarios as needed to their specific application. Tailoring may involve adding additional policies or
constraints.

PNNL also includes some discussion regarding interpretation of state-level results based on GCAM-USA. 22 Users
are encouraged to read that information and to communicate with the EPA GLIMPSE team if they have questions
about using GLIMPSE for state-specific applications.

21 https://www.marylandsclimatepathway.com/services-7
22 http://igcri.github.io/gcam-doc/gcam-usa.html
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4.6 CONSIDERATIONS WHEN MODELING A DEEP DECARBONIZATION SCENARIO

A deep decarbonization scenario is one that achieves significant reductions in CO2 emissions, often targeting an
80% or even 100% reduction by 2050, relative to a historical year such as 1990 or 2005. “Net-zero” strategies
typically achieve zero CO2 emissions through a combination of reducing emissions from the energy system,
applying carbon capture to fossil- and biomass-fueled combustion activities, removing CO; from the atmosphere
via direct air capture, and through changes in land use and farming practices.

GLIMPSE can be used to explore pathways for achieving deep decarbonization scenarios. One approach is to
introduce a declining CO2 or GHG cap, allowing GCAM to select a technology pathway through time for achieving
the target. Alternatively, GLIMPSE can be used to simulate specific sectoral mitigation strategies, including
introducing market share targets (e.g., for vehicle electrification, renewable technologies in electricity production,
and heat pumps) and technology subsidies (e.g., a credit for high efficiency technologies).

For either approach, GLIMPSE users should be aware of how GCAM’s myopic solution process, logit-based market
share allocation, and shareweight assumptions affect the results (described in “Chapter 2. How does GCAM
work?”). Depending on the scenarios being modeled, some adjustments may be desired or necessary, as discussed
in this section.

4.6.1 POTENTIAL ADJUSTMENTS FOR DEEP DECARBONIZATION SCENARIOS

When simulating deep decarbonization strategies, users may want to consider making the following adjustments:

e Including direct air capture (DAC) technologies. DAC technologies are not included in the Reference Case
but can be added to scenarios by including the Tech-DAC.txt scenario component.

e  Modifying the shareweight trajectories of decarbonization technologies. In the Reference Case
assumptions, many of the electric and hybrid transportation technologies have shareweights that begin at
0 and transition to 1 by 2050, 2070, or even 2100. A value of 1 indicates that all biases have been
addressed such that the technology competes for market share based upon its cost (and the impact of any
policies on technology costs). Under a deep decarbonization scenario, it is reasonable to assume that
many of the barriers to hybrid, electric, and fuel cell technologies will be addressed sooner than in the
Reference Case. For example, investments likely will be made to build out charging and hydrogen fuel
infrastructure. Thus, it may be reasonable to modify the shareweight trajectories for these technologies
to reach 1 sooner. We have created a DeepDecarbAssumptions.txt scenario component that includes
revised shareweight trajectories for advanced transportation technologies; however, GLIMPSE users may
opt to introduce their own assumptions instead.

e Reducing the elasticities on end-use service demands. In GCAM, end-use service demands have price
elasticities such that increases in cost lead to a reduction in demand. These elasticities have been
developed with input based on past human behavior. However, a deep decarbonization scenario would
diverge considerably from past conditions, and thus consumer choices and behaviors could be different as
well. Using the default elasticities, common response in GCAM and GCAM-USA to deep decarbonization is
significant reductions in service demands for historically difficult-to-decarbonize sectors, such as
international aviation and cement production. When modeling decarbonization scenarios, we recommend
that users examine the response of end-use demands and consider modifying the elasticities such that
there is less demand response.

e Modifying the electric sector’s coal plant retirement trajectory. GCAM and GCAM-USA include a “profit-
shutdown-decider” function that drives retirement as operational costs increase. We have found that the
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parameterization of this function results in the model being unable to retire existing capacity quickly
enough to meet some short-term decarbonization targets. As a result, users may choose to drive
retirements via adjusting power plant lifetimes or by using the “Tech Bound” option in GLIMPSE.

e Eliminating conventional technologies when using high market share constraints. Some deep
decarbonization scenarios may involve representations of sector specific policies, such as electric vehicle
sales reaching 100% or an RPS reaching 100% in a particular modeled year. When modeling such
scenarios, users are advised to keep in mind how the logit function makes market share decisions in
GCAM. The logit will assign market share based on relative costs, adjusted by technology-specific
shareweights. In most instances, GCAM will assign a non-zero market share to all technologies that are
competing in the market. As a result, market share constraints above 90% can be very challenging, often
resulting in unsolved markets. This problem can be addressed by adjusting the shareweights of
conventional technologies. For example, to meet a 100% EV target, in the years that target must be met,
the shareweights for other technologies in that market can be set to zero, effectively removing them from
the market. In GLIMPSE, the “Tech Avail” feature can be used for this purpose, and shareweight can also
be modified via the “Tech Param” option.

e Incorporating a global tax on CO2 or GHG emissions. When a CO2 or GHG policy is implemented for the
United States in GCAM-USA, bioenergy can be a mechanism that the model uses to decarbonize.
However, biomass is traded in GCAM as a global commodity, so biomass can potentially be imported into
the United States in large quantities. A barrier to this outcome in the real world is that the climate policies
for other countries may also drive competition for biomass, impacting its availability and price. In
simulating Deep Decarbonization scenarios for the U.S., adding a CO2 tax to the other regions in GCAM-
USA may result in more realistic biomass trade.

We provide examples of many of these adjustments in the “DeepDecarbAssumptions.csv” scenario component.
Depending on the needs of users, these assumptions may need to be adjusted. Tutorial B-6 provides an illustrative
Deep Decarbonization exercise that targets Net-Zero CO2 emissions in the United States by 2050.

4.6.2 ADDITIONAL CONSIDERATIONS

There are several additional aspects of deep decarbonization that should be considered. When interpreting the
resulting mitigation strategy, it is important that users keep in mind the myopic nature of GCAM’s solution process.
GCAM solves each time step by optimizing technology and fuel choices based upon conditions within that time
period only - but with no knowledge of conditions in the future. Thus, GCAM will not make short-term decisions
with long-term policy targets in mind, and this will impact the decarbonization pathway that is produced.

Uncertainty is another important consideration. Assumptions about the cost and performance of decarbonization
technologies typically are derived from a combination of peer-reviewed literature and government reports.
Nonetheless, future technology cost and performance are very uncertain, particularly for technologies that have
not yet been deployed commercially. Sensitivity analysis to explore alternative pathways can provide valuable
insights into the roles that technologies may play and into the amount of flexibility available in meeting
decarbonization targets.
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CHAPTER 5. REFERENCE

5.1 BUTTONS AND MENU OPTIONS ON THE SCENARIO BUILDER

In this section, the function of each button and menu option of the Scenario Builder is described.

5.1.1 BUTTONS

Figure 5.1: Scenario Builder window showing buttons.
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See the table below for descriptions of the buttons associated with various parts of the Scenario Builder.

Table 5.1: Buttons in the Component Library.

Icon Description

“New” — Open dialog to create a new scenario component.

“Edit” — Open dialog with the attributes of the selected scenario component loaded for editing.
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=

“Browse” — Opens the folder where the scenario components are stored.

X

“Delete” — Removes the selected scenario component(s). Deleted components are sent to the
“Trash” folder.

O

“Refresh” — Re-scans the scenario component folder in GLIMPSE and refreshes the list of available
components.

Table 5.2: Buttons between the Component Library and “Create Scenario” area.

Icon

Description

p

“Include” — Copies the selected scenario component(s) from the Component Library into the
scenario being created in the “Create Scenario” area.

<

“Remove” — Removes the selected scenario component(s) in the “Create Scenario” area, returning
them to the Component Library.

<«

“Remove all” — Removes all scenario components in the “Create Scenario” area, returning them to
the Component Library.

Table 5.3: Buttons in the “Create Scenario” area.

Icon

Description

“Create” — Create a new scenario by converting scenario components to XML files, as needed,
modifying the template configuration file, creating a folder for the scenario, and adding the scenario
to the Scenario Library table.

“Move down” — Move the order of the selected scenario component down in the “Create Scenario”
list.

b4 O®

“Move up” — Move the order of the selected scenario component down in the “Create Scenario”
list.
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Table 5.4: Buttons in the Scenario Library.

Description

“Modify” — copies the selected scenario from the Scenario Library area to the “Create Scenario”
area where it can be modified.

“Edit” — opens the configuration files for the scenarios that are selected in the Scenario Library area.
The editor specified in the options file is used.

“Browse” — opens the scenario folder for the selected scenario. The scenario folder includes the
configuration file and XML files that were created with the “Create” button in the “Create Scenario”
area is pressed. After a run has been completed, the main_log.txt file, as well as other files
(specified in the options file) associated with the run, are moved to the scenario folder.

v N

“Play” —adds the selected scenarios to the queue of scenarios to be run. If the queue is empty, the
scenario begins to run. If multiple scenarios are selected, they are added to the que in order of
where they appear in the table, from top-to-bottom.

=
=
=

“Results” — starts the Modelinterface and automatically opens the database that is specified in the
options file.

“Results-Selected” — starts the Modelinterface and automatically opens the database associated
with the selected scenario.

“Diff” — compares the configuration files of two selected scenarios. Lines that differ between the
two files are identified and those differences are listed.

“Queue” —shows a list of the runs that have been added to the queue since this session of GLIMPSE
was started. Note that completed runs are not removed from this list. That feature may be added
later.

B Il 4 EF

LOG

“Log” — displays the “main_log.txt” file that is in GCAM’s “exe/log” folder. This button allows you to
monitor the status of the current GCAM run while it is executing, including viewing any warnings or
error messages.

“Log-Selected” — displays the “main_log.txt” file that is associated with the selected scenario(s).

LOG
EXBE “Errors” — examines the “main_log.txt” file in the “exe/log” folder, extracting lines that include the
ERR word “Error.” The lines are displayed in a popup dialog window.

“Errors-Selected” — examines the “main_log.txt” file for the selected scenario and extracts the lines
from it that include the word “Error.” The lines are displayed in a popup dialog window.

B2 BV

“Run report” — scans the “main_log.txt” files associated with the runs in the Scenario Library table
and generates a report of the status of each run, including when the scenario was created, when it
was executed, how long the run took, whether it was completed successfully, the number of errors
reported, and in which model periods did not solve correctly.
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“Refresh” — updates the completion status of the scenarios in the Scenario Library table. Note that
status is not currently updated automatically.

5.1.2 MENU OPTIONS

The menu bar for the Scenario Builder includes the following menus: “File,” “Edit,” “Tools,” “View,” and “Help.”
The contents of each of these menus is described below.

Table 5.5: Contents of the “File” menu.

Menu ltem Description

Show Options Displays a non-editable dialog that shows the contents of the options file. Paths that
use #glimpseDir# and #gCamGuiDir# have been resolved in this dialog.

Edit Options Opens the options file in a text editor. Users can edit the settings in this file, but any
changes do not take effect until either GLIMPSE is restarted or “File>Reload
Options” is chosen.

Reload Options Reloads the contents of the options file, updating settings in GLIMPSE. Note that
options such as “database”, “stop-period”, and “debug region” are not updated in
scenarios that are already in your “Scenario Database”. Re-creating the scenario will

insert the updated values for these options.

Import Scenario Allows users to identify an existing configuration file. GLIMPSE reads the scenario
name from the file and creates a new scenario with that name in the Working
Scenarios table. The scenario can then be executed within GLIMPSE.

Exit Exits GLIMPSE and terminates related processes. Ongoing GCAM runs will continue,
however.

Table 5.6: Contents of the “Edit” menu.

Menu ltem Description
Scenario Builder Files
Scenario Template When GLIMPSE creates a new scenario, it begins with the “Scenario Template” file,

adding in the various selected scenario components and modifying the database,
stop period, debug region name, and scenario name.

Tech List for Bounds The “Tech Bounds List” file is used to populate many of the pulldown menus and
technology lists in the “New Scenario Component” dialog. Only advanced users
should modify this file.

Transportation Load “Load factors” for passenger transportation technologies represent the passengers
Factors per vehicle, while these factors for freight transportation factors reflect tons per
vehicle.
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Preset Region File

The New Scenario Component Creator’s region tree allows users to select the
regions to which a policy will apply. Below the tree is a list of multi-region groupings
that can be used to automatically check groups of states (e.g., New England) or
regions (e.g., North America). Use the “Preset Region File” to populate the list of
multi-region groupings.

XML Header File

The “XML Header File” includes the headers that are used to convert GLIMPSE-
developed scenario components into XML files.

CSV Column File

Query File

Modelinterface Files

The “CSV Column File” is used by GLIMPSE in developing the CSV-formatted files
that represent many scenario components. Only advanced users should modify this
file.

The “Query File” lists all the queries available to the Modelinterface. The name of
this file is obtained from the options file and that is listed in the
“model_interface.properties” file that is in the “GLIMPSE-Modelinterface/exe”
folder.

M| Unit Conversions File

GCAM Setup Files

Solver Config File

The “MI Unit Conversions File” is used by the Modellnterface in converting the units
of data reported by queries. See Section 3.18 for information on modifying this file.

The “Solver Config File” is used to modify parameters associated with the GCAM

solver components.

Table 5.7: Contents of the “View” menu.

Menu Item

Description

Current Main Log

Opens the current “main_log.txt” file from GCAM'’s exe folder. This file can be useful
for debugging many errors and warnings.

Errors in Main Log

Parses the “main_log.txt” from GCAM'’s exe folder and extracts lines starting with
the text “Error.” These lines are then displayed to a dialog window, along with an
analysis of the severity of market solution errors.

Current Solver Log

Displays the solver log, which provides very detailed outputs generated during the
solution process. Experienced users may find this log helpful in identifying
problematic markets.

Current Worst Market
Log

Opens the current “worst_market_log.txt” file from GCAM'’s exe folder. This file can
be useful in understanding solution bottlenecks.
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Current Calibration Log

Opens the current “calibration_log.txt” file from GCAM'’s exe folder. This file can be
useful in debugging calibration issues.

Debug File

Resource Logs

Opens the current “debug.xml” file from GCAM'’s exe folder. For the debug region,
this file provides detailed output that can be useful in debugging.

Provides access to the GLIMPSE log that records computer resource levels at the

initiation of the session and whenever specific thresholds are exceeded.

Current Session

Resource log for the current session.

Prior Session

Browse Folder

GLIMPSE Folder

Resource log for the prior session. The prior log may be most useful if GLIMPSE or
GCAM terminate unexpectedly, and you are checking whether limited resources
may be the underlying cause.

Opens a file explorer window in the specified location.

The GLIMPSE folder (GLIMPSE-v.1.1).

Scenario Folder

The parent folder to the scenario folders.

Scenario Component
Folder

The folder that contains the scenario components.

Contrib Folder

The folder that contains XML files that are not part of the GCAM data system. Many
of these files have been developed by the GLIMPSE team or by other GCAM-USA
users.

Trash Folder

The folder that contains deleted scenario components and scenario folders.

GCAM exe folder The folder where the gcam.exe file is located.

GCAM log folder The folder where log files are stored.

GCAM input folder The folder that contains gcam inputs files and the gcam data system.
GCAM output folder The folder that contains the output databases.
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Table 5.8: Contents of the “Tools” menu.

Menu Item

Description

Create or Open Output
Database

Opens the Modelinterface to the specified database. If the database does not exist,
the user is given the opportunity to create it.

Check Installation

Parses the options file to search for errors, including if required parameters are not
defined and if folders specified in the file do not exist. Also examines the folder
structure and reports if the main GLIMPSE folder is nested within the main GLIMPSE
folder, indicating an installation problem. Finally, reads the “JAVA_HOME"
environmental variable to determine which version of java is specified, then checks
to see if that version is on the system.

Check Current DB Size

Analyzes the current database (usually the one specified in the options file) to
determine its size. Reports the database size in a popup dialog, including a warning
if the database is near its size limit.

Archive Scenario

Supports repeatability to analyzing the configuration file associated with the
selected scenario, then copying all referenced scenario components to a subfolder.
Users can then execute the model using the archived files if desired.

Fix Lost Handle

If GLIMPSE is terminated while a GCAM run is ongoing, GLIMPSE is no longer able to
move the main_log.txt file to the current scenario’s folder. Since GLIMPSE relies on
this file to determine the status of a run, it is no longer able to update the scenario’s
status in the Scenario Library. The “Fix Lost Handle” searches the exe/log folder for a
main_log.txt file, reads the scenario name in that file, then moves the main_log.txt
file into the scenario folder with the same name.

Browse Trash

When scenarios and scenario components are deleted in GLIMPSE, they are placed
in a trash folder. This menu item displays the contents of the trash folder in a file
explorer. Note that there is currently no automated mechanism to undelete items
from the trash folder; however, users can restore deleted scenario components and
scenarios by moving the deleted items from the trash folder to Component Library
folder or Scenario Library folder, respectively

Empty Trash
Advanced

CSV-to-XML

Erases all items in the trash folder.
Provides access to features for advanced GLIMPSE users.

Advanced users may wish to create their own xml files using the CSVtoXML function.
This function requires the user to specify a data file (a CSV file with a specific format)
and an XML header file. The header file includes instructions on how to convert the
CSV to XML. For more information, please see the “CreatingXMLs” folder, accessible
via “Help~>GLIMPSE docs.”

Cleanup saved files

Removes ancillary files that are saved when a GCAM run completes from the various
Scenario folders. These files are specified in the options file, but often include debug

files and solver logs, both of which can be very large.
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Table 5.9: Contents of the “Help” menu.

Menu Item

Description

GCAM Docs (web)

Opens a web browser to the GCAM documentation on PNNL's GCAM GitHub site.

GCAM-USA Docs

Opens a web browser to the GCAM-USA documentation on PNNL's GCAM GitHub site.

GLIMPSE Information
(web)

Opens a web browser to the U.S. EPA’s GLIMPSE webpage.

GLIMPSE Document
Folder

Opens a file browser to a folder with the “GLIMPSE Users’ Guide” and other files that
may be of interest.

ScenarioBuilder
vYY.MM.DD

The date that is listed reflects the time stamp when the Scenario Builder executable file
was created. On some operating systems, this date may reflect the date the GLIMPSE
package was unzipped.

Modellnterface

The date that is listed reflects the time stamp when the Model Interface executable file

vYY.MM.DD was created. On some operating systems, this date may reflect the date the GLIMPSE
package was unzipped.

GCAM build The date that is listed reflects the time stamp when the GCAM executable file was

vYY.MM.DD created. On some operating systems, this date may reflect the date the GLIMPSE
package was unzipped.

About “About” produces an information dialog with additional information about GLIMPSE,

including notification of export restrictions.

5.2 SCENARIO COMPONENTS

GLIMPSE comes with many scenario components included in the Component Library. In this section, brief

descriptions are provided for each of the scenario components included with GLIMPSE. In addition, users can

modify these scenario components or develop their own using the New Scenario Component Creator dialog. We

describe each of the types of scenario components that can be created.

5.2.1 SCENARIO COMPONENTS INCLUDED IN THE COMPONENT LIBRARY

We include example policies and other scenario components in the Component Library. These are listed and

described below. Scenario components with an asterisk (*) are part of the GLIMPSE-1.1-Ref scenario.
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Table 5.10: Scenario components included with GLIMPSE.

Scenario Component

Description

Calib-Bio-and-CCS-limits-in-NewEngland.csv

Does not allow biomass or CCS to be used for electric
power generation in New England.

Calib-coal-egu_2020.txt

Constrains state-level output from coal-fired power
plants in the 2020 model year to be no more than
2021 real-world data. The purpose of this constraint is
to reflect coal plant retirements that have occurred in
recent years. 2020 was not used as the source of the
state-level values since data from that year were
skewed because of COVID-19-related lockdowns and
their impacts on energy demands.

Calib-LDV-EV-AE02020.csv

Limits onroad passenger vehicle electrification (e.g.,
“Cars” and “Large Cars and Trucks”) to levels projected
in the Energy Information Administration’s Annual
Energy Outlook 2020. AEO projections are relatively
low, with the sales share growing slowly to reach
about 10% in 2050. This constraint may be useful in
some applications as a baseline level against which the
impacts of greater electrification are evaluated.

Calib-Lo_alt_biofuel_SW.csv

Applies low shareweights to advanced biofuel
production technologies. The purpose of these
constraints is to reflect the slow development of these
technologies in recent years. In aggressive
decarbonization scenarios, modelers may wish to
remove or modify this file.

Calib-Lower_Income_Elasticity_Tran.txt

Some scenarios that result in cost increases to
transportation can result in significant declines in
service activity (e.g., international aviation demand
declining by 50%). This file adjusts the price-elasticity
of transportation sectors to reduce the demand
response. Note that GCAM can still shift travel
between modes (e.g., air, rail, onroad).

Calib-NE_fixed_nuke_output.csv

Forces electricity production from nuclear power
plants in New England to follow a retirement schedule
that reflects projections provided by Connecticut’s
Department of Energy and Environmental Resources.
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Scenario Component

Description

Calib-NE_fixed_nuke_output_Thru_2020.csv

A version of Calib-NE_fixed_nuke_output that adds
constraints only through 2020, allowing the model to
make its own decisions in subsequent years.

DeepDecarbAssumptions.txt

A set of add-on XMLs that may be helpful when
running deep decarbonization targets. These include:

e sets the price elasticity of zero for international
aviation, which avoids the model response of
international aviation demand diminishing
unrealistically when faced with deep
decarbonization targets;

e sets the price elasticity of zero for other industrial
energy use, which avoids the model response of
industry production diminishing unrealistically
when faced with deep decarbonization targets;

e adjusts the shareweights of advanced
transportation technologies such that any non-
cost biases (e.g., range anxiety) and technical
issues (e.g., weight of batteries for aviation) are
addressed earlier, allowing these technologies to
play a greater role in mitigation; and

e ataxof $25/tC (1990Ss), growing at 5%, is applied
to the rest of the world to reflect changes in
demand for bioenergy and fossil fuels in a
scenario in which there is some degree of
international cooperation to decarbonize.

Policy-100pct-HDV-EV-Heavy-2050.csv
Policy-100pct-HDV-EV-Light-2050.csv
Policy-100pct-HDV-EV-Medium-2050.csv

Policy-100pct-HDV-EV-NoConv-2050.csv

Example policy files that set a sales target of 100% EV
(electric and fuel cell) for freight trucks by 2050.
Separate components are used for different sizes since
the various truck sizes have different load factors.
Alternatively, the sales target can be applied across all
categories, but this can lead to major shifts from one
size vehicle to another.

The file Policy-100pct-HDV-EV-NoConv-2050.csv
complements the target files by only allowing
hydrogen and electric vehicles to be purchased in
2050. A 100% EV sales target will typically require a
complementary file such as this since the logit will not
allow for a 100% market share otherwise.
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Scenario Component

Description

Policy-100pct-LDV-EV-2050.csv

Policy-100pct-LDV-EV-NoConv-2050.csv

Example policy files that set a sales target of 100% EV
(electric and fuel cell) for passenger cars and trucks by
2050.

The file Policy-100pct-LDV-EV-NoConv-2050.csv
complements the target files by only allowing
hydrogen and electric vehicles to be purchased in
2050. A 100% EV sales target will typically require a
complementary file such as this since the logit will not
allow for a 100% market share otherwise.

Policy-100pct-LDV-EV-2035.csv

Policy-100pct-LDV-EV-NoConv-2035.csv

Example policy files that set a sales target of 100% EV
(electric and fuel cell) for passenger cars and trucks by
2035.

The file Policy-100pct-LDV-EV-NoConv-2035.csv
complements the target files by only allowing
hydrogen and electric vehicles to be purchased in
2035. A 100% EV sales target will typically require a
complementary file such as this since the logit will not
allow for a 100% market share otherwise.

Policy-CES_100x35_USA_acr.csv

Example policy that implements a national 100% CES
by 2035.

Policy-CES_100x50_USA_acr.csv

Example policy that implements a national 100% CES
by 2050.

Policy-CO2-Cap-100x50_USA.csv

Example policy that specifies a declining cap on
national CO2 emissions. The cap starts at roughly 2020
levels in 2020, declining linearly to zero in 2050. This
cap is not intended to represent any particular policy,
but instead to capture some of the dynamics
necessary to meet deep decarbonization targets.
Achieving this target may require aggressive use of
direct air capture (DAC) and carbon capture and
storage (CCS). DAC is not included in GLIMPSE-1.1-Ref
but can be added via the “tech-DAC.txt” scenario
component. Users may also elect to include the
“DeepDecarbAssumptions.txt” scenario component
that includes additional modifications to assumptions.
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Scenario Component

Description

Policy-CO2-Cap-80x50_USA.csv

Example policy that specifies a declining cap on
national CO2 emissions. The cap starts at roughly 2020
levels in 2020, declining linearly to a value that is 20%
of the starting value. This cap is not intended to
represent any particular policy, but instead to capture
some of the dynamics necessary to meet stringent CO:
reduction targets. Users may also elect to include the
“DeepDecarbAssumptions.txt” scenario component
that includes additional modifications to assumptions.

Policy-CO2-Cap-netZero-after-land-sink-2025start.csv

Example policy file that specifies a declining cap on
CO2 emissions. The cap starts at roughly 2020 levels in
2020, declining linearly to zero in 2050 — after
accounting for land sink opportunities. Thus, the cap
does not go to zero. This cap is not intended to
represent any particular policy, but instead to capture
some of the dynamics necessary to meet deep
decarbonization targets. This Net-Zero CO2 trajectory
was used in the Energy Modeling Forum 37 inter-
model comparison exercise ().

Policy-HDV-MOU-Heavy-EV_New.csv,
Policy-HDV-MOU-Medium-EV_New.csv

Policy-HDV-MOU-NoConv-in-2050.csv

Example policy file that implements medium- and
heavy-duty electrification targets that have been
outlined in a multi-state memorandum of
understanding (https://afdc.energy.gov/laws/12460).

In this implementation, we model sales targets that
increase from 15% in 2025 to 100% in 2050. This
implementation assumes that the target is adopted by
CA, CO, CT, DC, HI, MA, MD, ME, NC, NJ, NY, OR, PA,
RI, VT, and WA. Users may elect to change the states
to which the constraint is applied to reflect the most
recent set of states that have adopted the target.

Policy-IRA-basedOnCGS.txt

In support of report “Electric sector emissions impacts
of the Inflation Reduction Act” EPA 430-R-23-004 (Sept
2023), the Univ. of Maryland’s Center for Global
Sustainability and PNNL created add-on files that
reflect some of the key provisions of the Inflation
Reduction Act of 2022. That modeling was conducted
using GCAM-USA 5.3, but we have mapped those
implementations to GCAM-USA 7.0 and include them
here. Provisions represented include:
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Scenario Component

Description

e the Production Tax Credit and Investment Tax
Credit

e tax credits or subsidies for CCS, hydrogen,
residential and commercial energy efficiency
improvements, electric vehicles, rooftop PV, and
alternative fuels; and

e controls and a price on methane emissions.

Note that this representation of the IRA does not
include all of its provisions. For example, the Green
Bank and Climate Pollution Reduction Grant programs
are not reflected.

Policy-RGGI-hold.txt*

Policy file that caps electric sector CO; emissions for a
set of states in the Northeast US through 2030 based
upon the targets outlined by the Regional Greenhouse
Gas Initiative. Holds the targeted values constant from
2030 through 2050.

Policy-RGGI-Thru20200nly.txt

Policy file that caps electric sector CO2 emissions for a
set of states in the Northeast US through 2020 based
upon the targets outlined by the Regional Greenhouse
Gas Initiative. No caps are included after 2020. This
version should be used instead of “Policy-RGGI-
hold.txt” for scenarios that include deep
decarbonization targets or that place potentially
conflicting constraints on the electric sector (e.g.,
through an RPS or CES).

Policy-RPS_80x50_Natl.csv

Example policy file that sets an increasing target on
the fraction of electricity that must be produced from
renewable sources. The target increases linearly to a
value of 80% in 2050.

Policy-Sect177-ZEV-PassLDV-NewCATargets.csv,
Policy-Sect177-ZEV-FreightLt-NewCATargets.csv,

Policy-Sect177-ZEV-PassLDV-NewCATargets-
NoConv.csv,

Policy-Sect177-ZEV-FreightLt-NewCATargets-
NoConv.csv

Example set of policy files that together are intended
to represent the new CA light duty electrification
targets (100% sales of electric and hydrogen fuel cell
vehicles), extended to all of the Section 177 states. In
these files, the assumption is made that the target is
adopted by the following states: CO, CT, DE, MA, MD,
ME, MN, NJ, NY, OR, PA, RI, VT, and WA. Users can
update the set of states to which the targets are
applied as the set changes.
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Scenario Component

Description

Policy-StateCO2RdxTargets-asOf2021.txt

Example policy file that reflects state-level, economy-
wide CO2 reduction targets that had been adopted by
2023. Many of these targets reflect an 80% reduction
by 2050, and some of the newer targets indicate net-
zero emissions by 2045. At the state level, many of
these targets cannot be achieved in GCAM. To address
this, we have implemented state targets across broad
sets of states, providing the model more flexibility.

Policy-State_RPS_targets.txt*

Example policy file that reflects state-level Renewable
Portfolio Standards (RPS) and Clean Energy Standards
(CES) that had been adopted by late 2021. These
constraints are mapped to the grid region level, and so
each state may not meet its target, but collectively the
targets will be met. This RPS representation is very
memory intensive and users with limited
computational resources may opt to leave it out.

Policy-State_RPS_targets_20200nly.txt

Policies such as Clean Energy Standards may conflict
with the state RPSs and cause solution issues. To
address this potential issue, this file carries state RPSs
only through 2020 to reflect conditions in that year.

Tech-DAC.txt

Adds a representation of Direct Air Capture
technologies (DAC). These technologies, which have
not yet been commercialized, are able to remove CO:
from the atmosphere.

Tech-ElecTechs-bldgs.csv

Forces electrification of buildings by not allowing the
purchase of non-electric technologies in residential
and commercial buildings (excluding biomass) after
2015 or 2020. Also does not allow purchase of
incandescent lighting in residential and commercial
buildings after 2020.

Tech-HDV-HeavyEVSales-50x50.csv,
Tech-HDV-LightEVSales-50x50.csv,

Tech-HDV-MediumEVSales-50x50.csv

Implements heavy-duty electric vehicle sales targets of
50% in 2050.
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Scenario Component

Description

Tech-HighEffElecTechs-bldgs.csv

Example technology assumption file that forces
electrification via the highest efficiency electric
technology option in buildings.

Tech-HighEffTechs-bldgs.csv

Example technology assumption file that forces high
efficiency technology adoption in buildings.

Tech-LDV-EV-80x50-sales.csv

Example technology assumption file that requires the
EV sales share to climb linearly to 80% by 2050.

Tech-Low-AltRefining.csv

Example technology assumption file that uses a low
shareweight trajectory to limit the market share of
alternative liquid fuel production technologies.

Tech-NoCCSinNewEngland.csv

Example technology assumption file that does not
allow carbon capture in New England, reflecting the
region’s limited underground storage potential.

Tech-NoCCSinUSA.csv

Example technology assumption file that does not
allow carbon capture and sequestration (CCS) to be
deployed.

Tech-NoConvBioEGU.csv

Example technology assumption file that introduces a
requirement that all biomass combustion technologies
in the electric sector use gasified biomass.

Tech-OnroadTrn-SW-Ref-Updates.txt

Example technology assumption file that adjusts the
technology-specific shareweight trajectories for
electric and fuel cell technologies in onroad passenger
and freight vehicles. With these revised trajectories,
the years trajectories transition to 1 are provided
below.

e light-duty hybrid: 2025
e light-duty EV: 2035

e light-duty FCEV: 2050

e heavy-duty hybrid: 2035
e heavy-duty EV: 2050

e heavy-duty FCEV: 2055

Tech-NoLDVCNGs.csv,

Example technology assumption files that do not allow
light-duty natural gas vehicles, fuel cell vehicles, and
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Scenario Component

Description

Tech-NoLDVFCEVs.csv,

Tech-NoOnroadEVs.csv

electric vehicles, respectively. These are useful for
sensitivity analyses.

Updates-PostGCAM7Release.txt*

Includes several minor adjustments that were not
included in the GCAM-USA 7.0 Reference Case that
was distributed with GCAM. These include additional
constraints on global biomass that were previously
used in GLIMPSE 1.0, a fix to the battery storage
technology representation, and modifications to the
solver settings to improve performance on state-level
market share constraints.

Updates-GLIMPSEv1.1-AddOnFiles.txt*

Includes references to many add-on files in the
“Contrib” folder, such as:

e updates to emission factors in the power sector,
onroad transportation sector, and to air, rail, and
marine sources;

e constraints that: eliminate new industrial coal
capacity in states that have adopted Climate
Action Plans and new electric sector coal capacity
in states that do not have coal reflected in their
current generating mix; limit new biomass
combustion in the electric sector to use gasified
biomass;

e represent several state and regional constraints,
including eliminating electric sector use of
biomass in MA, requiring at least existing
procurements of offshore wind in the Northeast
U.S., and eliminating CCS as an option in New
England (reflecting lack of storage resources);

e adjustment to onroad vehicle lifetimes to be more
consistent with EPA estimates;

e upper bounds on state-level generation from coal
plants for 2020 to reflect witnessed retirements;

e updates to transportation shareweights to
provide consistency across modes and
technologies; and

e adjustments to shareweights in the buildings
sector to reflect real-world trends for heat pumps.
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Scenario Component

Description

individually within the Component Library.

Note: Some of these add-on components are available

* Files with an asterisk indicate inclusion in the GLIMPSEv1.1-Ref scenario

5.2.2 DEVELOPING NEW SCENARIO COMPONENTS USING THE NEW SCENARIO COMPONENT CREATOR

GLIMPSE supports the creation of several types of scenario components, which are summarized in the following

table. Additional information regarding the options for each are provided in the next subsection. Please see

Appendix B-3 for an example of how to construct a new scenario component. Here, we provide supplemental

information to explain the differences between the available options.

Table 5.11: Tabs and types of scenario components supported by the New Scenario Component

Creator.
Tab name Type Description
XML List Various Construct a scenario component that consists of a user-

defined list of existing XML add-on files.

Pollutant Tax/Cap

Pollutant taxes or

Specify a tax (1990S/tonne) on CO; or on GHGs or specify

constraint

caps system-wide caps on annual emissions for a region or across
regions.

Tech Avail Technology Specify whether and when specific technologies are
availability available for purchase.

Market Share Minimum or fixed Specify the minimum or fixed ratio (as a %) between the
market share sum of output from one set of technologies and the sum of
constraints output from another set. This feature has pre-sections for

policies such as RPSs, CESs, LED, heat pump, and vehicle
electrification targets.

Tech Bound Technology output Specify an upper, lower, or fixed constraint on the output of

a technology.

Tech Tax/Subsidy

Technology taxes
and subsidies

Modify the levelized cost of a technology by a specific
amount to reflect a tax or subsidy.

Tech Param

Technology
parameters

Provide updated values for the attributes of a technology,
including capacity factor, capital cost, efficiency, fixed
output, shareweight, subsector shareweight, lifetime, half-
life, or emission factor.

Fuel Price Adj

Modifies fuel prices

Allows prices for coal, crude oil, unconventional oil, natural
gas, and biomass to be adjusted.
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Each of these options is provided on a separate tab of the New Scenario Component Creator dialog window:

Figure 5.2: Tabs reflecting the main categories of scenario components that can be constructed via the
New Scenario Component Creator.

B | Mew Scenaric Component Creator

|XML List| Pollutant Tax/Cap | Tech Avail | Market Share | Tech Bound | Tech Tax/Subsidy | Tech Param | Fuel Price Ad)

Together, these tools will allow you to create a wide range of scenario components that reflect alternative policies
and assumptions. In the next subsection, we go through each tab, highlighting key features and limitations.

XML LIST

Experienced GCAM users likely will have created XML-formatted “add-on” files previously. These may represent
alternative technology costs or efficiencies or may represent specific policies. An “XML List” component allows a
GLIMPSE user to “point” to one or more existing XML add-on files. When GLIMPSE creates a scenario and reaches
an XML List scenario component, it will add the files in the XML List to the scenario template.

Clicking “Add” will display a file browser that will allow you to select one or more XML files. Since the order of
input files is important in GCAM (with later files overriding values from earlier files if the same parameters are in
both), you can use the “Move Up” and “Move Down” buttons to change the order of the files in this list. Click on
the “Save” button to create the XML-list-type scenario component. You will have the opportunity to provide a
unigue name when saving.

In the example below, the XML list points to three files. Including this Scenario Component in a Scenario would
result in these files being added to the scenario’s configuration file.
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Figure 5.3: “XML list” components point to existing xml-formatted add-on files.

In this example, the XML list points to three files. Including this Scenario Component in a Scenario would result in
these files being added to the scenario’s configuration file.

B Mew Scenaric Component Creator *

|XML Listl Pollutant Tax/Cap | Tech Avail | Market Share | Tech Bound | Tech Tax/Subsidy | Tech Param | Fuel Price Adj
XML Files:
Add Move Up || Move Down Delete Clear
XML Filename
ol wf o/ Contrib/Calibration/bicenergy_constraint\bio_ceiling_constraint_statexm]|
. f./Contrib/Calibration/bioenergy_constraint\bio_ceiling_constraint_ROW.xm|

..f./../Contrib/Calibration/bioenergy_constraint\bio_ceiling_mkt_global.xml

Save Close

POLLUTANT TAX/CAP

Pollutant taxes and caps can be created on this tab. “Measure” allows the user to indicate which of these two
options is being created. The tax or cap can be applied system-wide or, for CO2, can be applied to a specific sector.
Taxes or caps can be applied to the pollutants listed in the “Pollutant” choice box. Note the units in parentheses.
For CO., you have the ability to specify your cap or tax in units of MTC or MTCO.. If you chose “GHG (MT CO2zE),”
the cap or tax is specified in units of CO2 equivalent and is applicable across GHG species, considering their global
warming potentials.
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Figure 5.4: Pollutants to which a cap or tax can be applied.
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The figure below shows an example of how the New Scenario Component Creator could be used to construct a tax

on CO; emissions from the electric sector that starts at $100/tCO, increasing at 5% per year. Here, the “USA”

region is selected, indicating that the tax is applied to all states.
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Figure 5.5: The “Pollutant Tax/Cap” tab.
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TECH AVAIL

Controlling the availability of technologies is a powerful tool for conducting sensitivity analysis. For example, by
not allowing conventional vehicles to be purchased after 2030, one could explore a scenario where 100% of vehicle
purchases post-2030 are electric vehicles. Similarly, this option can be used to examine the benefits of buildings
electrification or of only allowing high-efficiency end-use technologies.

The “Tech Avail” tab allows the user to specify over what time period and in which regions a particular technology
or set of technologies is available for purchase.

Clicking on “Never” next to a technology will mean that the technology can never be purchased. This option can be
used to specify scenarios that, for example, do not include nuclear capacity additions or CCS. Alternatively, you can
make a technology available only within a specific range of years.

The “Filter” options allow the user to view just a subset of the technologies. For example, typing “resid” would
show residential technologies. The “Never” and “Range” buttons will automatically toggle all visible check boxes in
the “Never?” and “Range?” columns, respectively. You can edit the years for which each technology is available by
double-clicking on a cell, typing a new value, then pressing “Enter”. Alternatively, you can set the values in the
“First” and “Last” columns for all visible cells simultaneously using the “First yr:” and “Last yr:” fields at the bottom,
then clicking “Set Years.”
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In the following example, we have specified that “Car,” “Large Car and Truck,” and “Mini Car” vehicles powered by
natural gas can only be purchased from 1975 to 2015 in NC. This essentially eliminates their sale in the state after
2015.

Figure 5.6: The “Tech Avail” tab.
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MARKET SHARE

The “Market Share” tab can be used to implement market share targets for one or more technologies. The user
specifies a ratio (expressed as a % of either sales or activity) between the outputs of one set of technologies and
those of another. The technologies that make up the “numerator” in the ratio are specified via the “Subset:”
selector, while the technologies in the “denominator” are specified via “Superset:”. For example, if you want to
specify that 50% of “Car” sales be electric, the “Subset” would include BEV (battery-electric-vehicles) Cars, while
the Superset would include all Car technologies.

For convenience, there are several pre-specified options, including a Renewable Portfolio Standard (RPS), Clean
Energy Standard (CES), and light duty electrification targets for cars and trucks. Selecting one of these options will
pre-populate the “Subset” and “Superset” selections. A message will pop up indicating that the user should check
the selections to determine if they meet their objectives. For example, an RPS may include hydropower in one
state, but not in another. Hydro is automatically checked when the user selects “RPS.”
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Figure 5.7: Pre-set options for specifying market share constraints.
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The options next to “Constraint:” allow you to specify whether this is a “Lower Bound” or a “Fixed Bound.” If
“Lower Bound,” percentages must be equivalent to the constraint or higher. If “Fixed Bound,” the constraint must
be met exactly. The “Lower Bound” tends to be easier for the solver to meet, and we advise that it be used instead
of the “Fixed Bound” where possible.

The “Applied to:” pulldown menu allows the market share constraint to apply to either the entire stock or just to
new purchases. This distinction is important since some policies (e.g., EV targets) typically target a sales
percentage, while others (e.g., RPS or CES) are applied to the output of both existing and new stock.

The “Treatment:” option allows the constraint to be applied to “Each Selected Region” or “Across Selected
Regions.”

Together, these options provide a wide range of constraint designs. Below, we have specified an RPS that increases
from 20% in 2020 to 100% in 2050. The target is applicable to overall electricity production as opposed to sales and
is a national total.
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Figure 5.8: The “Market Share” tab.
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TECH BOUND

While “Market Share” allows the user to specify targets as percentages, the “Tech Bound” option allows a

constraint to be placed on the output of one or more technologies. The constraint can represent an upper, lower,
or fixed bound, and is specified in the output units of the technology.

Similar to the “Market Share” option, the constraint can be applied for each selected region or across regions.

Below is an example in which a “Tech Bound” constraint is used to force offshore wind in the Northeast U.S. to be

equal to or higher than current planned procurements.
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Figure 5.9: The “Tech Bound” tab.
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TECH TAX/SUBSIDY

The “Tech Tax/Subsidy” tab allows the user to adjust the price of a technology. Both taxes and subsidies are
expressed as positive values. Taxes add to the cost of a technology while subsidies are subtracted from the cost.

The default price adjustment is in “billion 1975Ss per unit of output”. For example, a subsidy on a lighting
technology would be specified in “billion 1975S5/peta-lumen-hours”, which is equivalent to “19755s/mega-lumen-
hours”. Similarly, for rooftop solar PV, a subsidy would be in units of "billion 1975$s/EJ”, which is equivalent to
“1975S$s/GJ”. An exception is in the transportation sector, where price adjustments are supplied in units of
“19908Ss per vehicle-kilometer”. To clarify what units are needed, the “Units:” label is updated to reflect the
selected technologies.

Values in the table in the middle of the tab must conform to the specified units. However, the “Populate” area at
the bottom left provides the ability to auto-populate the table. In this area, users have the option to specify taxes
or subsidies in more recent $-years (e.g., 2000, 2005, 2010, 2015, 2020, or 2023), with those values then being
automatically converted to the S-years required by GCAM (e.g., 1975Ss or 1990Ss, depending on the sector) via
the “Convert $s from:” option.

In the example below, the “Tech Tax/Subsidy” tab is used to create a U.S.-national subsidy for rooftop PV solar.
The “Sector” is “elec_td_bld” meaning electric transmission and distribution, buildings. The “Tech(s)” is
“elec_td_bld : rooftop_PV : rooftop_pv : EJ” and the “Type” is “Subsidy.”
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In this example, we will apply a subsidy of 0.05 2023Ss/kWh, starting in 2025 and ending in 2035. This reflects
approximately a 30% subsidy based upon electricity prices in 2023. First, we need to convert the units to $s per GJ,
as indicated in the “Units:” label. One kWh is equivalent to 3.6e-3 GJ, and thus, our 0.05 2023Ss/kWh subsidy is
equivalent to 13.9 20235s/GlJ.

The figure below specifies this subsidy, including the “Convert Ss from:” indicating that the values we are supplying
are in 2023Ss. Clicking “Populate” converts these to 1975S$s before populating the table, resulting in values of 2.36
1975$s/GJ.

Note that while unit conversion within the New Scenario Component Creator was a requested feature by many of
the first users of GLIMPSE, users can continue to complete their own unit conversions to default GLIMPSE units
outside of GLIMPSE if preferred.

Figure 5.10: The "Tech Tax/Subsidy" tab.

[87 New Scenario Component Creator X
I'e
1] | XML List | Pollutant Tax/Cap || Tech Avail | Market Share | Tech Bound | Tech Tax/Subsidy | Tech Param | Fuel Price Adj
{
Specification: Values:
: Select region(s):
Filter:
Populate Delete Clear ~
¥ |—| world
Sector: elect_td_bld v
- ‘ — = Year Value > V] USA
ech(s): elect_td_bld : rooftop_pv... >
2025 236 Canada
Type: Subsidy = Central America and Caribbean
2030 2.36
Mexico
Units: 1975%s per GJ 2035 2.36 @
p Brazil |
South America_Northern
. |
Names v/ Auto? South America_Southern
| Policy: 2 ~Nie Argentina |
; Market: Colombia |
EU-15
Populate: Sl
Type: Initial w/% Growth/yr - European Free Trade Association
Europe_Eastern
Start Year: 2025
Europe_Non_EU
End Year 203> Africa_Eastern
Initial Val: 139 Africa_Northern
Growth (%): 0
| S 4 Presets: Select (optional) -
Il Convert §s from: 20238s >
| Add
i
L
Save Close
TECH PARAM

The “Tech Param” tab allows users to modify a subset of technology attributes, including their shareweight,
lifetime, and half-life. Additional attributes options are being tested and may be added in the future.
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Figure 5.11: The “Tech Param” tab.
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FUEL PRICE ADJ

“Fuel Price Adj” allows users to develop alternative scenarios about the prices of coal, natural gas, oil, and biofuels

into the future. One or more fuels can be selected for adjustment. The adjustments must be provided in units of
1975S$s per GJ or use the “Convert $s from:” menu to convert from dollars per GJ in a different year. In the
example below, a 100 2020S$/EJ increase in cost is applied globally from 2020 through 2030.
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Figure 5.12: The “Fuel Price Adj” tab.
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5.3 GLIMPSE QUERIES IN THE MODELINTERFACE

When a GCAM run is completed, the results are saved to a database. The database is typically in a subfolder of the
GCAM-Model\gcam-v7.0\output, such as “database.” The contents of the database folder include seven files that
end in “.basex”. These are binary files that cannot be opened directly. Instead, data are extracted from the
database using queries that are written in the XPath query language. These queries can be executed via R scripts or
via the Modelinterface. Queries are located in a query file, which is specified in “GLIMPSE-
Modelinterface/exe/model_interface.properties”. GCAM’s query file is typically “standard_queries.xml”. In
GLIMPSE, a file named “Main_queries_GLIMPSE-7p0.xml” is used instead. This file includes all the queries in the
file but adds several groups of “GLIMPSE” queries to the top of the list. These include the
queries that we have found to be of most use to GLIMPSE users.

In

“standard_queries.xm

When choosing which queries to use, it is important to be familiar with the terminology in their names.

Primary energy refers to energy (e.g., natural gas, crude oil, coal, or biomass) that has not been converted or
transformed to another form (e.g., electricity, gasoline, or biofuels). Wind and solar energy are sometimes
reported as direct equivalents (the amount of electricity produced) or as fossil equivalent (the amount of
electricity produced, divided by the average fossil efficiency factor, often 33%).
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Final energy is the energy used in meeting end-use demands. Therefore, the natural gas going into power
generation is not final energy, but the electricity being used in residences is.

Cogen and combined heat and power (CHP) are used synonymously. Both represent industrial technologies that
produce both electricity and heat. Electricity production from these technologies is typically used within the
industry’s fenceline, meaning that it is not sold onto the electric grid.

Many of the queries refer to “sectors.” This is a GCAM model construct that is somewhat analogous to economic
sectors. However, the sector names are not always intuitive. For example, instead of reporting “electric sector”

” ou;

outputs, results are reported as “baseload generation,” “intermediate generation,

» u

peak generation,” and
“subpeak generation.”

The GLIMPSE queries include additional aggregation into groupings that may be more intuitive. Aggregated sectors

” ou;

include “electricity,” “industry,” “fuel production,

nu

commercial,” “residential,” “transport-LDV,” “transport-HDV,”
and “transport-ALM.” In these aggregations, “industry” includes all industrial processes except those related to the
fuel chain. “LDV” is “Light-Duty Vehicles” and represents passenger cars and trucks. “HDV” is “Heavy-Duty
Vehicles.” This includes Heavy, Medium, and Light trucks used for moving freight. “Fuel production” includes oil
and gas production, coal mining, refining, and pipelines.

Below, we list the queries that fall under the GLIMPSE categories, providing a brief description of each. Where a
query is followed by “(GCAM-USA)” or “(core),” users must use the query corresponding to the version of the
model they are using, where “core” indicates GCAM.

Queries that end in “(Total)” will sum results across all selected regions. The “(Total)” queries are not shown in the
tables below.

Table 5.12: Query group — Converted Units.

Query Description and use

GHG emissions by pollutant and region | GHG emissions, converted to units of million metric tonnes
(CO2eq) (mmCOeq), by pollutant.

NOx, SO2, PM2.5, VOC, CO, NH3 by Selected air pollutant emissions, converted to units of short tons.
region (short tons)

NOx, SO2, PM2.5, VOC, CO, NH3 by Selected air pollutant emissions by aggregated sector, converted to
aggregate sector (short tons) units of short tons.
CO2 prices (20205/tC02) Prices on CO2 in 2020S/metric tonne of CO2, converted from the

reported units in 1975Ss or 1990Ss.

Prices of all markets (2020Ss) Prices for various markets, reported in 2020Ss after conversion from
the reported units in 1975Ss or 1990Ss.

Elec prices by sector (20205/kwh) Electricity prices, converted from million 1975S5s/EJ to 2020S/kWh.

Refined liquid prices (20205/gal) Refined liquid prices, converted from million 1975$s/EJ to
2020S/gallon (gasoline equivalent).
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Table 5.13: Query group — Primary and final energy.

Query

Description and use

Primary energy consumption by region
(direct equivalent)

Primary energy consumption without converting wind and solar to
fossil equivalents. Useful in examining how resource consumption
changes over time.

Final energy consumption by region

Regional totals of final energy, summing all fuels and energy services.
Useful in examining how demands for energy change over time.

Final energy consumption by aggregate
sector

Final energy, summed across fuels, but does so at the aggregated
sector level. Useful in understanding which sectors consume the most
energy and how their energy demands change over time.

Final energy consumption by aggregate
sector and fuel

Final energy consumption by fuel, at the aggregated sector level.
Useful for understanding how much fuel is used in each sector.

Final energy consumption by sector
and fuel

Final energy by fuel but does so at the GCAM sector level.

Table 5.14: Query group — Energy inputs by sector.

Query

Description and use

Electricity use by aggregate sector

Electricity use at the aggregated sector level. Results include both
final energy and the electricity consumed in conversion technologies
(e.g., refineries). Useful in understanding in which sectors electricity
is being used and how that use changes over time.

Coal use by aggregate sector

Coal use at the aggregated sector level. Useful in understanding in
which sectors coal is being used and how that use changes over time.

Natural gas use by aggregate sector

Natural gas use at the aggregated sector level. Useful in
understanding in which sectors natural gas is being used and how
that use changes over time.

Refined liquids use by aggregate sector

Refined liquids (e.g., gasoline, diesel, and biofuels) use at the
aggregated sector level. Useful in understanding in which sectors
liquid fuels are being used and how that use changes over time.

Biomass use by aggregate sector

Biomass use at the aggregated sector level.

Hydrogen use by aggregate sector

Hydrogen use at the aggregated sector level.

End-use energy consumption in
buildings

Energy used across the buildings sector by fuel.

End-use energy consumption in
buildings (detail)

Energy used in various applications within the buildings sector by
fuel.
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End-use energy consumption in
transportation

Energy used across the transportation sector by fuel.

End-use energy consumption in
transportation (detail)

Energy used in various applications within the transportation sector
by fuel.

End-use energy consumption in
industry

Energy used across the industrial sector by fuel.

End-use energy consumption in
industry (detail)

Energy used in various applications within the industrial sector by
fuel.

Energy inputs in electricity production

Quantities of various fuels used by each electricity production
subsector. Useful in quantifying fuel use in the electric sector.

Energy inputs in electricity production
(detail)

Quantities of various fuels used in electricity production. Useful in
quantifying fuel use in the electric sector.

Energy inputs to refining activities

Fuels used in producing refined liquids, including petroleum-based
fuels and alternative fuels.

Table 5.15: Query group — Technologies.

Query

Description

Electricity generation by region
(centralized)

Total electricity produced in each region. Industrial generation via
combined-heat-and-power and co-gen are not included in this total.

Electricity generation by region (incl
cogen)

Total electricity produced in each region. Industrial generation via
combined-heat-and-power and co-gen are included in this total.

Electricity generation via rooftop PV by
region

Total electricity produced by residential and commercial rooftop solar.

Electricity generation by gen and
cooling tech (incl cogen)

Generation of electricity by each combination of generation and
cooling technology. This is the most detailed electric sector output.

Electricity generation by aggregated
subsector

Generation of electricity by major fuel category (such as coal, natural
gas, wind, and solar), with electricity production with CCS reported
separately.

Electricity generation by aggregated
subsector rnw detail

Generation of electricity by major fuel category (such as coal, natural
gas, wind, and solar), with electricity production with CCS and various
solar and wind technologies reported separately.

Electricity generation by subsector

Electricity generation at the subsector level. Useful when you are

interested in broad shifts over time (e.g., changing market shares
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Query

Description

among coal, gas, wind, and solar), as opposed to detailed information
about the specific coal or gas technologies.

Electricity generation by tech and
cooling (incl cogen)

Electricity production by combination of generation and cooling
technology.

Electricity generation by tech and
cooling (incl cogen)(new capacity)

Electricity production by vintaged combination of generation and
cooling technology.

Electricity generation by cogen only

Electricity produced by cogen and combined-heat-and-power
technologies.

Electricity generation input by
subsector

Fuel used in electricity production.

Building final energy by tech

Final energy used in buildings by technology.

Building service output by tech

Service outputs in the residential and commercial sectors, reported by
uses such as space heating, water heating, and lighting.

Building service output by tech (sales)

Sales to meet service outputs in the residential and commercial
sectors, reported by uses such as space heating, water heating, and
lighting.

Industry final energy by tech and fuel

Final energy used in industry by technology.

Refined liquids production by tech
(GCAM-USA)

Quantity (EJ) of liquid fuels produced by various technologies, such as
oil refining, corn and cellulosic ethanol production, biodiesel, and
flow-through gasoline fuels.

Hydrogen production by tech

Hydrogen production by technology.

Transport final energy by tech and fuel

Final energy used by technology in meeting end use service demands.

Transport service output by tech

Transportation service outputs met by various technologies and fuels.

Transport service output by tech
(sales)

Vintage-specific transportation service outputs met by new sales (in
units of pass-km).

Passenger car and truck service output
by tech

Onroad light-duty passenger travel demands (pass-km) met by various
technologies across vehicle sizes. Buses are not included in the query
results.

101



GLIMPSE Users’ Guide v1.1

Chapter 5. Reference

Query

Description

Freight truck service output by tech
(no bus)

Onroad freight travel demand (tonne-km) met by various technologies
across vehicle sizes. Buses are not included in the query results.

Table 5.16: Query group — Emissions.

Query

Description

CO2 emissions by region

Total CO2 emissions (in units of MTC) per region.

CO2 emissions by aggregate sector

CO:z emissions (in units of MTC) by aggregate sector. Combustion
emissions include all CO: in the exhaust gas. For biofuels and
bioenergy, the negative CO2 associated with biomass growth is
captured in the biomass category.

CO2 emissions by sector

CO:z emissions (in units of MTC) per GCAM sector.

CO2 emissions by sector (no bio)

CO:z emissions (in units of MTC) per GCAM sector, not including
emissions from the combustion of bioenergy. Biofuels-related
emissions are handled as usual, however.

CO2 emissions by resource production

CO:z emissions (in units of MTC) from resource production activities,
including mining and oil and gas operations. These emissions are not
reported in the emissions-by-technology queries.

CO2 emissions by tech

CO:z emissions (in units of MTC) by technology. This query does not
include the results of “CO2 emissions by resource production.”

CO2, NOx, SO2, PM2.s, VOC, CO, NHs by
region

Total emissions of several air pollutants (in Tg, which is equivalent to
million metric tonnes).

CO2, NOx, SOz, PM25, VOC, CO, NHs by
aggregate sector

Sectoral emissions of several air pollutants by aggregate sector (in Tg,
which is equivalent to million metric tonnes).

COz, NOx, SOz, PM2ss, VOC, CO, NHs by
sector

Sectoral emissions of several air pollutants by sector (in Tg, which is
equivalent to million metric tonnes).

CO2, NOx, SOz, PM2s, VOC, CO, NHs by
tech

Emissions of several air pollutants by technology.

All emissions by region

All tracked emission species by region.

All emissions by aggregate sector

All tracked emission species by aggregate sector.

All emissions by sector

All tracked emission species by GCAM sector.

All emissions by tech

All tracked emission species by technology.

All emissions by resource production

All reported emissions from resource production activities, including
mining and oil and gas operations. These emissions are not reported

in the emissions-by-technology queries.
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Table 5.17: Query group — Impacts.

Query Description

CO2 concentrations Global average CO2 concentration in parts-per-million (PPM).
Total climate forcing Climate forcing in watts per square meter.

Global mean temperature Global mean temperature in degrees C.

Table 5.18: Query group — Markets, prices, and costs.

Query Description

CO; prices Market price for CO2 reduction in 1990Ss/tC.

Prices of all markets Market prices in 1990Ss.

Supply of all markets Supplies at the equilibrium prices.

Demand of all markets Demands at equilibrium prices.

Final energy prices Prices for energy commodities in meeting end use demands in 1990Ss.
Costs by tech and input Costs of technologies and fuels in 1990Ss.

Building service costs Costs of meeting energy services in 1990Ss.

Costs of transport services Costs of providing transportation services in 1990Ss.

Elec prices by sector Electricity prices in 1990S/EJ.
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Table 5.19: Query group — Inputs and outputs.

Query

Description

Inputs by tech

Inputs into each technology. Useful for tracking fuel and material
flows.

Outputs by tech

Outputs from each technology. Useful for tracking fuel and material
flows.

Elec production (incl CHP)

Total electricity production by region.

Electricity use

Total electricity use by region.

Refined liquids production

Total refined liquids (e.g., gasoline, diesel, and biofuels) production.
Note: For GCAM-USA, selecting all states and the USA region
erroneously reports double the total.

Refined liquids use

Total refined liquids (e.g., gasoline, diesel, and biofuels) use.

Table 5.20: Query group — Assumptions.

Query

Description

Population by region

Exogenously determined population by region (thousands). Note: USA
population is reported both at the state and national level. Do not
sum over population USA and states to avoid double-counting.

GDP per capita PPP by region

Gross domestic product per person, with GDP converted to 19905s
US using purchasing power parity conversions for each country.

Elec shareweights by subsector

Shareweights for electricity production subsectors. A value of 1
reflects no bias relative to other subsectors.

Elec shareweights by gen tech

Shareweights for electric sector technologies. A value of 1 reflects no
bias relative to other technologies.

Building floorspace

Building floorspace in billion square meters. Calculated as a function
of population.

Building shareweights by subsector

Shareweights for buildings subsectors. A value of 1 reflects no bias
relative to other subsectors.

Building shareweights by tech

Shareweights for buildings technologies. A value of 1 reflects no bias
relative to other technologies.

Industry shareweights by subsector

Shareweights for industrial subsectors. A value of 1 reflects no bias
relative to other subsectors.
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Query

Description

Refining shareweights by tech

Shareweights for refining technologies. A value of 1 reflects no bias
relative to other technologies.

Refining and oil shareweights by
subsector

Shareweights for refining subsectors. A value of 1 reflects no bias
relative to other subsectors.

Transport subsector shareweights

Shareweights for transportation subsectors. A value of 1 reflects no
bias relative to other subsectors.

Transport tech shareweights

Shareweights for transportation technologies. A value of 1 reflects no
bias relative to other technologies.

Capacity-factors by tech

Reports capacity factors, as a fraction, for all electric sector
technologies.

Costs by tech

Reports detailed costs by technology, including fixed and variable

O&M, capital cost, and any regional price adjustment.

Table 5.21: Query group — Water supply and demand.

Query

Description

Water withdrawals by state, sector,
basin (include desal)

Water withdrawals in units of km cubed.

Water consumption by state, sector,
basin (includes desal)

Water consumed in units of km cubed. Does not include quantity
replaced into reservaoir, river, etc.

5.4 TROUBLESHOOTING

5.4.1 COMMON PROBLEMS AND ERRORS USING THE SCENARIO BUILDER

Table 5.22: Scenario Builder problems and solutions.

Problem Potential Cause Solution

After clicking “Run,”
Cmd window appears, then
immediately disappears.

D> th The configuration file is not a Inspect the configuration file for errors.
e
properly formatted XML file. Some text editors have features for

checking the formatting of XML files.

After clicking “Run,” only
some components are
loaded before the Cmd
window disappears.

One of the scenario components
does not exist or the path name is
incorrect.

Check the last loaded scenario component
and the next scenario component listed in

the main_log.txt file. Ensure that they exist
and are properly formatted.
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Problem

Potential Cause

Solution

After clicking “Run,” all
components are loaded, but
the Cmd window disappears
before the first period
completes.

A technology is referenced in one
of the add-on files, but that
technology does not exist in the
specific region.

Check the main_log.txt file for an error
related to a DISCRETE market not having
been set up for a technology. If the
technology name is misspelled, correct the
spelling in the relevant add-on file. If the
technology should not exist in some
markets, modify the add-on XML to include
the NOCREATE=1 tag.

The model appears to be
running correctly; however,
the gcam.exe window
disappears while the
Scenario Library. The
“main_log.txt” file in the
“exe” folder does not
include any details about
why the run terminated.

The computer may have run
physical memory or disk space
(either on the drive where your
model is being run or on the drive
where your “swap” file is stored).

A log is kept that records entries indicating
that key thresholds have been exceeded.
You can check these resources via
“View—>Resource Logs—~>Current Log”.
Please see “How do | ... determine what
caused GCAM to fail?”

In the scenario’s components,
there may be conflicting market
or policy names that can cause
the model to terminate
unexpectedly. This typically will
not be a problem with
components created wholly in
GLIMPSE since GLIMPSE generates
unique market and policy names.

Examine the scenario’s market and policy
names for conflicts. Iteratively executing
the model while removing one or more
scenario components may help identify
which files include problematic naming
conflicts.

The model seems stuck and
is not producing new output
lines in the Cmd window.

The model is having difficulty
solving one or more markets and
the solver is requiring an unusual
number of iterations.

Within GLIMPSE, choose “View—>Worst
Market Log” from the menu bar. Wait
several minutes and repeat. Compare the
end of the two files. Are they the same? If
not, then the model is still executing. You
may want to check the GCAM website
information on the solver and its settings
for guidance: https://jgcri.github.io/gcam-

doc/solver.html

GCAM has paused execution for
some other reason. A common
reason is that the user has
selected text in the Cmd window
with the mouse, which will pause
the model execution.

Sometimes clicking in the Cmd window,
then pressing “Enter” will result in GCAM
execution continuing.
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Problem

Potential Cause

Solution

After revising the option file
in the notepad, the options
have not taken effect.

The options file has not been
reloaded.

Restart GLIMPSE or choose “File>Reload
Options” from the Scenario Builder menu
bar.

Modifications to options file
parameters such as
“gCamOutputDatabase” and
“stop-period” are not
reflected in existing
scenarios.

The scenario was created before
the changes to the options file
were introduced.

Click on the scenario in the Working
Scenarios table, then click on the arrow

button, / . In the “Create Scenario” pane,

click on the “Create” button © . This will
update the scenario with the new settings.

GCAM outputs warnings and
errors to the Cmd window
and to the main_log.txt file.

Many such errors and warnings
are not serious and do not affect
the model results. Most serious
errors will cause GCAM to
terminate.

Examine the run’s main_log.txt file. Does it
include the text “Model completed
successfully?” If not, then there may be
more serious issues.

The Scenario Builder
indicates that there were
solution problems and
identifies specific time
periods with market failures.

The solver had difficulty solving
one or more markets before the
allowable number of solver
iterations.

Please see section 4.3 of this users’ guide
“Interpreting and debugging unsolved
market information.” GCAM
documentation for guidance on changing
solver settings may also be useful:
https://jgcri.github.io/gcam-

doc/solver.html

Some scenario component
XMLs are not being created
when the “Create” button

©)

is pressed.

GLIMPSE may be having difficulty
interpreting the path names to
files. This can be the case if you
have scenario components or
scenario names that have spaces
or non-standard characters.

Do not use spaces in path or filenames
when installing GLIMPSE or constructing
new scenarios or scenario components.

When you double-click on a
scenario name in the
Scenario Library or do other
actions that should display a
file, no text or XML editor is
displayed.

The XML and text editor options
in the options file may be
referring to editors that you do
not have on your computer.

Check and revise the text and XML editor
specifications, if necessary. Reload the
options file.

The status of a scenario in
the Scenario Library is “Lost
Handle.”

Stopping the Scenario Builder will
not terminate any ongoing GCAM
runs. However, GLIMPSE will not
be able to copy the main_log.txt
file to the scenario’s folder when
the run terminates. However,
when determining status,

In the Scenario Builder, select “Tools=> Fix
Lost Handle.” This will find the
main_log.txt file in the exe/logs folder,
parse it to determine the scenario with
which that main_log.txt file is associated,
then place a copy in the scenario’s folder.
This should resolve the lost handle

message.
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Problem Potential Cause Solution

GLIMPSE uses the main_log.txt
file, so status cannot be updated.

In the Scenario Builder or Windows includes options for In the options file, there is an option for
setting the font size. Adjust the size up or
down as needed, restarting GLIMPSE to

test whether this addresses the issue.

New Scenario Component scaling font sizes to be larger or

Creator, some options are smaller. Depending on these
not visible. settings, the text may no longer fit

on the application window.

5.4.2 COMMON PROBLEMS AND ERRORS USING THE MODELINTERFACE

Table 5.23: Modelinterface problems and solutions.

Problem

Potential Cause

Solution

Using GCAM-USA, queries
of the USA region
produce only a small
number of outputs.

In GCAM-USA, the “USA” region
outputs include only those
categories that have not been
assigned to states, such as:
agriculture; oil, gas, and coal
extraction; and hydrogen
production.

Select the “USA” region and all states to
obtain U.S. national totals.

Using GCAM-USA, electric
sector queries produce
results for only a few
technologies.

GCAM-USA uses a different set of
queries for many electric sector
outputs.

If GCAM-USA-specific queries exist for an
output, use those.

The Modelinterface
freezes and is non-
responsive

This happens occasionally for non-
obvious reasons.

There may be some incompatibilities with
certain versions of the Java virtual machine.
For example, we have found that the
Modelinterface occasionally will freeze
when one tries to open a File Chooser, for
example, when exporting a result from the
database. Terminating the Scenario Builder
allows the Modelinterface’s File Chooser to
appear. It is not clear what is causing this
behavior. However, we have not had this
issue with jre1.8.0_333, so upgrading your
version of Java may be a solution.
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Problem

Potential Cause Solution

You may need to terminate, then re-start
the Modelinterface. Press ctrl-alt-del and
select the Task Manager. Click on “More
details.” Find the option “Java™ Platform SE
binary” and expand the “carrot” to the left.
If you see an icon for the Modelinterface,
select that process. If you do not, see if the
Modelinterface icon is below another Java
process. Click on it. Press “End Task.” You
may need to do this twice to kill the process.
Restart by pressing the “Results” button on
the Scenario Builder.

The database size has become too Unfortunately, this means that the data in
large and the basex software used the database is lost. Use the “Check Current
by the Modelinterface can no DB Size” option to determine the database
longer access the database’s files. size. If it is larger than 40 or 50 GB, size is

the issue. You will need to create a new
database. Please see Database Size
Management in the “How do I...? section for
best practices.

5.5 GLOSSARY

In this section, key terms and acronyms used in GLIMPSE, the query list, and this document are defined.

Table 5.24: Glossary of acronyms and key terms.

Acronym or term

Description

2W 2-wheel powered vehicles, such as motorcycles
2WE&3W 2- and 3-wheel powered vehicles, such as motorcycles
Onroad passenger vehicles with 4 wheels, including cars, pickup trucks, SUVs,
4w and vans. To simplify data requirements, these are categorized as “Car,” “Large
Car and Truck,” and “Mini-Car” in GCAM 7.0.
Adv Advanced

Aggregate sector

Aggregation of GCAM sectors into categories such as “Electricity,” “Industry,”
“Commercial,” “Fuel production,” “Transportation-LDV,” “Transportation-HDV,”
and “Transportation-ALM.”

Base

Baseload component of a load duration curve

BC

Black Carbon, a climate pollutant
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Acronym or term

Description

BEV Battery-Electric Vehicle, also known as electric vehicle

BTL Biomass to liquid

cC Combined-Cycle, a type of high efficiency turbine

CCs Carbon Capture and Sequestration

CES Clean Energy Standard

CH4 Methane, a climate pollutant

CHP Combined heat and power technologies that produce both electricity and heat
co Carbon Monoxide, an air pollutant

COz Carbon dioxide

CO2eq Carbon dioxide equivalent

Cogen Cogeneration technology that produces both heat and electricity

Comm Commercial sector

CNG Compressed natural gas

Csp Concentrated Solar-Thermal Power

Conv Conventional

CT Combustion Turbine

DAC Direct Air Capture — technologies capable of removing CO, from ambient air
Delivered Fuel that has been delivered to meet end-use demands and thus includes costs

associated with transportation and distribution

Direct equivalent

When comparing primary energy usage, renewable energy is often expressed in
terms of fossil equivalent or direct equivalent. For example, with solar power,
“direct” is equal to the actual electricity produced by the solar device. If “fossil,”
then the electricity is divided by the average fossil plant efficiency, often 0.33 to
0.4.

EGU Electric generating unit

EJ Exajoules, equivalent to 1e18 Joules or 2.78e5 gigawatt-hours

Elec_td_bld Electricity used in buildings

Elec_td_ind Electricity used in industry

Elec_td_trn Electricity used in transportation

Enduse Energy uses in buildings, industry, and transportation.

FCEV Fuel Cell Electric Vehicle, a technology that uses electricity produced by a fuel

cell to power an electric vehicle
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Acronym or term Description

Final energy Energy use(':l in 'meeting end-use energy service demands such as passenger
travel and lighting

T Fischer-Tropsch process that converts carbon monoxide and hydrogen or water
into liquid hydrocarbons

Gas Natural gas

Gen_ll_LWR Conventional nuclear plants utilizing a Light Water Reactor

Gen_lll Advanced nuclear power technologies

H2, H> Hydrogen

HDV Heavy-duty onroad vehicle

Hi-eff High-efficiency version of a technology

HSR High-speed electric rail

Hybrid liquids Hybrid technologies that are fueled by refined liquids

Hydro Hydropower

IGCC Integrated gasification combined-cycle advanced combustion technologies

Int Intermediate portion of a load duration curve

ITC Investment tax credit

Kg Kilogram

km?, km#2 Square kilometer

km3, km~3 Cubic kilometer

LD-NTR Light-Duty, Near-Term Greenhouse Gas Rule

LDV Light duty onroad vehicles

Liquids Often refers to technologies fueled by “refined liquids”

LPG Liquified petroleum gas

m3, m~3 Cubic meters

Mt Mega-tonnes, or million metric tonnes

MTC Mega-tonnes of Carbon, where one MT is equivalent to 1.102x10”6 short tons

N20, N20 Nitrous oxide — A climate pollutant

N Nitrogen

NG Natural gas or Compressed Natural Gas (CNG)

NHs, NH3 Ammonia — an air and water pollutant, precursor to tropospheric ozone and
secondary particulate matter
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Acronym or term

Description

Non-methane Volatile Organic Carbon - air pollutants and precursors to

NMVOC .
tropospheric ozone
NO Nitrogen oxides — an air pollutant and precursors to tropospheric ozone and
X
secondary particulate matter
ocC Organic Carbon
Pass-km Passenger-kilometer
Peak Portion of the load duration curve that represents the hours with the highest
ea

electricity demand

Petalumen-hours

Units used to express demand for lighting

PM1o, PM10 Particulate matter with a diameter less than 10 microns

Particulate matter with a diameter less than 2.5 microns which is also referred to
PMzs, PM2.5 .

as fine PM
Pul Pulverized, referring to coal

Primary energy

Raw forms of energy. Examples include crude oil, natural gas, and coal.

PTC

Production tax credit

PV

Photovoltaic solar power technology

Refined liquids

Liquid fuels. GCAM does not differentiate these fuels, which include gasoline,
diesel, liquid petroleum gas, kerosene, and fuel oil

Resid Residential sector

RGGI Regional Greenhouse Gas Initiative

RPS Renewable Portfolio Standard

rnw Renewable

SO, SO2 Sulfur dioxide, and air pollutant

Solid state Lighting technology also known as LED or light-emitting diode

subpeak F’ortion o.fthe load .dL.Jration curve that represents the hours between peak and
intermediate electricity demand

Tech Technology

Tg Teragram, or 1e9 grams

Thous Thousand

Ton-km Tonne-kilometer

Transport-ALM

Transportation subsectors that include air, locomotive (aka rail), and marine (aka
shipping)
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Acronym or term Description

Light-duty transportation subsectors used for onroad passenger travel, including

Transport-LDV
“2QW&3W,” “Car,” and “Large Car and Truck”

1’

Heavy-duty transportation subsectors used for onroad freight, including “Heavy,”

Transport-HDV
P “Medium,” and “Light” trucks

Transport-Onroad All onroad transportation, including passenger and freight vehicles
Trn Transportation
VOoC Volatile Organic Carbon - air pollutants and precursors to tropospheric ozone
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APPENDIX A: SCENARIO DESCRIPTIONS

A-1 INTRODUCTION

There are many pathways by which the U.S. energy system could evolve over the coming decades. GCAM-USA can
be used to construct internally consistent scenarios that describe potential pathways. Users are also able to
explore the impact of alternative assumptions about inputs such as population growth and migration, economic
growth and transformation, technology change and adoption, climate change, human behavior and choice, and
policies, including those targeting climate, environmental, or energy goals.

The model’s projections reflect the underlying assumptions about the present and future. The projections also
reflect the formulation of the GCAM-USA itself, including the aspects of the system the developers chose to
include, how various phenomena are represented, and how those formulations are parameterized. Thus,
understanding the underlying assumptions, formulation, and parameterization is important in interpreting the
results. Please see the “How does GCAM work?” section of this Users’ Guide for a basic overview. The online
GCAM documentation? provides additional information, including the section on the model’s logit-based choice
algorithm.?

We include a GLIMPSE Reference Scenario (GLIMPSE-1.1-Ref) in the Scenario Library with our GLIMPSE
distribution. This scenario is provided for convenience, and no endorsement by the U.S. EPA is implied. There is no
specific likelihood assigned to GLIMPSE-1.1-Ref or to any other scenario since there is considerable uncertainty
inherent in making long-term energy system projections. Furthermore, there are differences between the
GLIMPSE-1.1-Ref and those used in regulatory modeling activities by the EPA. GLIMPSE-1.1-Ref is not intended to
supplant the scenarios or modeling used in those activities. GLIMPSE users may choose to tailor this scenario for
their specific application.

A primary goal of this chapter is to describe GLIMPSE-1.1-Ref, including how it differs from the reference scenario
included by PNNL with GCAM-USA 7.0 (GCAM-USA-7.0). Furthermore, for GLIMPSE-1.1-Ref, we provide national-
level results to convey fuel, technology, and emission trends, overall and for key energy sectors. These results can
also be generated for individual states. Finally, we compare several energy-related outputs with the U.S.
Department of Energy’s Annual Energy Outlook 2022 and air pollutant projections with those of the U.S. EPA’s
2016v2 modeling platform.

A-2 THE GCAM-USA 7.0 REFERENCE SCENARIO, GCAM-USA-7.0

GLIMPSE-1.1-Ref is built upon the GCAM-USA 7.0 Reference Scenario that was distributed by PNNL but includes
several updates and additional policies. In this section we first describe GCAM-USA-7.0, followed by a description
of the updates that were made to create GLIMPSE-1.1-Ref.

A narrative is provided for the GCAM-USA-7.0 in the GCAM-USA 7.0 online documentation.?®> That document
describes key assumptions about socioeconomics and energy demands, electricity demand, electricity supply,

23 https://jgcri.github.io/gcam-doc
24 https://jgcri.github.io/gcam-doc/choice.html
25 https://jgcri.github.io/gcam-doc/gcam-usa.html
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inter-state electricity trade, refining, water supply and demand, and carbon sequestration. Primary data sources
are provided, and there is guidance regarding interpreting results. GCAM-USA-7.0 is included in the GLIMPSE
Scenario Library.

In general, the GCAM-USA-7.0 does not incorporate explicit representations of air, climate, and energy policies.
Exceptions include the following:

e Tier 3 standards — Tier 3 standards limit air pollutant emissions from onroad vehicles. GCAM-USA 7.0 includes
onroad mobile emission factors developed using EPA’s MObile Vehicle Emissions System (MOVES), version
2014.

e  Production Tax Credit (PTC) — These credits subsidize renewable generation by providing a 1-to-2 cent tax
credit per kWh of electricity generated. The PTC is represented as a reduction in the cost of wind, geothermal,
and biomass technologies, beginning in 2020. The policy reduces the levelized cost of energy by $4.81 (2020
dollars) per gigajoule (GJ) for wind, $8.71 for geothermal, and $4.62 for biomass energy.

e Investment Tax Credit (ITC) — The ITC is an alternative to the PTC that provides a credit for 12-to-30% of the
capital costs of a renewable energy project. The ITC is represented as a cost reduction in solar beginning in
2020. The reduction is made to the fixed charge rate, which has the effect of reducing the portion of overnight
capital paid each year.

Please note that we have made changes to several constants in the GCAM code, including the parameterization of
“small number” and “very small number.” These changes were made to support the additional decimal places
required in solving scenarios that include market share constraints. As a result, the GCAM-USA-7.0 results may be
slightly different than in PNNL’s distribution.

A-3 THE GLIMPSE REFERENCE SCENARIO, GLIMPSEV1.1-REF

A-3.1 OVERVIEW

GLIMPSE1-1.1-Ref builds upon GCAM-USA-7.0 but adds several updates. The GLIMPSE-1.1-Ref storyline assumes
that historical trends will continue in the near term (e.g., through 2030). Over the longer term (e.g., 2030-

2050), parameters that are used to calibrate to historic trends are relaxed, and the simulation is increasingly driven
by economic forces and policies. We assume a continuation of current, “on-the-books” national and

regional policies. This type of scenario is sometimes referred to as a “current legislation” scenario, although note
that we do not include all legislation or policies that could potentially impact the results.

In our representation, when a policy reaches its “sunset date” (e.g., the final year for which a policy target has
been specified), we tend to hold the policy target constant through 2050. For example, the Regional Greenhouse
Gas Initiative (RGGI) electric power sector CO2 cap has been specified through 2030. We hold that 2030 cap
through our final modeled time period, 2050.

In the real world, some types of policies and regulations could become more stringent over time. GCAM-USA
allows exploration of the impact of alternative assumptions about how policy targets are extrapolated. For
example, results under GLIMPSE-1.1-Ref could be compared to alternative scenarios, such as those that remove
policy targets after they sunset, continue the historic downward trajectory of targets through 2050, or explore
more stringent actions.
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Modifications to the GCAM-USA-7.0 that are introduced in GLIMPSE-1.1-Ref include state-specific Renewable
Portfolio Standards, state-level constraints to reflect real-world coal-fueled power plant retirements, updated

emission factors for electric sector emissions, and various updates that reflect stakeholder feedback or current

trends. Updates are summarized below.

Transportation air pollutant emission factors — Onroad emission factors for air pollutants were updated to
values produced by EPA’s MOVES 3.0 model, which incorporated improved emission estimation methods
compared to MOVES 2014. Emission standards were applied to air, rail, and marine sources, lowering the
emission factors of post-2015 vintages. In addition, international aviation and international marine emissions
were scaled such that national emissions levels were equivalent to the NEI in 2016. This scaling was necessary
since the emission factors developed by PNNL represented the entire operational cycle of these sources,
including emissions outside of the U.S. For applications investigating air quality, only the portion of emissions
released domestically are considered. Updated rail emission factors were developed from the report
“Emission Factors for Locomotives,” EPA-420-F-09-025, April 2009.

Biomass constraints - While the biomass constraint will not come into play in many scenarios, they are
included in GCAM-USA-7.0 so that they will be in place if the user is simulating CO2 or GHG reduction targets.
In those instances, GCAM tends to turn to biofuels and bioenergy as a primary means of mitigation. However,
GCAM does not represent important aspects of the US and global bioenergy markets. For example, biomass
used for bioenergy is generally expensive to transport because of its bulk and water content. This can limit the
geographical size of markets. Also, in a scenario in which the U.S. has a mitigation target in place, it is
reasonable to assume that other countries would be competing for available biomass, limiting US imports. To
represent this limit, we apply the constraints in the following table, which were developed by PNNL and are
intended to represent values from the U.S. Department of Energy’s 2016 Billion-Ton Report.2®

26 https://www.energy.gov/eere/bioenergy/2016-billion-ton-report

116


https://www.energy.gov/eere/bioenergy/2016-billion-ton-report

GLIMPSE Users’ Guide v1.1

Appendix A: Scenario Descriptions

Table A-2.1: Biomass limits in the US and globally.

Global values do not include the US region.

Year US biomass ceiling (EJ) Global biomass ceiling (EJ)
2015 4.7 195.3
2020 5.8 194.2
2025 7.3 192.7
2030 8.8 191.2
2035 10.5 189.5
2040 123 187.7
2045 14.8 185.2
2050 17.4 182.6

Grid scale batteries —In GCAM-USA, grid-scale batteries are configured to charge during non-peak hours, then
to discharge to meet peak load. However, there was an error in the technology shareweight that resulted in
no grid-scale battery capacity being used. This error was corrected, and a small quantity of grid-scale battery
capacity is now being built in GLIMPSE-1.1-Ref.

Light-Duty Vehicle GHG emission standards — In 2021, EPA finalized its light-duty vehicle GHG standards. A
regulatory impact analysis of that standard (https://nepis.epa.gov/Exe/ZyPDF.cgi?Dockey=P10130RN.pdf)
suggests that national sales of electric vehicles in the car and light truck categories will achieve 16% and 11%

shares, respectively, by 2025. That estimate includes both plugin hybrid vehicles and electric vehicles,
although the value is dominated by electric vehicles. In GLIMPSE-1.1-Ref, these sales fractions are applied to
electric vehicles only since plugin hybrids are not represented in the model.

Updates to solver settings — We have found that the GCAM default solver settings, defined in the

“cal_broyden_config.xml” file, do not perform well with transportation sector market share constraints. These
constraints can involve very small values that the model cannot distinguish from zero. We have updated

several of the solver parameters to address this issue in most applications.
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Table A-2.2: Updates to solver parameters to improve performance on transportation market share

constraints.

Parameter Original value Updated value
Solution-tolerance 0.001 0.0001
solution-floor le-4 le-9
preconditioner-solver-components: ftol le-2 le-7
broyden-solver-component: ftol 5e-4 9e-9

e  State-specific Renewable Portfolio Standards (RPSs) — An RPS is a target percentage of electricity that is
produced by renewable sources. Similarly, a Clean Energy Standard (CES) is a target fraction of electricity that
is produced by clean sources. In either case, how “renewable” and “clean” are defined determines how the

standard can be met. For example, some states include hydropower as a renewable while others do not.
Twenty-nine states have adopted either an RPS or CES target. We represent these targets, as of late 2021,
aggregated to the grid-region level. Aggregation simulates trade of clean energy credits among states within
the region but does not allow for broader trading.

e Regional Greenhouse Gas Initiative (RGGI) — RGGl is a multi-state cap-and-trade program for electric sector
GHG emissions. To incorporate RGGI, we constrain the electric sector CO2 emissions of the member states
following the program’s stated budgets through 2030. The cap is held at the 2030 level through 2050. The
states included in our representation are Connecticut, Delaware, Maine, Maryland, Massachusetts, New

Hampshire, New Jersey, New York, Rhode Island, Vermont, and Virginia. New Jersey and Virginia fall under the
cap after 2020. Cap values are provided below. The cap increases in 2025 to reflect the addition of NJ and VA.

Table A-2.3: RGGI targets and membership.

Year Cap (MTC) Assumed membership

2020 19.34 CT, DE, ME, MD, MA, NH, NY, RI, VT

2025 26.01 CT, DE, ME, MD, MA, NH, NY, RI, VT, NJ, VA
2030-2050 21.50 CT, DE, ME, MD, MA, NH, NY, RI, VT, NJ, VA

e Transportation technology shareweights - Shareweights are used in the logit function to represent a wide

range of otherwise unmodeled factors that affect the relative sales of competing technologies within a

market. For existing technologies, 2015 technology-specific shareweights are calculated as a function of real-
world market share and the relative costs of competing technologies. The calculated shareweight is “relaxed”
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over time, transitioning to a value of 1.0 in a future year, typically linearly. A value of 1.0 signifies that there is

no bias for or against the technology, and that its market share is determined solely on differences in price

and on the logit parameter, which specifies how much differences in price matter. The year in which this

transition is completed is specified at the market level, reflecting external assumptions about technological

progress and the breaking down of barriers.

For new and emerging technologies, the shareweight in the calibration year is zero because the market share

was negligible. The trajectory of how these technology-specific shareweights transition to 1.0 is thus

important, because it is indicative of the rate at which barriers against technology adoption, whether

psychological or technological, are likely to be addressed. Setting shareweight trajectories involves modelers’

judgement.

Modelers’ judgement was used to adjust the transportation sector shareweights to reflect current trends and

expectation of when barriers for each will be resolved. Resulting values are shown in the tables below.

Table A-2.4: Onroad transportation technology shareweight assumptions for alternative fuel

technologies.

Refined liquids technologies (e.g., internal combustion engines fueled by gasoline and diesel) are assumed to have a

shareweight of 1.0 for all periods.

Sector Subsector Technology 2020 | 2025 | 2030 | 2035 | 2040 | 2045 | 2050
BEV 008 | 050 [092 |1.00 |1.00 |1.00 |1.00

Eo Car FCEV 005 |027 [073 |095 |1.00 |1.00 |1.00
% Hybrid Liquids | 0.50 | 1.00 |1.00 |1.00 |1.00 |1.00 | 1.00
13 BEV 008 | 050 [092 |1.00 |1.00 |1.00 |1.00
§ #:;gci Carand | cepy 005 |027 [073 |095 |1.00 |1.00 |1.00
Hybrid Liquids | 0.50 | 1.00 |1.00 |1.00 |1.00 |1.00 | 1.00

BEV 005 |027 [073 |095 |1.00 |100 |1.00

Light truck FCEV 003 |016 [050 |084 |097 |1.00 |1.00

Hybrid Liquids | 0.16 | 0.84 |1.00 |1.00 |1.00 |1.00 | 1.00

%ﬂ BEV 003 |011 [033 |067 |090 |097 |1.00
% Medium truck | FCEV 003 |011 [033 |067 |090 |097 |1.00
§ Hybrid Liquids | 0.08 | 050 |092 |1.00 |1.00 |1.00 | 1.00
BEV 003 |016 |050 |084 |097 |1.00 |1.00

Heavy truck | FCEV 003 |016 [050 |084 |097 |1.00 |1.00

Hybrid Liquids | 0.08 | 050 |092 |1.00 |1.00 |1.00 | 1.00

119




GLIMPSE Users’ Guide v1.1

Appendix A: Scenario Descriptions

Table A-2.5: Air, marine, and rail transportation technology shareweight assumptions for alternative

fuel technologies.

Refined liquids technologies (e.g., internal combustion engines fueled by gasoline and diesel) are assumed to have a

shareweight of 1.0 for all periods.

Sector Subsector Technology 2020 | 2025 | 2030 | 2035 | 2040 | 2045 | 2050
BEV 0.02 0.03 0.08 0.16 0.30 0.50 0.70

International
. Hydrogen 0.02 0.03 0.08 0.16 0.30 0.50 0.70
= BEV 0.02 0.06 0.16 0.37 0.64 0.84 0.94

Domestic

Hydrogen 0.02 0.06 0.16 0.37 0.64 0.84 0.94
BEV 0.02 0.03 0.08 0.16 0.30 0.50 0.70
International FCEV 0.02 0.03 0.08 0.16 0.30 0.50 0.70
_“é Hybrid Liquids 0.05 0.27 0.73 0.95 1.00 1.00 1.00
g BEV 0.02 0.06 0.16 0.37 0.64 0.84 0.94
Domestic FCEV 0.02 0.06 0.16 0.37 0.64 0.84 0.94
Hybrid Liquids 0.05 0.27 0.73 0.95 1.00 1.00 1.00
BEV 0.03 0.11 0.33 0.67 0.90 0.97 1.00
— Freight FCEV 0.03 0.11 0.33 0.67 0.90 0.97 1.00
& Hybrid Liquids 0.05 0.27 0.73 0.95 1.00 1.00 1.00
Passenger Electric 1.00 1.00 1.00 1.00 1.00 1.00 1.00

Electric sector coal retirement calibration — Over the decade extending from 2010 through 2020, considerable
electric sector coal powerplant retirement occurred, driven by expansion of natural gas and renewable
capacity. However, this trend was not fully reflected in the GCAM-USA 7.0 results. To calibrate versus
witnessed retirement, we obtained state-level coal plant generation from the U.S. Energy Information Agency
and constrained the output of existing coal plants to be equal to or less than those amounts.?” Data for 2021
were used to avoid any anomalies associated with 2020 and the COVID-19 shutdowns.

Onroad vehicle lifetime and retirement adjustments — The retirement of a cohort of capacity of a technology is
represented in GCAM via a retirement s-curve. This curve is parameterized via three parameters: lifetime, half-
life, and slope. Lifetime reflects the maximum age that a technology in that cohort can achieve, while the half-
life is the number of years by which approximately half of that cohort has been retired from service. GCAM-
USA assumptions differ from those used in EPA analyses. We have updated these assumptions based upon
EPA estimates of annual mileage by vehicle age and survival rates. Light-duty retirement estimates were

27 https://www.eia.gov/electricity/data/browser
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derived from Tables 3.12 and 3.13 of the “Draft Technical Assessment Report: Midterm Evaluation of Light-

Duty Vehicle Greenhouse Gas Emission standards and Corporate Average Fuel Economy Standards for Model
Years 2022-2025,” EPA-420-D-16-900, July 2016. Heavy-duty vehicle retirement estimates were derived from
the “Final Rulemaking to Establish Greenhouse Gas Emission Standards and Fuel Efficiency Standards for

Medium- and Heavy-Duty Engines and Vehicles — Regulatory Impact Analysis”, EPA-420-R-11-901, August,

2011.

Table A-2.6: Revised parameterization of onroad vehicle retirement.

GCAM-USA category Vintage Lifetime Half-life Slope
Car 2015 composite 30 7.0 0.28
2020 and later 30 11.4 0.27
Large Car and Truck 2015 composite 30 7.0 0.27
2020 and later 30 10.7 0.23
Freight truck (all sizes) 2015 composite 30 7 0.27
2020 and later 30 7.5 0.17

e Representation of offshore wind procurements - Procurement data for the Northeast U.S. were obtained
from National Renewable Energy Laboratory (NREL) report NREL/TP-500-76079, Beiter et al., “Comparing
offshore wind energy procurement and project revenue sources across states”, 2020.28 This was

supplemented by data for Maine from newenglandforoffshorewind.org that provided procurement to

date. The procurement data were combined with state-level capacity factors to develop estimates of

output for 2025, 2030, and 2035 in EJ. These values were converted into a constraint that was applied

across New England, NY, NJ, MD, and VA. A future update could include procurements from other parts of

the country as well.

Table A-2.7: Estimated electricity production from current offshore wind procurements for coastal

northeast.

Area includes Connecticut, Massachusetts, Maryland, Maine, New Hampshire, New Jersey, New York, Rhode Island,

and Virginia.

Year Output (EJ)
2025 0.118
2030 0.228
2035 0.497

28 https://www.nrel.gov/docs/fy200sti/76079.pdf
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e Limits on natural gas-fueled light- and heavy-duty vehicles — Natural gas-fueled onroad light- and heavy-
duty vehicles have not achieved significant real-world market share in the U.S. With factors such as
increased demand for natural gas from the electric sector and new competition from electric and
hydrogen technologies, this trend is not expected to change. We provide a shareweight of 0 for onroad
natural gas vehicles starting in 2020, which eliminates their purchase.

e Limits on advanced liquid production — Advanced, alternative liquid fuel production technologies,
including those that produce cellulosic ethanol, Fischer-Tropsch biofuels, and coal- and gas-to-liquids have
yet to achieve significant market share. To reflect that these technologies are not expected to achieve
significant market share without breakthroughs or policy intervention, we assign low shareweights
(0.00625 in 2025, rising to 0.1 in 2100). Users may wish to remove this constraint when exploring deep
decarbonization scenarios.

e Limits on electric sector capacity additions of coal — The GCAM-USA-7.0-Ref scenario does not allow new
builds of new conventional coal-fired powerplants, although gasified coal plants and new coal plants with
integrated CCS are allowed. In GLIMPSE-1.1-Ref, we add an additional constraint that eliminates new coal
plants as an option from any state that had eliminated all of its existing coal plants by June 2023, based on
the EIA’s 860M data for electric utility and independent power providers.?° This constraint is applied to
California, Connecticut, Hawaii, Idaho, Massachusetts, Maine, New Jersey, New York, Oregon, Rhode
Island, and Vermont.

e Limits on industrial capacity additions of coal - Thirty-two states plus the District of Columbia have
adopted Climate Action Plans. We assume that industries in these states will not add new industrial coal
capacity. States included in this constraint are: Arizona, Arkansas, California, Colorado, Connecticut, the
District of Columbia, Delaware, Florida, lowa, lllinois, Kentucky, Louisiana, Massachusetts, Maryland,
Maine, Michigan, Minnesota, Montana, North Carolina, New Hampshire, New Jersey, New Mexico, New
York, Nevada, Oregon, Pennsylvania, Rhode Island, South Carolina, Virginia, Washington, and Wisconsin.

e Limits on carbon capture and biomass use in the electric sector in New England — Stakeholder feedback
suggested that carbon capture and sequestration and biomass combustion for electricity production are
not realistic options for New England. A primary barrier for CCS is the lack of storage options and the
difficulty anticipated in siting new pipelines to transfer CO2 out of the region. For biomass, the climate-
related challenges and difficulty in competing with other renewables are seen as barriers. To address this
feedback, we have eliminated capacity additions of these technologies in New England in GLIMPSE-1.1-
Ref.

Note that not all policies with the potential to impact future scenarios are included in GLIMPSE-1.1-Ref. For
example, the following are not included:

e  Provisions of the 2022 Inflation Reduction Act and 2021 Infrastructure Bill - This legislation is expected to
be incorporated into future versions of GCAM and will be available in GLIMPSE subsequently. In the
meantime, we provide an optional scenario component that includes representations of some of the
major provisions of the IRA. This implementation was developed by the Univ. of Maryland’s Center for
Global Sustainability and PNNL to support the GCAM-USA application to the report “Electric sector

2 https://www.eia.gov/electricity/data/eia860m/

30 https://www.c2es.org/document/climate-action-plans/
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emissions impacts of the Inflation Reduction Act”.3! That modeling was conducted using GCAM-USA 5.3,
but we have mapped those implementations to GCAM-USA 7.0 and include them here.

e The 45Q subsidy for Carbon Capture Utilization and Storage

e Other state and regional policies, including cap-and-trade, energy efficiency standards, and economy-
wide GHG reduction targets.

e Explicit representations of location-specific air pollution control requirements associated with attainment
status of the National Ambient Air Quality Standards.

Future versions of GLIMPSE are expected to include additional federal, regional, and state policies. GLIMPSE users
are also encouraged to tailor the reference case as needed in their application.

In the next section, selected national-level results from GLIMPSE-1.1-Ref are provided to illustrate commonly used
queries and model coverage.

A-3.2 SELECTED RESULTS

Below, national-level GLIMPSE Reference Scenario results are presented for several key outputs. The results are
divided into three sections to reflect the three portions of the figure below: (1) primary energy, (2) processing and
conversion of energy carriers, and (3) final energy. In addition, we provide results indicating the market shares for
various technologies in selected end-use sectors, as well as emissions of CO2 and air pollutants.

31 https://www.epa.gov/inflation-reduction-act/electric-sector-emissions-impacts-inflation-reduction-act
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Figure A-2.1: Energy system schematic.

The energy system extends from the import or extraction of primary energy, through its processing and conversion
into useful forms, through its use in meeting final end-use energy demands.
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To obtain national totals, all states, DC, and the USA region were selected. The USA region includes a few sectors

that have not yet been disaggregated to the state level, such as agriculture, hydrogen production, and oil, natural
gas, and coal operations.

All data were extracted from the output database using queries available in the “GLIMPSE” section of the
Modelinterface query list. Except for the emissions graphics, all images shown were generated using the
Modelinterface’s graphing tools. Emissions data were combined from two queries in a spreadsheet.
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A-2.4.1 PRIMARY ENERGY

Fig. A-2.2 shows the GLIMPSE-1.1-Ref projection of the consumption of primary energy (e.g., in its “raw” form)
through 2050. Renewables are shown as direct equivalent, indicating that the quantity shown is the energy
produced from wind, solar, geothermal, and hydro.

Overall, primary energy consumption is stable from 2015 on, although consumption of energy increases steadily
from 2030 through 2050, returning to 2015 levels in 2040. Imported oil decreases over time but imported natural
gas increases. The reduction in primary energy use in 2020 reflects factors such as improved vehicle efficiencies
and the transition from coal-powered electricity production to higher efficiency gas combined-cycle turbines. The
impacts of the COVID-19 pandemic are not included in this version of the model.

Figure A-2.2: Reference Scenario primary energy consumption by region (direct equivalent).
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A-2.4.2 PROCESSING AND CONVERSION OF ENERGY CARRIERS

In this section, we examine electricity production, refining, and hydrogen production by aggregated technology
category.

ELECTRICITY PRODUCTION

Figure A-2.3 shows GLIMSEv1.1-Reference electricity generation by aggregate subsector. Categories are fuel-
based, but differentiate between onshore and offshore wind, as well as by type of solar power. PV stands for
photovoltaic technologies, while CSP indicates concentrated solar power technologies. National electricity
production grows by more than 70% from 2015 to 2050. Generation from coal and nuclear power diminish over
the modeling horizon as existing plants retire and are replaced with increased generation from wind, solar, and
natural gas. By 2050, renewables constitute more than 50% of generation. This result is impacted by the use of
updated electric sector technology costs that reflect reduced capital costs for wind and solar.

Figure A-2.3: Reference Scenario electricity generation by aggregate subsector.
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REFINED LIQUIDS PRODUCTION

In GCAM and GCAM-USA, liquid fuel production technologies include those shown in Fig A-2.4. The fuels that they
produce are then lumped together and referred to as “refined liquids.” Refined liquids can be used by any sector.
FT biofuels are those produced by the Fischer-Tropsch process. In GLIMPSE-1.1-Ref, domestic liquid fuel
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production decreases by 11% from 2015 to 2050, driven by vehicle efficiency improvements, fuel switching, and
electrification of the transportation sector. The primary source of liquid fuels is oil refineries. Corn ethanol
production is small in comparison and is steady over the modeling horizon until 2040, when it begins to grow. Gas-

Figure A-2.4: Reference Scenario liquid fuel production by technology.
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HYDROGEN PRODUCTION

In GCAM-USA 7.0, H2 production is represented at the USA level only. Technologies in GLIMPSE-1.1-Ref that
produce H2 include: natural gas steam reforming, thermal splitting (which uses the heat produced by nuclear
power), and biomass technologies, with and without CCS. While production grows dramatically from 2020 in the
GLIMPSE Reference Scenario, the overall quantity of Hz production in 2050 is still much less than refined liquids
from conventional refineries. The majority of Hz is produced by steam reforming.

Figure A-2.5: Reference Scenario hydrogen production by technology.
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A-2.4.3 FINAL ENERGY

This section, we show the total final energy consumption by sector over time, independent of fuel. We then
examine this information further by inspecting the use of specific fuels by sector.

TOTAL ENERGY CONSUMPTION BY SECTOR

Final energy is the energy used in various sectors to meet end-use demands, such as space heating, water heating,
lighting, and transportation. Here, transport-LDV refers to passenger cars and trucks. Transport-HDV refers to
trucks used for delivering freight, and these vehicles are further categorized as being small, medium, or large.
Transport-ALM refers to the combination of air, locomotive (rail), and marine vehicles. In 2015, industry, buildings
(the residential and commercial sectors), and transportation each are responsible for approximately one-third of
final energy use. The industrial final energy usage grows, while most other sectors stay relatively constant. Energy
use by transport-LDV decreases as those vehicles become more efficient. Fuel use in transport-HDV and in
transport-ALM is steady over time. Overall, final energy is relatively constant through 2035. From 2035, however,
the final energy consumption overtakes efficiency improvements, resulting in steady growth in consumption.

Figure A-2.6: Reference Scenario final energy consumption by sector.
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ELECTRICITY USE BY SECTOR

The residential and commercial sectors are responsible for more than two-thirds of use electricity use in 2015. By
2050, this share is closer to half as industry and transport grow in electricity use over the time horizon. Fuel
production refers to fuel extraction and refining activities, which use very little electricity.

Figure A-2.7: Reference Scenario electricity use by aggregate sector.
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COAL USE BY SECTOR

Coal use declines significantly over the modeling horizon. The largest decreases are prior to 2020, when coal loses
market share to natural gas and, to a lesser extent, wind. Post 2025, coal declines accelerate, driven by
retirements. Industrial coal use is steady over time, although there is a slight increase. Only a negligible amount of

coal is used in the buildings sectors. Exported coal is not shown.

Figure A-2.8: Reference Scenario coal use by aggregate sector.
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NATURAL GAS USE BY SECTOR

Natural gas is used across many sectors of the economy. Use in electricity production grows significantly from 2015
to 2020. Use in industry and fuel production increases over time as well. In contrast, commercial natural gas use is
steady, while residential natural gas use decreases as more residential end-use services (e.g., space and water
heating) are met with electricity. Use in heavy-duty transportation is minimal but also decreases over time.

Figure A-2.9: Reference Scenario natural gas use by aggregate sector.
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REFINED LIQUIDS USE BY SECTOR

GCAM does not differentiate whether the liquid fuels are gasoline, diesel, or biofuels. The transportation sector
used more than three-quarters of liquid fuels in 2015. Use in light duty transportation declines over time as
vehicles become more efficient and alternative fueled vehicles achieve greater market share. Use of liquid fuels in
industry grows slowly but steadily. Much of this industrial refined liquid use is in construction, agriculture, and
mining.

Figure A-2.10: Reference Scenario refined liquids use by aggregate sector.
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BIOMASS USE BY SECTOR

The industrial sector is the greatest user of biomass in the early years. However, use in liquid fuel production
grows significantly from 2040 as advanced biofuel technologies become available in the model.

Figure A-2.11: Reference Scenario biomass use by sector.
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H2 USE BY SECTOR

H2 use is near zero in 2020 but increases significantly by 2050. The transportation sector is the greatest user of H,
and most Hz use occurs in onroad transportation.

Figure A-2.12: Reference Scenario hydrogen use by sector.
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Queries are also available for examining specific sectors and their fuel use, as is shown in the following graphics.

ENERGY USE IN THE INDUSTRIAL SECTOR

Overall, industrial energy use increases approximately 53% from 2015 to 2050. Use of all fuels increases over that
time horizon, but the increase is dominated by refined liquids (3.76 EJ), natural gas (3.25 EJ), and electricity (2.83
EJ).

Figure A-2.13: Reference Scenario industrial sector energy use by fuel.
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ENERGY USE IN RESIDENTIAL AND COMMERCIAL BUILDINGS

Overall, energy use in buildings increases approximately 14% from 2015 to 2050. Of the fuels used in buildings,
only electricity use (3.8 EJ) and biomass (0.019 EJ) increase over that time horizon.

Figure A-2.14: Reference Scenario buildings energy use by fuel.
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ENERGY USE IN THE ONROAD LIGHT-DUTY TRANSPORTATION SECTOR

The onroad light-duty vehicle sector includes the “Car” and “Large Car and Truck” passenger vehicle categories.
Overall, light-duty vehicle energy use decreases by 28% from 2015 to 2050. Use of refined liquids decreases by
47%. By 2050, electricity and hydrogen account for 27% of fuel use.

Figure A-2.15: Reference Scenario light-duty transportation energy use by fuel.
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A-2.4.4 TECHNOLOGY MARKET SHARES FOR SPECIFIC END-USES

In this section, we examine the market shares (in terms of service demands met) of competing technologies for a
selection of end-use markets. Here, we focus on the commercial, residential, and transportation sectors. In GCAM-
USA 7.0, the industrial sector has limited technological detail, reflecting “other industrial energy use” by fuel, as
well as fuel used in the cement and fertilizer industries. We do not present additional results for the industrial
sector, but GLIMPSE users are encouraged to use the “Industry final energy by tech and fuel” to explore industrial
fuel use further. Future versions of GCAM-USA are expected to have additional detail in the industrial sector.

COMMERCIAL SPACE COOLING

Overall, commercial space cooling demands increase by 36% from 2015 to 2050. The greatest increase is in high-
efficiency air conditioning (0.85 EJ), output of which more than triples from 2015 to 2050.

Figure A-2.16: Reference Scenario service output for commercial space cooling technologies.
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COMMERCIAL SPACE HEATING

Overall, commercial space heating demands increase by 29% from 2015 to 2050. The greatest increases are from
high-efficiency gas furnaces (0.73 EJ) and from electric heat pumps (0.44 EJ).

Figure A-2.17: Reference Scenario service output for commercial space heating technologies.
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COMMERCIAL WATER HEATING

Overall, commercial water heating demands increase by 43% from 2015 to 2050. The greatest increase is from
high-efficiency natural gas water heaters (0.37 EJ).

Figure A-2.18: Reference Scenario service output for commercial water heating technologies.
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COMMERCIAL LIGHTING

Solid state technologies include Light-Emitting Diodes (LED) lighting. Fluorescent includes compact (CFL) and linear
(LFL) bulbs. Overall, commercial lighting demands increase by 49% from 2015 to 2050. While some market share
remains through 2050 for fluorescent and incandescent lighting, the only category that grows over that period is
solid state lighting (12.8 petalumens-hours).

Figure A-2.19: Reference Scenario service output for commercial lighting technologies.
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RESIDENTIAL SPACE COOLING

Overall, residential cooling demands increases by 56% from 2015 to 2050. The high-efficiency version of electric air
conditioning achieves only a very small market share.

Figure A-2.20: Reference Scenario service output for residential space cooling technologies.
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RESIDENTIAL SPACE HEATING

Overall, residential heating demands increase by 42% from 2015 to 2050. Output from electric heat pumps
increases by 3.2 EJ. Heating from high-efficiency natural gas furnaces grows in output as well, but only by 0.49 EJ.
Overall, heating provided by natural gas decreases by 33% from 2015 to 2050.

Figure A-2.21: Reference Scenario service output for residential space heating technologies.

Building service output by tech
GLIMPSE-1.1-Ref
resid heating
region: Total

50

48 |

46 |

44

40 |

| ™ wood fumace
36  gas furnace hi-eff
34 W gas furnace

32 W fuel furnace hi-eff
307 W fuel furnace

28 electric heat pump
26 | electric furnace

output (EJ)

M coal furnace

SLoT
ozoz
SZTOZT -
0E0T
SEOT
oF0Z
SH0Z -
050z

144




GLIMPSE Users’ Guide v1.1 Appendix A: Scenario Descriptions

RESIDENTIAL WATER HEATING

Overall, residential water heating demand increases by 51% from 2015 to 2050. Much of the growth over time is
met by high-efficiency electric water heaters. However, starting in 2030, output from electric heat pump water
heaters begins to grow.

Figure A-2.22: Reference Scenario service output for residential water heating technologies.
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RESIDENTIAL LIGHTING

Solid state technologies include Light-Emitting Diodes (LED) lighting. Fluorescent includes compact (CFL) and linear
(LFL) bulbs. Overall, residential lighting demand increases by 65% from 2015 to 2050. Output from fluorescent
bulbs is relatively constant over time. Incandescent bulbs have been significantly displaced by solid state lighting
by 2025.

Figure A-2.23: Reference Scenario service output for residential lighting technologies.
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ONROAD LIGHT-DUTY TECHNOLOGIES

Conventional vehicles that operate on gasoline and diesel dominate the market through 2020, from which hybrid
and electric vehicle market share increases steadily. Hydrogen fuel cell vehicles begin to penetrate the market in
2030, achieving a market share (based on pass-km) of approximately 8.5% in 2050.

Figure A-2.24: Reference Scenario service output for light-duty passenger vehicle technologies.
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ONROAD FREIGHT TRUCK TECHNOLOGIES

This graphic includes onroad freight demand met by technology across three size categories: “Light,” “Medium,”
and “Heavy.” The load factors for these three sizes differ, and are 0.27, 2.07, and 4.16 tonnes per vehicle. Adoption
of alternative fuel vehicles across these size classes will differ. The “Transport service output by tech” query can be
used to explore market shares for each class separately. Conventional vehicles that operate on gasoline and diesel
dominate the market in 2015. From 2020, however, hybrid vehicle market share grows, eventually representing
23% of overall ton-km. Electric and fuel cells begin to appear in 2020. By 2050, they have reached 9.5% and 3.7% of
overall onroad ton-km, respectively.

Figure A-2.25: Reference Scenario service output for heavy-duty truck technologies.
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BUS TECHNOLOGIES

Overall demand for bus travel peaks in 2015, then declines slowly. Alternative fuels play an increasing role in this
sector. By 2050, hybrids, electric, and fuel cell buses each represent approximately 25% of the category’s service

demand.

Figure A-2.26: Reference Scenario service output by bus technologies.
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DOMESTIC AVIATION TECHNOLOGIES

Overall demand for domestic aviation doubles from 2015 to 2050. Refined liquid technologies dominate the

market, although there is significant growth in hydrogen and electric planes after 2035. Note that biofuels are not

represented as a separate end-use fuel, but that biofuels represent a portion of refined liquids.

Figure A-2.27: Reference Scenario service output by domestic aviation technologies.
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INTERNATIONAL AVIATION TECHNOLOGIES

Overall demand for international passenger aviation nearly doubles from 2015 to 2050. Hydrogen and electric
planes do not achieve a meaningful share of the market by 2050.

Figure A-2.28: Reference Scenario service output by international aviation technologies.
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FREIGHT RAIL TECHNOLOGIES

Freight rail service demand increases by 48% from 2015 to 2050. Hybrid and alternative fuel technologies begin to
appear in the 2025 model year. By 2050, hybrid has overtaken liquids as the freight rail technology with the largest
market share. Fuel cells and electric have both also achieved significant market shares.

Figure A-2.29: Reference Scenario service output by freight rail technologies.
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DOMESTIC MARINE TECHNOLOGIES

Demand for domestic marine freight nearly doubles between 2015 and 2050. From 2020, hybrid technologies
begin to appear and by 2030 have gained more than half the market. Hybrids remain dominant, but electric and
fuel cell ships begin to achieve a growing market share in 2035.

Figure A-2.30: Reference Scenario service output by domestic marine shipping technologies.
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INTERNATIONAL MARINE TECHNOLOGIES

Demand for international shipping grows at a smaller rate than domestic shipping, increasing 41% from 2015 to
2050. By 2030, hybrid technologies will provide more than half of the ton-km. By 2040, that has grown to two-
thirds.

Figure A-2.31: Reference Scenario service output by international marine shipping technologies.
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A-2.4.5 EMISSIONS OF CO2 AND AIR POLLUTANTS

CO2 EMISSIONS

CO:z emissions are produced at the state level, as well as from the “USA” region that includes several source
categories that have not been disaggregated to the state level (e.g., oil and gas production, coal mining, and H»
production).

US CO2 emissions are estimated to decline steadily from 2015 to 2050, ultimately falling 19%. Note that emissions
of CO; are presented in units of Megatonnes of Carbon (MTC). To convert to MTCO;, multiply these values by
44/12.

Figure A-2.32: Reference Scenario CO, emissions.
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In Figure A-2.33, CO2 emissions are aggregated by sector. Negative emissions from biomass growth reflect the CO:
that is removed from the atmosphere when growing the biomass used for bioenergy. This graphic was created
using the results of two queries: “All emissions by aggregate sector” and “All emissions by resource production.”
The latter query returns emissions from coal, natural gas, and crude oil operations, which are not reported by the
“All emissions by aggregate sector” query.

In the scenario, CO2 emissions decline over time, driven by reductions from light duty transportation (transport-
LDV) and the electric sector. Economic growth drives an increase in industrial CO2 emissions. Fuel production also
increases slightly. Other sectors remain relatively constant despite increasing energy service demands.

Biomass growth increases beginning in 2040, offsetting the CO2 emissions in other sectors.

Figure A-2.33: Reference Scenario CO, emissions by sector.
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NOX EMISSIONS

NOx emissions decline dramatically through 2035. Onroad vehicles (transport-LDV and transport-HDV) and the

electric sector are primarily responsible for this decline. For onroad vehicles, the Tier 3 engine and mobile vehicle

fuel standards drive this trend. After 2035, additional reductions come from vehicle electrification. In the electric

sector, fuel switching from coal to natural gas and renewables is driving emissions lower. However, these

emissions reduction in transport-HDV are offset by increased travel demand. Industry, industrial processes, and
air-locomotive-marine (transport-ALM) together emitted 35% of total NOx in 2015. This percentage grows to

approximately 50% in 2050 as emissions from other sectors decline.

Figure A-2.34: Reference Scenario NOx emissions by sector.
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SO2 EMISSIONS

Coal-fired power generation dominates SOz emissions in 2015. However, emission limits combined with the
retirement of coal plants reduces the power sector’s contribution 82% by 2020. Industrial SOz grows slowly over
the time horizon, which is driven by international shipping.

Figure A-2.35: Reference Scenario SO, emissions by sector.
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PM2.s EMISSIONS

Industry and industrial processes are the primary sources of PM from 2015 through 2050. Residential wood
combustion also accounts for a large share of PMas emissions. Emissions from this category decrease over time,
driven both by cleaner wood-burning technologies and by a transition to greater use of electric heating
technologies.

Figure A-2.36: Reference Scenario PM; s emissions by sector.
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A-3.3 EVALUATION

A-3.3.1 COMPARISON WITH THE ANNUAL ENERGY OUTLOOK 2022

In this section, national-scale results from GLIMPSE-1.1-Ref are compared to the U.S. Energy Information
Administration’s 2022 Annual Energy Outlook, or AEO 2022.32 AEO 2022 was selected since it is the last AEO that

32 https://www.eia.gov/outlooks/aeo/data/browser/
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did not include the Inflation Reduction Act in its Reference Case. For some parameters, this section includes a brief
discussion of factors that may contribute to discrepancies between GLIMPSE-1.1-Ref and AEO 2022.

Figure A-2.37: Comparison of primary energy consumption with AE02022.
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Electricity production in GLIMPSE-1.1-Ref is greater than that in AEO2022. Much of the increased demand is being
met by electricity production from natural gas technologies.

Figure A-2.38: Comparison of electricity production by fuel category with AEO2022.
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Electricity use in GLIMPSE-1.1-Ref is greater than in AE02022. A significant portion of the difference is a result of
transportation sector electricity demands. GLIMPSE-1.1-Ref also has greater electricity demands in the residential,

commercial, and industrial sectors.

Figure A-2.39: Comparison of electricity use by sector with AE02022.
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Energy use in residential and commercial buildings is lower in GLIMPSE-1.1-Ref than in AE02022. GLIMPSE-1.1-Ref
predicts greater electrification and lower demand for natural gas and refined liquids.

Figure A-2.40: Comparison of energy use in buildings by fuel with AE02022.
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GLIMPSE-1.1-Ref projections for industrial energy use are very similar in magnitude to AE02022, although there
are some differences in which fuels are being used.

Figure A-2.41: Comparison of industrial energy use by fuel with AE02022.
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Transportation sector fuel use is less in GLIMPSE-1.1-Ref than in AE02022. Contributing to this difference is greater

market shares for electric and hydrogen fuel cell vehicles, which are more efficient than conventional internal

combustion engines.

Figure A-2.42: Comparison of transportation energy use by fuel with AE02022.
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Demand for onroad passenger travel is slightly higher in GLIMPSE-1.1-Ref than in AEO2022. The market shares of
hybrid (hybrid liquids), electric (BEV), and fuel cell (FCEV) vehicles are much greater, however.

Figure A-2.43: Comparison of passenger car and truck service output by fuel with AE02022.
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A-3.3.2 COMPARISON OF AIR POLLUTION OUTPUTS WITH THE EPA’S 2016V2 EMISSIONS MODELING
PLATFORM

In this section, we evaluate GLIMPSE-1.1-Ref national and sectoral emission projections by comparing them with
the U.S. EPA 2016v2 emission platform.33 EPA developed the 2016v2 platform to support regulatory air quality
modeling for the 2022 Good Neighbor Rule.3* The platform includes a 2016 air pollutant emission inventory based
upon the EPA’s National Emissions Inventory (NEI), as well as projections to 2023, 2026, and 2032.

In general, GLIMPSE-1.1-Ref emission projections are similar to those of the 2016v2 platform, both in magnitude
and trends through time. However, SOz emissions tend to be higher than the platform, while PM2s, VOC, CO, and
NHs are slightly lower.

Figure A-2.44: Comparison of GLIMPSE-1.1-Ref emission projections (lines) with those of the EPA
2016v2 emission platform (dots).
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33 http://epa.gov/air-emissions-modeling/2016v2-platform
34 http://www.epa.gov/csapr/good-neighbor-plan-2015-0zone-naags
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Next, we compare sectoral emissions by species. For NOx, most sectors match the platform well, although NOx
from industry and buildings are low compared to the platform. The air, rail, and marine categories initially match
well, but diverge over time. The reason for this divergence is that the emission standards for vehicles are specified
per unit of fuel consumed. As advanced, more efficient technologies achieve greater market share in the GLIMPSE
results, emissions from these sectors decrease.

Figure A-2.45: Comparison of GLIMPSE-1.1-Ref NOx emission projections, in total and by sector (lines),
with those of the EPA 2016v2 emission platform (dots).
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Evaluation of GLIMPSE-1.1-Ref SOz emissions against the 2016v2 platform provides similar results for most
categories. Exceptions are SOz from the industrial and buildings sectors. Many refineries are transitioning to ultra-
low sulfur fuel oil, a transition that is not yet fully captured in the GLIMPSE-1.1-Ref scenario. Future versions of
GCAM-USA are expected to address this difference.

Figure A-2.46: Comparison of GLIMPSE-1.1-Ref SO, emission projections, in total and by sector (lines),
with those of the EPA 2016v2 emission platform (dots).
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The comparisons for other pollutants are similar, although there may be different reasons for discrepancies. For

example, we expect that the GLIMPSE-1.1-Ref scenario’s VOC emissions from buildings are below the 2016v2

emission platform because of incomplete coverage of processes such as evaporative emissions from paints and

chemicals. Some discrepancies may be based on imperfect matching of emission categories between GCAM-USA

and the inventory. Reducing the remaining discrepancies will be a goal of future updates. Note that NH3 emissions

from air and marine sources are highlighted because these categories are not represented explicitly in the 2016v2

inventory.

Figure A-2.47: Comparison of GLIMPSE-1.1-Ref PM, s emission projections, in total and by sector
(lines), with those of the EPA 2016v2 emission platform (dots).
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Figure A-2.48: Comparison of GLIMPSE-1.1-Ref VOC emission projections, in total and by sector (lines),
with those of the EPA 2016v2 emission platform (dots).
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Figure A-2.49: Comparison of GLIMPSE-1.1-Ref CO emission projections, in total and by sector (lines),
with those of the EPA 2016v2 emission platform (dots).
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Figure A-2.50: Comparison of GLIMPSE-1.1-Ref NH3 emission projections, in total and by sector (lines),
with those of the EPA 2016v2 emission platform (dots).
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A-3.4 DISCUSSION AND SUMMARY

The GLIMPSE Reference Scenario is intended to simulate a cohesive and plausible evolution of energy demands,
fuels, and technology market shares through 2050. Thus, it represents a baseline against which scenarios with
alternative assumptions about policies, technology advances, and various socio-economic drivers can be compared
and evaluated.

Overall, GLIMPSE-1.1-Ref results are generally consistent with AE02022, with differences largely being explainable.
For example, AEQ’s inclusion of Inflation Reduction Act of 2022 (IRA) provisions in the electric sector result in less
coal and natural gas than projected by GLIMPSE. In other sectors, GLIMPSE-1.1-Ref tends to transition from fossil
fuels to electricity more quickly than AEO, particularly in the transportation sector.

Note that there are real-world barriers and constraints that are not reflected in GCAM-USA, and thus are not
captured in GLIMPSE-1.1-Ref. Examples include bottlenecks in the transmission grid and limitations in the
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availability of funding for companies to build new electricity production and refining capacity or for households to
purchase more expensive technologies.

There also are limitations to how GCAM-USA apportions market share to competing technologies. For example,
the logit will apportion at least some market share to each competing technology. For light-duty transportation,
this means that hydrogen fuel cell vehicles will achieve a market share in the first year that they are available to
the model. However, GCAM-USA is not considering the potential barriers associated with introducing a refueling
infrastructure for only a small number of vehicles. Market share apportionment also considers technology-specific
shareweights, which are intended to represent factors such as bias and unmodeled issues, as well as market-
specific logit exponents, which reflect the sensitivity of the market to price differences between technologies.
Values chosen for these parameters result in technology shares that simulate historical choices reasonably.
However, there is uncertainty in determining the “best” values for each parameter, including how they transition
over time.

As a result of these limitations, GCAM-USA results, including GLIMPSE-1.1-Ref, should be considered in the context
of the inclusions and omissions in model coverage, as well as limitations associated with model formulation and
parameterization. Considering these limitations, some users may choose to develop their own Reference Scenario
that involves parameterizations, assumptions, or policies that are different from those used here. That is one of
the strengths of the GLIMPSE framework — users can explore alternative scenarios and develop their own
Reference Scenario and alternative scenarios.

When comparing GCAM-USA outputs with those of other models and data sources, there undoubtedly will be
differences. There are many potential reasons for these discrepancies, including the inherent uncertainty in
projecting energy system transformation for decades into the future, and various projections use different
assumptions, models, methods, and formulations to make their projections. Nonetheless, understanding
similarities and differences can provide insights into the key factors that may drive future trends, as well as how a
particular projection falls within the range of possibilities.
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APPENDIX B: TUTORIALS

B-1 RUNNING GCAM THROUGH GLIMPSE

B-1.1 OVERVIEW

The purpose of this tutorial is to walk new GLIMPSE users through the steps of starting GLIMPSE, executing GCAM-
USA for the GLIMPSE-1.1-Ref scenario, and monitoring progress. In Tutorial B-2, users will evaluate the results of
the simulation.

The reference material in Chapter 5 of this Users’ Guide may be useful as you carry out the steps of this tutorial.
Chapter 5 includes descriptions of GLIMPSE’s buttons and menu options, brief descriptions of the types of Scenario
Components that can be created and the options for each, descriptions of the scenario components that are
included in the Component Library, descriptions of commonly used queries, information for troubleshooting, and a
glossary.

B-1.2 OPENING THE GLIMPSE SOFTWARE

Open Windows Explorer. In the “GLIMPSE-v1.1” folder, double click “run_GLIMPSE_GCAM-USA-7p0”.

Figure B-1.1: Contents of the main GLIMPSE folder, GLIMPSE-v1.1.

GLIMPSE-v1.1 X + B - X
{ @ MNew ~ T sort ~ == View ~ sae
“ v <« (QSDisk (C:) » Projects » GLIMPSE-v1.1 v C Search GLIMPSE-v1.1 2
amazon-corretto-8.382.05.1-windows-x64-jre GLIMPSE-Modellnterface
Contrib | options_GCAM-USA-Tp0
Docs [ETrun_GLIMPSE_GCAM-USA-Tp0
GCAM-Model
GLIMPSE-Data
GLIMPSE-GUI
9 itermns =0

This will start the Scenario Builder, using the options specified in the file “options_ GCAM-USA-7p0.txt".

A Cmd.exe window will open for your GLIMPSE session. Diagnostic information about your GLIMPSE setup and
computer’s resources are output to this window.
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Figure B-1.2: Diagnostic information displayed to the GLIMPSE session’s Cmd.exe window.

CAwindows\system32\cmd.ex X + | =

C:\Projects\GLIMPSE-vl.1>java -jar .\GLIMPSE-GUI\exe\ScenarioBuilder.jar -options options_GCAM-USA-Tp@.txt
Loading settings and initializing.

Loading options from options_GCAM-USA-T7p@.txt

No match for gcameexecutableargs

Analysis of GLIMPSE setup
No problems found with parameters or folders.
No problem was found with nested GLIMPSE folders.
Your JAVA_HOME folder, C:\Projects\GLIMPSE-v1.1\\amazon-corretto-8.382.05.1-windows-x6U-jre, was successfully found.
Installation at location C:\Projects\GLIMPSE-v1.1 appears to be succesful.

Check to verify that key files exist as specified
XML header file: C:\Projects\GLIMPSE-v1.1\GLIMPSE-GUI\templates\glimpseXMLHeaders_v7p8.txt - true
Tech Bound file: C:\Projects\GLIMPSE-v1.1\GLIMPSE-GUI\templates\tech_bnd_list_usa_7p®.txt - true
Configuration template file: C:\Projects\GLIMPSE-v1.1\GLIMPSE-GUI\templates\configuration_GCAM-USA-7p@_template.xml - tr
ue

Query file: C:\Projects\GLIMPSE-v1.1\GLIMPSE-ModelInterface\exe\Main_queries_GLIMPSE-7p0.xml - true
GCAM executable: C:\Projects\GLIMPSE-v1.1\GCAM-Model\gcam-v7.8\exe\gcam-epa.exe - true
ModelInterface executable: C:\Projects\GLIMPSE-v1.1\GLIMPSE-ModelInterface\exe\ORDModelInterface.jar - true

Computer Information
—- Memory analysis —-—
Total physical memory: 16.0
Free physical memory: 7.5 GB

—— Disk space analysis ——
Total space: 397.2 GB
Free space: 298.2 GB
Total swap spac 25.9 GB
Free swap space: 15.7 GB

-- Processor analysis --
Available processor cores:
Current usage: 98.8%

Several seconds later, the GLIMPSE Scenario Builder graphical user interface will appear.
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Figure B-1.3: The Scenario Builder.
n GLIMPSE Scenaric Builder = O

File Edit View Tools Help
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Component Name
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Scenario Library Search: [T o= E @ O
ooo —
Scenario Name Created Completed Status ProbMkts Runtime
GCAMT.0 2023-11-01: 1510 2023-11-13: 13:22 Success 0 hr 26 min
GLIMPSE-1.1-Ref 2023-11-01: 1510

Resources... CPU: 29% | RAM: 16GB Free:50% | Disk: 303GB available | Swap: 18GB Free:45% // Database: database-v1 Size: 10.4GB Used:26%

The Scenario Builder consists of three panes. In the top-left pane is the scenario Component Library, which
contains a list of scenario components that have been previously created. A scenario can be created by adding one
or more components from the library to the Create Scenario pane on the top right. Scenarios that have been
created are listed in the Scenario Library table at the bottom.

The Scenario Library table lists the date and time that the scenario was created, the date and time that its
execution was completed, the status of the run, the modeled time periods that experienced solution errors (if
any), and the total runtime for any runs that have completed. Options for status include blank (indicating the run
has not been started), “In queue” to be run, “Running,” “Success,” “DNF” (an abbreviation for “Did Not Finish”),
and “Unsolved mkts.”

The GLIMPSEv1.1 distribution includes two scenarios. The first is GCAM?7.0. This is the reference scenario that is
distributed with GCAM by PNNL. The Scenario Builder reports that GCAM7.0 was created on November 11, 2023,
execution was completed successfully on November 13, 2023, and that execution required 26 minutes.

The second scenario included with this distribution is GLIMPSE-1.1-Ref, which includes several updates specific to
GLIMPSE. Note that the GLIMPSE Reference Scenario may change over time, including with new distributions. This
scenario was created on November 1, 2023, but the empty “completed” field indicates that it has not yet been run.

You can see which components were included in each scenario by clicking on the scenario, then hovering the
mouse over the table. A “tooltip” appears, listing the scenario’s components.
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Note if you select one scenario, then hover the mouse over another scenario, the components that are shown will
reflect the selected scenario.

A scenario’s configuration file indicates options such as which input files are included, the name of the database
where outputs will be sent, how many model periods to execute, and whether to generate a detailed “debug” file.
To view the configuration file associated with a scenario, double-click on the scenario’s name in the Scenario
Library. For example, double-clicking on GLIMPSE-1.1-Ref displays the following file, using the text editor specified

in your options file. Alternatively, you can select a scenario, then click on the “Edit” button, , which will open
the configuration file(s) associated with the selected scenario(s).

Figure B-1.4: The configuration file for the GLIMPSE-1.1-Ref scenario.

! [ CcA\Projects\GLIMPSE-v1,1\GLIMPSE-Data\GCAM-USA-Tp0\ScenarioF olders\GLIMPSE-1.1-Reficonfiguration_GLIMPSE-1.1-Refxml - Notepad-++ = [m] X
! File Edit Search View Encoding Language Settings Tools Macre Run  Plugins  Window 7 + v X
PRCE & | |88 Bg | & & | =1 DERER=E®| ]

| [=] configuration_GLIMPSE-1,1-Refxml E1 I |

Scenario name: GLIMPSE-1.1-Ref
Database: database-vl

1 o tn b

Debug region: CT
8 Stop year:2050
) Comments:
11 Components:
12 Updates-PostGCAMT7Release. tXt
13 Updates-GLIMPSEvl.1-AddOnFiles.txt
14 Policy-RGGI-hold.txt
15 Policy-State RP5_targets.Lxt
16 Policy-LDV-Short-Term—-GHG-Rule.txt

H<Files>

2 <Value name="xmlInputFileName">../input/geandata/xml /modeltime.xml</Valus>

<Value name="BatchFileName">batch ag.xml</Value>

<Value name="policy-target-file">../input/policy/forecing target 4p5.xml</Value>

5 <Value name="GHGInputFileName">../input/magice/inputs/input gases.emk</Value:>

& <Value append-scenarico-name="0" name="xmldb-location" write-output="1">..\output\database-vl</Value>

7 <Value append-scenario-name="0" name="restart" write-output="1">./restart/restart</Value>

8 <Value append-scenario-name="0" name="xmlDebugFileName" write-output="1">debung.xml</Value>

7] <Value append-scenarico-name="0" name="climatFileName" write-output="1">gas.emk</Valus>

<Value append-scenario-name="1" name="costCurvesOntputFileName" w:ite—a:tp:t=“1“bcost_curves.xm1<fValue>
<Value append-scenario-name="0" name="batchCSVOutputFile" write-output="1">batch-ecsv-ount.csv</Value>
<Value append-scenario-name="0" name="supplyDemandOutputFileName" write-output="0">SDCurves.csv</Value>
<Value append-scenarioc-name="0" name="flow-graph" write-output="0">gcam-flow-graph.dot</Value>

<Value append-scenario-name="0" name="dependencyGraphName" write-output="0">DependencyGraph.dot</Value>
<Value append-scenario-name="0" name="landAllocatorGraphName" write-output="0">LandAllocatorGraph.dot</Value>
36 F</Files>

|eXtensible Markup Language file length: 18,051 lines: 240 Ln:1 Col:1 Pos:1 Windows (CRLF)  UTF-8 INS

AN B

You may want to use an XML editor when viewing or editing XML files. For example, Notepad++ color codes the
XML code, including marking comments as green, tags as blue, attributes in red, and attribute values in purple. The

|Il

programs to use for opening “.txt” and “.xml” files can be specified in GLIMPSE’s options file.

If your configuration file did not appear, your XML editor’s path may be specified incorrectly in your options file.
You can correct this setting in the options file, then choose “File=>Reload Options” in the Scenario Builder menu to
adopt the change.
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The GCAM User’s Guide provides information about the contents and sections of the configuration file.3 For
scenarios that are constructed in GLIMPSE, meta-data is added the top of the configuration file, surrounded by
XML comment indicators “<!--” and “-->”. The meta-data indicates the scenario name, output database, end year,
and the scenario components from the Component Library that were included in the run.

B-1.3 EXECUTING THE GLIMPSE REFERENCE SCENARIO

To execute the GLIMPSE Reference Scenario, select it in the Scenario Library, then press the “play” button, D .
The scenarios status will immediately change to “In queue.” If the queue is empty, the status will change to
“Running” within a few seconds.

A black gcam.exe window will be displayed. If this window appears, then immediately disappears, this is usually an
indication that JAVA_HOME is not configured properly in the options file or that the XML formatting in the
configuration file is incorrect. If the window does not disappear immediately, but disappears while reading in input
files, this is an indication that the last input file that was read had an error. Please see the Troubleshooting section
if you encounter either of these instances or other problems as the model executes.

This status window displays diagnostic information for the run, including which input files have been imported, as
well as warnings and errors. Critical problems typically are reported as “Errors” or “Critical Errors.”

Figure B-1.5: Diagnostic information displayed while a scenario is executing.

C:\Projects\GLIMPSE-vI.I\GCA X + v

Parsing ..\..\..\Contrib\Policies\RPS\RPS_Central.xml scenario component.

Parsing ..\..\..\Contrib\Policies\RPS\RPS_East_81122821_updatedNE.xml scenario component.

Parsing ..\..\..\Contrib\Policies\RPS\RPS_West.xml scenario component.

Parsing ..\..\..\Contrib\Policies\LDV-GHG-Rule\Policy-2023-LD-Car-GHG-Std.xml scenario component.
Parsing ..\..\..\Contrib\Policies\LDV-GHG-Rule\Policy-2023-LD-LtTrFrt-GHG-Std.xml scenario component.
Parsing ..\..\..\Contrib\Policies\LDV-GHG-Rule\Policy-2023-LD-LtTrPass-GHG-Std.xml scenario component.
XML parsing complete.

Starting new scenario: GLIMPSE-1.1-Ref

Mon Nov 20 ©9:29:31 2823:WARNING:Hector::Logge printLogHeader: hector version 3.1.1

Mon Nov 20 ©9:29:31 2823 :WARNING:Hector::Logger: :printLogHeader: hector version 3.1.1

Starting a model run. Running period 11

Model run beginning.

Period 8: 1975

Model solved with last period's prices.

Period 1: 1998
iterations: 3 total: 4 solved: 587
iterations: 35 total: 36 solved: 1688
iterations: 62 total: 63 solved: 1796
iterations: 156 total: 157 solved: 20660
iterations: 158 total: 159 solved: 20660
iterations: 173 total: 174 solved: 26864
iterations: 173 total: 174 solved: 2064
iterations: 173 total: 174 solved: 2864
Model solved normally. Iterations period 1: 173. Total iterations: 174

Period 2: 2865
2 iterations: 3 total: 177 solved: 454
2 iterations: 35 total: 289 solved: 1787
2 iterations: 73 total: 247 solved: 1903

35 GCAM Documentation: GCAM User Guide (jgcri.github.io)
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However, there are many warnings reported to this window that can be ignored. For example, the “Market info
object” messages reflect how water demands are integrated into the model, but do not affect model performance.

Figure B-1.6: Example of warnings that can be ignored.

ED

C:\Projects\GLIMPSE-v1.\GCA X + -

iterations: 242 total: 6453 solved: 1938
iterations: 357 total: 6568 solved: 2108
iterations: 359 total: 6576 solved: 2100
iterations: 398 total: 6609 solved: 2899
iterations: 399 total: 6618 solved: 2899
iterations: 528 total: 6731 solved: 2122
iterations: 522 total: 6733 solved: 2122
iterations: 545 total: 6756 solved: 2124
iterations: 546 total: 6757 solved: 2124
iterations: 679 total: 6898 solved: 2125
Model solved normally. Iterations period 8: 679. Total iterations: 6898

00 00 0O 03 O3 OO OO OO OO

]

Period 9: 2640
Input Lo_All_Tech_OSW-NE2 does
Input Lo_All_Tech_OSW-NE2 does

a matching input i period.
a matching input i period.
Input Lo_All_Tech_OSW-NE2 does a matching input i period.
Input Lo_All_Tech_OSW-NE2 does a matching input i e period.
Input Lo_All_Tech_OSW-NE2 does a matching input i e period.
Input Lo_All_Tech_OSW-NE2 does a matching input i e period.
Input Lo_All_Tech_OSW-NE2 does a matching input i e period.
Input Lo_All_Tech_OSW-NE2 does a matching input i e period.
9 iterations: 3 total: solved: 237
iterations: 35 total: solved: 972
iterations: 65 total: solved: 1827
iterations: 185 total: solved: 1747
iterations: 187 total: solved: 1747
iterations: 223 total: solved: 2822
iterations: 260 total: solved: 2026

Additional diagnostic information is also printed to the gcam.exe window. For each model period, these include
the number of solver iterations within that period, the total solver iterations, and the number of solved markets at
that time.
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Figure B-1.7: Additional diagnostic information.

C:\Projects\GLIMPSE-v1.1\GCA X + v

Starting a model run. Running period 11
Model run beginning.

Period 8: 1975

Model solved with last period's prices.

Period 1: 1998

iterations: 3 total: 4 solved: 507

iterations: 35 total: 36 solved: 1680
iterations: 62 total: 63 solved: 1796
iterations: 156 total: 157 solved: 28668
iterations: 158 total: 159 solved: 2868
iterations: 173 total: 174 solved: 2864
iterations: 173 total: 174 solved: 2864
iterations: 173 total: 174 solved: 2864

Model solved normally. Iterations period 1: 173. Total iterations: 174

Period 2: 2085
iterations: 3 total: 177 solved: 454
iterations: 35 total: 289 solved: 1787
iterations: 73 total: 247 solved: 1983
iterations: 254 total: 427 solved: 2851
iterations: 256 total: 429 solved: 2851
iterations: 274 total: 447 solved: 2064
iterations: 274 total: 447 solved: 2064
iterations: 274 total: 447 solved: 2864
Model solved normally. Iterations period 2: 27d. Total iterations: 447

Period 3: 2818
£l iterations: 3 total: 458 solved: 389
= iterations: 35 total: u82 solved: 1714

This information can be useful in determining that the model is actively running and in gaging the progress that it is
making. The solved market number tends to increase rapidly, then progress tapers off. Occasionally the number of
solved markets will decrease as the solver adjusts its solution approach. The solver configuration file includes a
parameter that specifies the maximum number of iterations allowed in each model time period. In the default
GLIMPSE setup, this maximum is 8,000 for most time periods. Thus, the value following “iterations” can provide
some indication of the maximum number of remaining iterations in that period. When the iteration limit is reached
but unsolved markets remain, information about those markets is written to the status window.

As the run continues, the information in the Scenario Table is periodically updated. For example, “Running (6)”
indicates that GCAM is currently running and that the model is in the sixth period. The status bar at the bottom of
the Scenario Builder window shows current computer resources and utilization. For many of these metrics there
are thresholds beyond which problems may occur. When specific thresholds have been exceeded, the status
message is concatenated with “I11”. Additionally, this information is saved to a log file that can be accessed by
“View—>Resource Logs—>Current Session.” For each log entry there is a time stamp and name of the currently
executing scenario. This information can be useful in debugging execution problems that are caused by computer
resource limitations.

See the section “Interpreting and debugging unsolved market information in the main_log.text file” for

information about addressing unsolved markets. The GCAM documentation also includes a detailed description of

the solver and its parameterization as well as debugging.3%%’

36 https://jgcri.github.io/gcam-doc/solver.html
37 https://jgcri.github.io/gcam-doc/dev-guide/debug.html
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Most of the information written to the status window is also saved to the “main_log.txt” file, which is in the
“GLIMPSE-v1.1\GCAM-Model\gcam-v7.0\exe\logs” folder. You can access this log file during the run by clicking on

the “EXE LOG” button, .

When the run completes, several sequential steps occur:

e The results are written to the output database. Note that if the Modelinterface is currently open and
viewing the output database, then this step cannot proceed. A message appears in the gcam.exe window
asking that the Modelinterface be closed. Once it is closed, the process of writing results to the database
begins.

e The gcam.exe status window disappears.

e Several files are moved to the scenario’s folder, including the main_log.txt file and other files that are
specified via the “gCamOutputToSave” option in the options file. The saved files may include the
following:

o calibration_log.txt — diagnostic information from GCAM'’s calibration process in which the model
determines shareweights based on real-world, calibration-year data
debug.xml — detailed information provided for a single region or state
solver_log.csv — information on market prices and solution status at each iteration of GCAM’s
solver

e The main_log.txt file is parsed by GLIMPSE to ascertain whether the run completed successfully and
whether there were any solution periods with unsolved markets.

e The scenario’s status is updated in the Scenario Library to “Success,” “DNF” (Did Not Finish), or “Unsolved
mkts” (Unsolved Markets).

e If there were periods with unsolved markets, those are listed in the “ProbMkts” (Problem Markets)
column.

e The scenario’s runtime is listed in the table.

180



GLIMPSE Users’ Guide v1.1 Appendix B: Tutorials

Figure B-1.8: Scenario Builder indicating successful completion of GLIMPSE-1.1-Ref.

| B8 GLIMPSE Scenario Builder = ] *

File Edit View Tools Help

i

11 ¢ - - - i -

| Component Library Search: _|_ g E e O Create Scenario

! Component Name Created Companent Neme
Calib-Bio-and-CCS-limits-in-NewEngland.csv 2023-08-23: 1325
Calib-coal_egu_2020.txt 2023-02-08: 08:45
Calib-LDV-EV-AEO2020.csv 2023-02-08: 08:45 No content in table
Calib-Lower_Income_Elasticity_Tran.txt 2023-02-08: 08:45
Calib-Lo_alt_biofuel SW.csv 2023-02-08: 08:45
Calib-NE_fixed_nuke_output.csv 2023-02-08: 08:45

1 {Calih-NF_fived nuke ootoast Theoa 2020 rsw AN23-02 -0 NR45

/2B DX i = O

Scenario Name Created Completed Status ProbMkts Runtime
GCAMT.0 2023-11-01: 1510 2023-11-13: 13:22 Success 0 hr 26 min
GLIMPSE-1.1-Ref 2023-11-01: 1510 2023-11-20: 17:00 Success 0 hr 39 min

Resources... CPU: 18% | RAM: 16GB Free:55% | Disk: 280GB available | Swap: 41GB Free:79% // Database: database-v1 Size: 10.8GB Used:27%

Runtime for a scenario can vary significantly from one computer to another, depending on processing speed,
available RAM, disk speed, and the types of policies included in the run. You should expect GLIMPSE-1.1-Ref to
require less than an hour to several hours. In the screenshot above, execution of GLIMPSE-1.1-Ref required 39
minutes.

B-1.4 EXAMINING INFORMATION SAVED WITH EACH RUN
To access the folder associated with a scenario, click on the scenario’s name in the Scenario Library, then press the
. In addition to the saved files listed in the previous section, the scenario

folder also includes the scenario’s configuration file and input files that were developed in the creation of the
scenario.

open folder button above the table,

For GLIMPSE-1.1-Ref, the contents of the scenario folder are shown below.
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Figure B-1.9: Files saved to the scenario's folder.

GLIMPSE-1.1-Ref * aF
I @ New - Tl sort ~ = View ~ sas
|
I « GCAM-USA-Tp0 > ScenarioFolders » GLIMPSE-1.1-Ref hd C Search GLIMPSE-1.1-Ref

|

File Edit View Tools

MName Date modified Type N Size

Q{ Tech-MoConvBicEGU xml 9/5/2023 10:36 AM XMIL File 11,952 KB
| Q{ Tech-Low-AltRefiningxml 9/5/2023 10:36 AM XMIL File 7,028 KB

Q{ Policy-5ec177-ZEV-PassLgCarAndTruck.xml 8/18/2023 404 PM XMIL File TOKB

Qf Policy-5ec177-ZEV-PassCars.xml 8/18/2023 4:04 PM XMIL File 69 KB

Q{ Policy-MoBiomassEGUinMAxml 8/4/2023 3:55 PM XML File 212 KB
| [ Policy-2023-LD-LtTrPass-GHG-Std.xm 9/5/2023 10:33 AM XMIL File 159 KB
| L?f Policy-2023-LD-LtTrFrt-GHG-5td.xml 9/5/2023 10:33 AM XML File 156 KB
| Qf Policy-2023-LD-Car-GHG-5td.xml 9/5/2023 10:33 AM XMIL File 158 KB
! Qf debugaxml 11/3/2023 1212 PM XML File 73,627 KB
I Q{’ configuration_GLIMPSE-1.1-Ref.xml 11/1/2023 3:10 PM XML File 18 KB
i LS{ Calib-OffshoreWind_lower-Bound_EastCoast_thru2035.xml 8/4/2023 3:55 PM XMIL File 27 KB
| Q{ Calib-NoNewCealEGUsIn0DCoalStates.xml 8/4/2023 3:35 PM XMIL File 336 KB
| Q{ Calib-Bio-and-CCS-limits-in-MNewEngland.xml 9/5/2023 10:33 AM XMIL File 5,317 KB

Q{ Calib-2023IndCoal-GHGPlanStates.xml 8/4/2023 3:35 PM XMIL File 705 KB

|j main_log.bet 11/3/2023 1218 PM Text Docurment 2,276 KB

15 iterns

P

=o

As a shortcut to access a scenario’s main_log.txt file, you can click on the scenario’s name in the Scenario Library,

-

=
then click on the LOG button, td . The arrow on the button indicates that the main_log.txt file(s) for the selected

scenario(s) will be opened in a text editor.

Users generally will not need to visit a scenario’s folder. However, the “debug.xml” and “solver_log.csv” files may

be useful to advanced users in diagnosing problems with GCAM execution. Users can modify which outputs are

saved with each run by changing the “gCamOutputToSave” settings in the GLIMPSE options file. Alternatively,

when a scenario is created via the create scenario button, @ , the user has the opportunity to override these

settings.

Scenario results are saved in an output database, which is accessed via the Modelinterface.
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B-2 EXAMINING MODEL RESULTS

B-2.1 OVERVIEW

The Modelinterface is used to access results by performing queries on the GCAM-USA database. Results are
provided in a table, and additional tools are available for filtering, sorting, and visualizing the data.

B-2.2 VIEWING MODEL RESULTS WITH THE MODELINTERFACE

To view GCAM results, you will need to open the output database via the Modelinterface. There are two Results
1l 4

buttons available. The “Results” button, H00' wil| open the Modelinterface, initialized to the output database

B
specified in the options file. Alternatively, press _dnlkﬁ to initialize the Modelinterface to the database referenced in
the selected scenario.

For this tutorial, select the scenario GLIMPSE-1.1.-Ref in the Scenario Builder's Scenario Library. Then click the
¥
results button with the arrow, ﬁ:-"ﬁ .

After several seconds, the Modelinterface window will appear. You should see two scenarios in the “Scenarios”
pane, GCAM?7.0, which was included with the GLIMPSE installation, and the new scenario, GLIMPSE-1.1-Ref. The
name for each is followed by the date and time that it was loaded into the output database.
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Figure B-2.1: The Modelinterface.

5 GLIMPSE Modellnterface [C\Projects\GLIMPSE-v1.1\GCAM-Model\gcam-v7.0\output\database-v1] = O

File Edit Tools Advanced Help

GCAM7.0 2023-13-11T12:55:55-05:00 Africa_Eastern
Africa_Northern
Africa_Southern
Africa_Western
Australia_NZ
Brazil

Canada

Central Asia
China

EU-12

EU-15
Europe_Eastern
Europe_Non_EU

India
Indonesia
Japan
Mexico
Middle East
Pakistan
Russia
South Africa

South Asia
South Korea

Scenario Regions
GLIMPSE-1.1-Ref 2023-3-11T11:37:16-04:00

Central America and Caribbean

European Free Trade Association

South America_Northern
South America_Southern

Queries

d
=}~ GLIMPSE/GCAM-USA

=7 Converted Units
= GHG emissions by pollutant and region (CO2eq)
= NOx,502,PM2.5,VOC,CO,NH3 by region (short tons)
= NOx,502,PM2.5,VOC,CO,NH3 by aggregate sector (short tons)
= CO2 prices (2020%/tCO2)
= Prices of all markets (2020%s)
= Elec prices by sector (2020%/kwh)
= Refined liguid prices (2020%/gal)
Primary and final energy
< Primary energy consumption by region (direct equivalent)
= Final energy consumption by region
= Final energy consumption by aggregate sector
= Final energy consumption by aggregate sector and fuel
= Final energy consumption by sector and fuel
= Enerqv inputs by sector
= Electricity use by aggregate sector
= Coal use by aggregate sector
= Natural gas use by aggregate sector
= Refined liquids use by aggregate sector
= Biomass use by aggreqate sector
= Hydrogen use by aggreqgate sector
= End-use energy consumption in buildings
= End-use energy consumption in buildings (detail)
= End-use energy consumption in transportation
= End-use energy consumption in transportation (detail)
= End-use energy consumption in industry
= End-use energy consumption in industry (detail)
= Energy inputs to electricity production
= Energy inputs to electricity production (detail)
= Energy inputs to refining activities
=7 Technologies
< Electricity generation by region (centralized)
: = Electricity generation by region (incl cogen)

il
il

Run Query Diff Query [:]Tulal Collapse

In the “Regions” pane, all the socio-economic regions included in GCAM-USA are listed, as well as the model’s

electricity transmission grid regions within the U.S.

Note that most of the energy system-related activities within the U.S. have been disaggregated to the state level.

Thus, the “USA” region does not provide national totals. Instead, “USA” includes several sectors that have not been

apportioned to states, including agriculture, coal mining, oil and gas operations, and hydrogen production.

The “Queries” pane lists the various outputs that can be extracted from the output database. Currently, several

hundred queries are available. The queries are organized in a tree structure. The “GLIMPSE” set of queries includes

those that we anticipate will be of particular interest to many GLIMPSE users. These queries are grouped into sub-

categories, including “Converted Units,” “Primary and final energy,” “Energy Inputs by Sector,” “Technologies,”
“Emissions,” “Impacts,” “Markets, prices, and costs,” “Inputs and outputs,” “Assumptions,”

demand.” For the queries under “GLIMPSE,” hovering the mouse over a query will pop up a tooltip with a

description of the query. Several queries are specific to either GCAM or GCAM-USA, as indicated in their title.

and “Water supply and

Different versions of these queries are necessary because of the naming and structural differences between the

two versions of the model.

Additional queries follow, grouped into the category “Standard GCAM Queries.” These are the queries that are

distributed with GCAM by PNNL.

For this tutorial, we will use several commonly examined outputs, including:

e  “CO2 emissions by region”
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e  “Electricity generation by aggregate subsector rnw detail,” where “rnw detail” indicates that this query
returns more detailed information about renewables than “Electricity generation by aggregate

subsector.”
In the “Scenario” pane, select GLIMPSE-1.1-Ref.

Next, in the “Regions” pane, we want to select all the states and the “USA” region. An easy way to do this is with

the following steps:

e Scroll down to “WY” and click select it.

e Scroll up to “AK” and shift-click select it.

e Scroll up to the top and control-click on “USA.”
In the “Queries” list, scroll down and select the query: Queries—>GLIMPSE-> CO2 emissions by region.
Next, click on the “Run Query” button.

A tab will appear at the bottom of the Modelinterface, showing the message “Waiting for results. Close to

terminate.” After a short period of time, the tab will be populated by a table that shows the query results for each

selected scenario and region.
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Figure B-2.2: Viewing the results of a query at the regional level.

% GLIMPSE Modellnterface [C:\Projects\GLIMPSE-v1.1\GCAM-Model\gcam-v7.0\outputidatabase-v1] = a x

|File Edit Tools Advanced Help

Scenario Regions Queries
GLIMPSE-1.1-Ref 202 6-04: South Korea i Panspur{ sefvice DU{DU{ tt;v {EER (sales)
. . . -7 = Transport service output by tech (sales’
GCAM7.0 2023-13-11T12:55:55-05:00 Southeast Asia -~ Passenger car and truck service output by tech a
Taiwan - = Freight truck service output by tech (no bus)
; =" Emissions
Argentlr.]a ZEE1(C02 emissions by region
Colombia I -~ = CO2 emissions by aggregate sector

= CO2 emissions by sector

= CO2 by resource production

= CO2 emissions by sector (no bio)

= CO2 emissions by tech

= C02,NOx,502,PM2.5,VOC,CO,NH3 by region

= C02,NOx,502,PM2.5,VOC,CO,NH3 by agqreqate sector
= C02,NOx,502,PM2.5,VOC,CO,NH3 by sector

i Run Query | Diff Query DTntaI Collapse

@ CO2 emissions by region

Filter Graph Format

scenario region 2015 2020 2025 2030 2035 2040 2045 2050 Units
GLIMPSE-1.1-Ref, date= T11:37:16- 8.89 7.98 7.79 7.76 7.74 7.93 8.09 8.27 TC
GLIMPSE-1.1-Ref, date= :37:16- 323 28.7 28.7 28.6 . 28.0 26.3 26.7 C
GLIMPSE-1.1-Ref, date= :37:16- 2.8 2.6 2.3 5.1 3 4.7 4.2 13.6 C
GLIMPSE-1.1-Ref, date= :37:16- 4.9 20.0 20.1 20.0 9.6 20.1 20.2 21.5 C
GLIMPSE-1.1-Ref, date= :37:16- 02 02 01 96.7 .3 0.6 196.3 C
GLIMPSE-1.1-Ref, date= :37:16- 24. 22.3 22.5 22.1 21.7 21.4 20.7 20.2 C
GLIMPSE-1.1-Ref, date= :37:16- 9.0 .35 .67 6.95 37 .50 6.43 6.63 C
GLIMPSE-1.1-Ref, date= :37:16- 0.726 .756 0.737 0.712 0.687 0.681 0.672 0.685 C
GLIMPSE-1.1-Ref, date= :37:16- 3.3 .05 .87 2.60 44 2.39 2.3 2.21 C
GLIMPSE-1.1-Ref, date= :37:16- 66.8 1.6 60.6 58.7 57.7 58.6 9.l 59.5 C
GLIMPSE-1.1-Ref, date= :37:16- 37.6 33.3 32.8 317 31.1 31.1 316 32.3 C
GLIMPSE-1.1-Ref, date= :37:16- 5.33 4.7 4.50 4.22 .06 .02 53.91 3.88 C
GLIMPSE-1.1-Ref, date= :37:16- 13.5 10. 10.4 10.7 1 9.31 .07 3.08 C
GLIMPSE-1.1-Ref, date= :37:16- .57 3 4.90 .7 4.5 .47 4.46 .47 C
GLIMPSE-1.1-Ref, date= :37:16- 55. 48.9 48.2 0.9 39. 38. 38. 1. C
GLIMPSE-1.1-Ref, date= :37:16- 8.5 41.3 41.1 32.9 27. 27. 27.6 27. C
GLIMPSE-1.1-Ref, date= :37:16- 6.5 14. 14.4 4.3 14.2 14, 4. 12. C
GLIMPSE-1.1-Ref, date= :37:16- 35.5 28.5 28.3 28.9 29.1 28.5 27.2 ’276 C
GLIMPSE-1.1-Ref, date= 37:16- 54.9 51.6 51.3 514 51.9 53.2 54.4 55. C
GLIMPSE-1.1-Ref, date= :37:16- 16.4 153 14.5 13.4 12.7 12.5 12.4 12.5 C
GLIMPSE-1.1-Ref, date= :37:16- 16.1 13.5 12.8 12.0 1.4 114 115 11.0 C
GLIMPSE-1.1-Ref, date= :37:16- 4.10 4.00 3.79 3.51 3.33 3.25 3.21 3.31 C
GLIMPSE-1.1-Ref, date= :37:16- 42.5 38.5 37.3 28.5 27.7 27.8 28.1 20.1 C

The Modelinterface also makes it very easy to develop regional totals. To do this, click on the “Total” button in the
center for the graphical interface, then re-run the query by clicking on “Run Query.” The values that are reported
in the table now represent the sum across all selected regions.
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Figure B-2.3: Viewing the results of a query, totaled across selected regions.

o=
% GLIMPSE Modellnterface [C:\Projects\GLIMPSE-v1.1\GCAM-Model\gcam-v7.0\outputidatabase-v1] = a x

|File Edit Tools Advanced Help

Scenario Regions Queries
GLIMPSE-1.1-Ref 2023-3-11T11:37:16-04:00  |ENLOI = Transport service output EV %ECR (sales)
oo . . -7 = Transport service output by tech (sales
GCAM7.0 2023-13-11T12:55:55-05:00 Southeast Asia - = Passenger car and truck service output by tech O
Taiwan - = Freight truck service output by tech (no bus)
i =" Emissions
Argentu?a Bl CO?2 emissions by region
Colombia I -2 CO2 emissions by aggregate sector

= CO2 emissions by sector

= CO?2 by resource production

= CO2 emissions by sector (no bio)

= CO2 emissions by tech

= C02,NOx,502,PM2.5,VOC,CO,NH3 by region

= C02,N0Ox,502,PM2.5,VOC,CO,NH3 by agqreqate sector
= C02,NOx,502,PM2.5,VOC,CO,NH3 by sector

¢ Run Query | Diff Query .Tntal Collapse

3 CO2 emissions by region E CO2 emissions by region

Filter Graph Format

scenario region 2015 2020 2025 2030 2035 2040 2045 2050 Units
GLIMPSE-1.1-... [Total 11420 11280 |1270 |1200 |1180 |1170 11160 11150 MTC

B-2.3 ANALYZING MODEL RESULTS OUTSIDE OF THE MODELINTERFACE

There are several ways to analyze the results of the queries. One is to move the data to a spreadsheet. If you have
Excel open, you can drag the label of the tab associated with a query over to an Excel worksheet and drop the data
there. This approach moves the table headings along with the data.

For large datasets (e.g., with several hundred rows or more), this approach can be very overly memory intensive.
An alternative is to select rows in your table (multi-selecting with shift-click or control-click), then pressing ctrl-c to
copy the data. You can then paste the data into the spreadsheet by choosing a location and pressing ctrl-v. This
second approach only pastes the contents of the table; it does not paste the headings.

The Modelinterface offers a third mechanism for exporting query results. If you have already executed the queries
of interest, one or more tables of data will be shown on tabs. Choose “File>Export tabs as CSVs” from the main
Modelinterface menu bar. A file browser will appear, and you can select the folder for where you would like to
place the query results. The data on each tab, including the column headers, are then written to that folder as CSV
files, with the filenames base on the tab names.

An issue can arise with these approaches if you have the “Text to Columns” feature in your spreadsheet. The
scenario name has a comma embedded in the cell, and this cell can sometimes be displayed over two cells. Turning
off “Text to Columns” can alleviate this problem.

For practice, use each of the approaches described above to transfer the query results to an Excel workbook.
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B-2.4 USING THE MODELINTERFACE TO VISUALIZE MODEL RESULTS

The Modelinterface includes graphical capabilities that are intended to support interactive, exploratory data

analysis — allowing the user to quickly visualize and iteratively explore the model results. In this section, we use

these tools to understand how electricity production differs between the GCAM?7.0 and GLIMPSE-1.1-Ref.

Run the query “Electricity generation by aggregate subsector rnw detail.” When the query is complete, your

Modelinterface should report resulting electricity production values.

Figure B-2.4: Examining electricity production by subsector.

(.
4% GLIMPSE Modellnterface [C:\Projects\GLIMPSE-v1.1\GCAM-Model\gcam-v7.0\output\database-v1] = m]

X
|File Edit Tools Advanced Help
Scenario Regions Queries
GLIMPSE-1.1-Ref 2023-3-11T11:37:16 South America_Northern e Eggﬂgg gggg; Egggﬂmg}:gg :2 :ﬂgﬂggz (detal)
GCAM7.0 2023-13-11T12:55:55-05:00 South America_Southern = Eneray inputs to electricity production n

South Asia
South Korea
Southeast Asia
Taiwan
Argentina
Colombia

= Enerqy inputs to electricity production (detail)

- = Enerqy inputs to refining activities
=17 Technologies

- = Electricity generation by region (centralized)
= Electricity generation by region (incl cogen)
= Electricity generation via rooftop PV by region
= Electricity generation by gen and cooling tech (ind cogen)
= Electricity generation by aggregated subsector

C i aggregated subsector mw detail

eneration by subsector
= Electricity generation by tech and cooling (incl cogen)

Run Query Diff Query 'T:}tal Collapse
i Electricity generation by agaregated subsector mw detail ;
Filter Graph Format

scenario region subsector 2015 2020 2025 2030 2035 2040 2045 2050 Units
GLIMPSE-1.1...Tota battery 0.00 0.000165 0.000293 0.000517 0.000712 |0.00114 0.00173 0.00385 E
GLIMPSE ofa biomass 0.240 0.189 0.192 0.201 0.214 0.234 .259 0.301 EJ
GLIMPSE .Total coal 5.30 3.21 3.20 2.57 2.32 2.18 .9 .64 EJ
GLIMPSE .[Total gas 4.99 6.02 6.37 7.25 8.20 9.22 0. 1.9 EJ
GLIMPSE . Total hydro .904 1.05 1.05 05 1.05 1.02 .03 .04 E]
GLIMP . Total ﬁidmgen .00 .00 0.000320 0.00594 0.0105 0.0161 .0203 .0254 E]
GLIMP . Total refined liquids [0.139 .0677 0.0617 0.0511 0.0471 0.0465 0.0459 0.0483 E]
GLIMP . Total solar PV .116 .676 1.07 92 2.58 .16 3.77 4.08 E]
GLIMPSE ota solar rooftop...0.00 .0290 0.0591 0.0993 0.111 0.136 0.155 0.197 E]
GLIMPSE ota wind offshore 0.00 .00 0.138 0.316 0.662 0.749 0.931 1.06 E]
GLIMPSE ota wind onshore 0.695 1.70 2.15 .84 3.38 .96 4.2 4.62 E]
GLIMPSE otal nuclear 2.99 2.92 2.79 2.73 2.32 1.88 1.49 1.12 E]
GLIMPSE otal solar CSP 0.0128 0.0489 0.0776 0.141 0.184 .256 0.358 0.420 E]
GLIMPSE-1.1...[Tota geo 0.0674 0.0674 0.0674 0.0673 0.0673 0.0673 0.0674 0.0674 B

Click the “Graph” button above the table. A simple line chart will appear to the right of the table.
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Figure B-2.5: Generating a thumbnail graphic.

o
unu GLIMPSE Modellnterface [C:\Projects\GLIMPSE-v1. 1\GCAM Model\gcam-v7.0\output\database-v1] = a X

|File Edit Tools Advanced Help

Scenario Regions Quenes
GLIMPSE-1.1-Ref 2023-3- g South America_Northern = End-use energy consumption in industry .
GCAM7.0 2023-13-11T12:55:55-05:00 South America_Southem T2 Endruse energy consumption in industry (detail .
South Asia - = Enerqgy inputs to electricity production (detail)

South Korea = Enerqy inputs to refining activities

. I =] Technuloqms
Southeast Asia = Electricity generation by region (centralized)
Taiwan - < Electricity generation by region (incl cogen)
Argentina - < Electricity generation via rooftop PV by region
g = Electricity generation by gen and cooling tech (ind cogen)

Colombia 2 EIELtnclt generation by a reated subsector

it egated subsector mw detail
= Electnl:lty generation by subsel:tor
= Electricity generation by tech and cooling (incl cogen)

Run Query Diff Query .Tntal Collapse

& Electricity generation by aggregated subsector rnw detail

scenario region subsec... 2015 2020 2025 2030 2035 2040 2045 2050 Units

GLIMPS...[Total _|battery 10.00 0.000165 0.000293/0.000517 0.000712 0.00114 0.00173 0.00385 ) SRR
GLIMPS._.[Total |biomass [0.240 0192 (0201 0214 (0234 [0.259 0301 _|EJ region: Total
GLIMPS...[Total __[coal 5.30 3 21 320 [2.57 232 2. .90 . E] wal

GLIMPS...Tota 499 [6.02 637 7.2 .20 2 i 3 .

GLIMPS... Total __hydro __10.004 __[1.05 1.05 205 0 03 -0 3

GLIMPS...Tota ﬁ%dmgen 0.00 [0.00___[0.000320 0.0059% [0.0105 [0.0161 [0.0203 _0.0254 _|EJ o)l

GLIMPS... Total _refined ... 0.139 __[0.0677 _[0.0617 10.0511 _0.0471 _[0.0465 [0.0450 10.0483 [E) 10

GLIMPS...[Total __[solar PV 10.116 _ [0.676 __1.07 2.58 16 77 4.0 3

GLIMPS... Total __solar ro...10.00 _ [0.0290 _[0.0501 _0.0993 0.111 _ [0.136 __[0.155 __10.197 __[E) =

GLIMPS...[Total __wind of.... [0.0 0.00  10.138 0.316 __0.662 _[0.749 __[0.931 __1.06 3 g

GLIMPS...[Total __wind on...0.695 [1.70 .15 2. 38 .06 22 46 3 H

GLIMPS...Total _nudlear 12.09 _ [2.00 _ 2.79 _ 12.73 32 188 149 142 3 3

GLIMPS... Total __solar C5P 10.0128 [0.0489 _[0.0776 _0.141 _ 0.184 _[0.256__[0.358 __10.420 __[E)

GLIMPS... Total __Igeo 0.0674 [0.0674 10.0674 ]0.06/3 _10.0673 _0.0673 ]0.06/4 ]0.06/4 |EJ

Bow o8 owooN
8 8 8 8 B
2 8 B 8 B
@ 5 & & &

This image is a thumbnail. Clicking on it will display a larger version with a legend. Right-clicking on this larger
image and choosing “Copy” will add a copy of the image to your computer’s clipboard, allowing it to be pasted into
other documents. Note that this option may be problematic on Corretto’s versions of Java and may cause the
Modelinterface to freeze. Alternatively, you can right-click and choose “Save As...” to save the image as a PNG file
or use Windows screen capture tools to copy the image.
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Figure B-2.6: Clicking on the thumbnail produces a larger version with legend.

| —
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ChartOptions
Yaar 2018 2020 2028 2018 2040 2048 2080
battasy 0.0 0.0 |o.a 0.001 0.001 0.002 0.004
biomass |o.24 l0.183 |b.152 0,214 0234 lo.238 |0.301
coal 53 tET! 32 232 210 199 164
gas 4.35 6.02 [837 8.2 9.22 10.4 1.9
hydra |EEE] (103 | ¥CE] |1.03 102 [FE] 104
ydrmgan 0.0 0.0 e 0.01 0.018 0.02 0.023
rafined liguids 0,133 la.0e8 [o.082 o.0a7 lo.0as |0.0a8 [0-0ee
solar Pv |o.118 l0.676 |ro7 JEET [3.18 |EXL] |4.08_
solar rocfop PV 0.0 0.029 |EEED 0.111 0136 0.1535 0.197
wind clfshars 0.0 0.0 [o.138 0562 0.743 0.931 1.06
wind onshore 0,653 a7 |EXTE] |3.38 13.38 422 482
rusclear .99 292 |2.79 232 1.80 1.49 112
solar CSP 0.013 0.043 [o.a78 0.184 0.256 0358 0.42
e o087 la.os7 [o.087 |o.087 o067 l0.067 |0.087

There are a variety of options for modifying the figure, including changing the texture and shading of the lines.

These changes can be saved and are applied automatically the next time a similar figure is plotted.

Other types of graphs can also be displayed. Above the thumbnail, change the selection in the pulldown menu

from “LineChart” to “StackedBarChart.” The thumbnail is updated to reflect the change.
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Figure B-2.7: Viewing query results as a stacked bar chart.

i GLIMPSE Modelinterface [C:\Projects\GLIMPSE-v1.1\GCAM-Model\gcam-v7.0\output\database-v1]

|File Edit Tools Advanced Help

Scenario

Queries

e 16-04:00 South America_Northern
GCAM7.0 2023-13-11T12:55:55-05:00 South America_Southern
South Asia
South Korea
Southeast Asia
Taiwan
Argentina
Colombia

< End-use energy consumption in industry
= End-use energy consumption in industry (detail)

- = Energy inputs to electricity production
- = Enerqgy inputs to electricity production (detail)

= Energy inputs to refining activities

echnologies

= Electricity generation by region (centralized)
< Electricity generation by region (ind cogen)
= Electricity generation via rooftop PV by region

- = Electricity generation by gen and cooling tech (incl cogen)
* « Electricity generation by aggregated subsector

BiElectricity generation by aggregated subsector rnw detail
= Electricity generation by subsector

- = Electricity generation by tech and cooling (incl cogen)

Diff Query [ Total Collapse

(3 Electricity generation by aggregated subsector rnw detail

Filter Graph Format

scenario  region subsec... 2015 2020 2025

™~

i

~o
=

[
o

]

oloololoin
=N
=2

k<

output (EJ)

n

[ e

Fo ot et e o e o |

|~

=l

|GLIM battery  |0.00 0.000165 |0.000293
|Gl biomass [0.240 0.189 0.192
G coa 5.3 3.21 3.20
Gl gas 4.99 6.02 6.37
Gl hydro 0. 1.05 1.
G ﬁ%ﬂmﬁen 0. .00 0.
refined ...[0.139 677 10.0617
solar PV_[0.116 676 1.07
Gl X 290  [0.0591
G i .. |00 0 0.138
|Gl 1.70 2.15
G nuclear .99 2.92 2.79
G solar CSP [0.0128  [0.0489  [0.0776
G geo 0.0674 10.0674 [0.0674

GLIMPSE-1.1-Ref

region: Total
28
&l ]
24 ]
22 ]
20 [
18 i
18 i
" . . -
12 =

Try out some of the other graphing options.

B-2.4 COMPARING RESULTS ACROSS SCENARIOS

Next, we will walk through some ways you can use the Modelinterface to compare the results of two scenarios.

In the Scenario pane at the top left of the Modelinterface, keep GLIMPSE-1.1-Ref selected, but add GCAM?7.0 to the

selection by control-clicking on it.

In the Query pane on the top right, change your selection to “Electricity generation by aggregated subsector rnw

detail.”

Make sure the “Total” checkbox is checked, then click on the “Run Query” button. After several seconds, the table

will be populated with electricity generation data.
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Figure B-2.8: Examining the results of two scenarios simultaneously.

| % GLIMPSE Modelinterface [C:\Projects\GLIMPSE-v1.\GCAM-Modehgcam-v7.0\output\database-v1] = (] X
File Edit Tools Advanced Help |
Scenario Regions Queries |
= End-use energy consumption in industry
Africa. Fast = End-use energy consumption in industry (detail)
rica_tastern = Energy inputs to electricity production .
Africa_Northern = Energy inputs to electricity production (detail)
Africa_Southern = Energy inputs to refining activities
L =] wologies
Africa_Western ectricity generation by region (centralized)
Australia_NZ ectricity generation by region (incl cogen)
Brazil ectricity generation via rooftop PV by reqgion
ectricity generation by gen and cooling tech (ind cogen)
Canada ctricity generation by aggregated subsector
Central America and Caribbean rau aggregated su el
Central Asia ectricity generation by subsector ]
entra ectricity generation by tech and cooling (incl cogen)
China ectricity generation by tech and cooling (indl cogen)(new capacity)
EU-12 ectricity generation by cogen only
ectricity generation input by subsector
EU-15 < = Building final energy by tech
Europe_Fastern ] Euilginq service output Bv tecn (sales)
< building service output by tech (sales’
Europe_Non_EU . = Industry final energy by tech and fuel
European Free Trade Association < Refined liquids production by tech (GCAM-USA)
India -~ = Hydrogen production by tech
Indonesia | Run Query | Diff Query [@Total Collapse
[E Electricity generation by aggregated subsector rnw detail
Filter Graph Format
scenario region subsector 2015 2020 2025 2030 2035 2040 2045 2050 Units
G 0 [otal |biomass 0.240 0.187 0.214 0.231 0.253 0.275 .309 0.360 EJ
G 0 Total |coal 5.30 4.36 4.26 4.08 3.83 3.49 2.90 .07 EJ
G 0 Total lgas 4.99 5.33 6.00 6.79 7.72 8.74 .1 6 EJ
G 0 Total hydro .904 1. 1. 1.05 1.05 1.05 K .04 EJ
G 0 Total drogen .00 .00 0.000327 0.00432 0.00798 0.0123 .0164 .0216 EJ
G 0 Total refined liquids [0.139 .0657 0.0600 0.0501 0.0465 0.0444 . .0462 EJ
G 0 Total .116 .602 0.998 1.7 2.35 2.9 3.61 3.95 EJ
G 0 Total PV|0.00 .0287 0.0611 0.111 .124 0.135 .151 . EJ
G 0 Total 00 .00 0.0252 0.0943 .205 0.352 .538 .725 EJ
G 0 Total 695 .26 1.76 2.35 .01 3.67 .00 .62 EJ
GCAM7.0 Total .99 2.92 2.79 2.71 31 1.89 .50 1.0 EJ
G 0 Total 0128 .0454 0.0756 125 177 0.238 334 0.396 EJ
“Q AM7.0 Total 674 .0674 0.0674 .0674 0674 0.0674 674 0.0674 EJ
G Total 0 .000165 0293 000517 000712 0.00114 0173 0.00385 EJ
IIIQi ofal 40 .189 .201 14 0.234 .259 0.301 EJ
[IMPSE-1 1- [Tnta n 21 2 57 32 2 1R a9 64 E

Click on the “Graph” button to generate thumbnails. You may need to reposition the dividers to see both
thumbnails fully. Click on the checkbox next to “Same Scale.” This will ensure that the Y axis is shown at the same

scale for all thumbnails.
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Figure B-2.9: Comparing two results scenarios graphically.

i GLIMPSE Modelinterface [C:\Projects\GLIMPSE-v1.1\GCAM-Model\gcam-v7.0\output\database-v1]

— [m] X
‘File Edit Tools Advanced Help
Scenario Regions Queries
= End-use energy consumption in industry
Africa. Fast = End-use energy consumption in industry (detail)
rica_tastern = Energy inputs to electricity production n

Africa_Northern
Africa_Southern

= Energy inputs to electricity production (detail)
= Energy inputs to refining activities

wologies

ectricity generation by region (centralized)

ectricity generation by region (incl cogen)

ectricity generation via rooftop PV by reqgion

ectricity generation by gen and cooling tech (ind cogen)

ctricity generation by aggregated subsector

rati aggregated su I Il

re
Electricity generation by subsector
Electricity generation by tech and cooling (ind cogen)

Electricity generation by tech and cooling (indl cogen)(new capacity)
Eeutricitv generation by cogen only

ectricity generation input by subsector

Run Query Diff Query . Total Collapse

[ Electricity generation by aggregated subsector rnw detail

Filter | Graph Format
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As before, you can click on each thumbnail to view a larger version. However, additional features facilitate

comparison.

Click on “More” in the green area above the thumbnails and click “Transpose.”

A popup window of thumbnails appears, but this time each series is given its own plot and the results of the two

scenarios are compared.

Here, we have changed the “Display” option to “4,” which changes the number of charts shown on a row.
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Figure B-2.10: Using the transpose option to compare the scenario results by series.
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If we click on the “coal” thumbnail, we can see that the electric production from coal is less in GLIMPSE-1.1-Ref
(blue) relative to GCAM?7.0 (red).
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Figure B-2.11: Comparing output from coal plants in the electric sector from one scenario across

scenarios.
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Close these windows when you are ready.

Next, we will generate a “difference” plot.

First, change the chart type to “StackedBarChart” and click on “Same Scale” to synchronize the magnitude of the Y-

axis.
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Figure B-2.12: Viewing the thumbnails as stacked bar charts.

t %ET] GLIMPSE Modelinterface [C:\Projects\GLIMPSE-v1.1\GCAM-Model\gcam-v7.0\output\database-v1] = (] X

File Edit Tools Advanced Help

Scenario

Regions Queries

= End-use energy consumption in industry

= End-use energy consumption in industry (detail)

= Energy inputs to electricity production "]
= Energy inputs to electricity production (detail)

= Energy inputs to refining activities
=7 Technologies
= Electricity generation by region (centralized)
ectricity generation by region (incl cogen)
ectricity generation via rooftop PV by reqgion
ectricity generation by gen and cooling tech (ind cogen)
ectricity generation by aggregated subsector

eneration by aggregated subsector rnw detail

ectricity generation by subsector

ectricity generation by tech and cooling (ind cogen)

ectricity generation by tech and cooling (indl cogen)(new capacity)
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ectricity generation input by subsector
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Click on “More” in the green area above the thumbnails and click “Difference.” A popup appears with the names of
all the scenarios in the table. First, choose “Total GLIMPSE-1.1-Ref,” then press “OK.”

Figure B-2.13: Specifying which scenario to subtract from the other.

Typically, the Reference Scenario is the second selected.

l @ Select first chart to compare X

Total GCAM7.0_date=2023-13-11T12:55:55-05:00,0
Total GLIMPSE-1.1-Ref_date=2023-3-11T11:37:16-04:00,1

Cancel

Then select GCAM7.0 and press “OK.”

A difference plot appears. Items that are greater in GLIMPSE-1.1-Ref are shown above the line, while items that are
less are shown below the line.

196




GLIMPSE Users’ Guide v1.1 Appendix B: Tutorials

Figure B-2.14: Difference plot.

Items above the axis represent increases and items below the axis represent decreases.
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The updates incorporated in GLIMPSE-1.1-Ref have resulted in increased electricity production from onshore and

offshore wind, and utility-scale solar and rooftop photovoltaics. GLIMPSE-1.1-Ref also has less output from coal.

Stacked bar plots are particularly useful for showing changes from one scenario to another.

B-2.5 ADDITIONAL SUGGESTIONS FOR EXPLORATION

Use the Modelinterface’s graphical capabilities to examine other outputs of interest, and how these outputs differ

between GLIMPSE-1.1-Ref and GCAM?7.0. Suggestions include:

e  “Final energy consumption by aggregate sector”
e  “Building service output by tech”

e “Refined liquids production by tech (GCAM-USA)”
e  “Passenger car and truck service output by tech”
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B-3 MODELING AND EVALUATING A CARBON TAX

B-3.1 OVERVIEW

In this portion of the tutorial, we will develop a new scenario that incorporates a hypothetical economy-wide tax
on carbon. The tax will start at a value of $100/tC in 2025 (in 1990Ss) and will increase at 5% per year. Please note
that this tax is being applied per metric tonne of carbon. Converting the units to $/tCO: equivalent involves
multiplying it by 12/44ths, the ratio of the molecular weight of C to the molecular weight of CO». By default, GCAM
uses 19905s. $1 in 1990 is the equivalent of $2.27 in 2022. Considering both conversions, our starting tax is
approximately $62/tCOz in 2022Ss.

B-3.2 CONSTRUCTING CARBON TAX SCENARIO COMPONENT
Our first step is to create a new Scenario Component that represents our hypothetical tax. First, click on the “New”

button in the Component Library, + . This will pop up the New Scenario Component Creator. Tabs across the top
represent several types of policies or alternative assumptions that can be created. Select “Pollutant Tax/Cap.”

Figure B-3.1: The New Scenario Component Creator dialog.

B " New Scenaric Component Creator *
XML List | Pollutant TaxfCap| Tech Avail | Market Share | Tech Bound | Tech Tax/Subsidy | Tech Param | Fuel Price Adj
Specification: Values:
Select region(s):
Measure: Select One - Populate Delete Clear - world =
o 3
Pollutant: Year Value USA
Canada
Sector:
Central America and Caribbe...
Mexico
Names: V| Auto? Brazil
Policy: South America_Northern
Market: South America_Southern
Argentina
Colombia
populate No content in table EU-15
Type: Initial w/% Growth/yr - EU-12
Start Year: 2020 European Free Trade Associa...
End Year: 2050 Europe Eastern
Eurcpe_Mon_EU
il Africa_Eastern
Growth (%): Africa_Northern
Presets: | salact (optional) -
Add
Save Close

The top-left portion is where we define what type of policy we will be creating. The middle portion will contain the
values associated with the policy. The tree at the right allows us to specify to which regions or states the policy
applies. The bottom-left portion can be used to automate the process of populating the central table with data.
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In the top-left portion, under the “Measure:” choice menu, you will find the two types of policies that can be
created on this tab. Select “Emission Tax ($/t).

Next, the “Pollutant:” choice menu can be used to select to which pollutant the tax will be applied, choose “CO>
(MT C)".

We want this to be an economy-wide tax, so in the “Sector:” choice menu, choose “All.”

The tax will start at $100/tC, starting in 2025, so change the “Start Year:” value to “2025” and add “100” and “5” in
the “Initial Val:” and “Growth (%):” boxes, respectively.

Above the table, press the “Populate” button to populate the table with values that reflect these options.
The tax will be applied to all US states, so click the check box next to “USA” on the region table.

When you have completed these steps, the scenario component window should look like this:

Figure B-3.2: Specifying the options for our carbon tax policy.

[B! New Scenaric Component Creator *

L

XML List | Pollutant Tax/Cap | Tech Avail | Market Share || Tech Bound | Tech Tax/Subsidy | Tech Param | Fuel Price Adj

Specification: Values

M Emission Tax (19908 Select region(s):

easure mission Tax (19908/t) PR Cinlate i
¥ |—| world
Pollutant: €02 (MT Q) -
Year Value > v UsA

Sector. Al i
1 2025 100 Canada
| S0 7 Central America and Caribbean

2 12

MNames: v | Auto? Mexico
1 Palicy: 2035 163 Brazil
||| Market: 2040 208 South America_Northern
'
l i I .

2045 265 South America_Southern

0 . Argentina

Populate: 2050 339

- " : Colombia

Type: Initial wy/% Growth/yr -
| EU-15 |

Start Year: 2025

EU-12

End Year 2050 European Free Trade Association

Initial Wal 10 Europe Eastern

Growth (%): 5 Europe Non EU

Convert §s from None - Africa_Eastern

Africa_Northemn
Presets: Select (optional) -
Add
Save Close

Next, press the “Save” button. The “Save As” dialog will appear, and a default name will be provided. Here, the
name has been changed to be more descriptive. When naming scenario components and scenarios in GLIMPSE it is

“«w n

important only to use alpha-numeric characters and either or “-”. Do not use spaces, or other non-alpha-

numeric characters, such as “+”, “/” or “\”. Do not use spaces in Scenario Component filenames.
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Figure B-3.3: Saving our scenario with a unique name.

Sawve As X |

4N + GLIMPSE-v1.1 » GLIMPSE-Data » GCAM-USA-Tp0 » ScenarioComponents ~ ) Search ScenarioComponents @
Organize * Mew folder = - e
Name . Date modified Type Size

ﬂ Calib-Bio-and-CCS-limits-in-NewEngland.csv 8/23/2023 1:25 PM Microsoft Excel Com I
B Calib-LDV-EV-AEO2020.csv 2/8/2023 8:45 AM Microsoft Excel Com... 585 KB

B Calib-Lo_alt_biofuel SW.csv 2/8/2023 8:45 AM Microsaft Excel Com... 173 KB

B Calib-NE fixed_nuke_output.csv Microsoft Excel Com 43 KB

] Calib-NE_fixed_nuke_output_Thru_2020.csv Microsoft Excel Com... 11 KB

B9 No-ces-NE.csv 2/8/2023 8:45 AM Microsoft Excel Com 42 KB

aj Policy-100pct-EV-FreightTrck-Heavy.csv 442 1:32 PM Microsoft Excel Com 189 KB

B Policy-100pct-EV-FreightTrck-Light.csv 4/25/2023 1:30 PM Microsoft Excel Com... 189 KB

File name: | Tax_C_100dpt-5pct-2025.csv
Save as type: CSV files (*.csv)
» Hide Folders Save Cancel

Note that the New Scenario Component Creator does not automatically disappear after you have clicked “Save.”
This behavior is intentional and is intended to allow the user to modify the constraint readily.

Once you have pressed “Save,” the component will appear in the Component Library. By default, the components
are in alphabetical order. You can click on the appropriate column name to sort the table. Here, the components
are sorted by the date they were created:
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Figure B-3.4: Selecting a scenario to modify.

i u GLIMPSE Scenario Builder

1
q File Edit View Tools Help

Component Library Search:

+ e X O]

Component Name

Tax_C_100dpt-Spet-2025.csv

Tech-DAC et
Tech-ElecTechs-bldgs.csv
Tech-HOY-HeavyEVSales-50x50.csv
i Tech-HOWV-LightEV Sales- 50x50.csv

‘i Tech-HDVY-MediumEVSales-50x50.cov

Created

2023-11-13: 1511 ’

2023-08-17: 16:57
2023-02-08: 08:45
2023-02-08: 08:45
2023-02-08: 08:45

2023-02-08: 08:45

Create Scenario

GCAMT.0

Component Name

No content in table

®

|

}

J Ji

Scenario Library Search: / d wll= ﬁ . o= O l

= D X i CE R R R |k
Scenario Name Created Completed Status ProbMkts Runtime

GCAMT.O 2023-11-01: 15:10 2023-11-13:13:22 Success 0 hr 26 min i
GLIMPSE-1.1-Ref 2023-11-01: 15:10 2023-11-20: 17:00 Success 0 hr 39 min [

Resources... CPU: 31% | RAM: 16GB Free:50% | Disk: 282GB available | Swap: 41GB Free:75% // Database: database-v1 Size: 10.8GB Used:27%

The next step is to construct a scenario that includes this policy. We will do this by modifying an existing scenario.

Start by clicking on GLIMPSE-1.1-Ref in the Scenario Library. Then, click on the / button to allow you to modify it.

You will see components associated with GLIMPSE-1.1-Ref displayed in the table at the top-right. Change the name
above the table to “GLIMPSE1.1-Tax-100C-5pct” to describe your new scenario.

Then, click on the new tax component in the Component Library and press the > button to add it to your

scenario:
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Figure B-3.5: Adding the new scenario component to the scenario.

EZ GLIMPSE Scenario Builder — O b 4

File Edit View Tools Help

Component Library Search: | f B X O Create Scenario GLIMPSE-1.1-Ref
Component Name
Component Name Created
’ Updates-GLIMPSEv1.1-AddOnFiles.txt
Tax_C_100dpt-5pet-2025.csv 2023-11-13: 151
? : n Palicy-RGGI-hold. txt
Tech-DAC.txt 2023-08-17; 16:57
{ Policy-State_RPS targets b
Tech-ElecTechs-bldgs.csw 2023-02-08: 08:45
) x Palicy-LDV-Short-Term-GHG-Rule.txt
Tech-HOV-HeavyEVSales-50x50.csv 2023-02-08: 08:45
1 Tech-HDV-LightEVSales-50x50.cov 2023-02-08: 08:45
| Tech-HOV-MediumEVSales- 50x50.csv 2023-02-08: 08:45

arZal=d0abdl 1~ = O

Scenario Name Created Completed Status PrabMkts Runtime
GCAMT.O 2023-11-01: 15:10 2023-11-13: 1322 Success 0 hr 26 min
GLIMPSE-1.1-Ref 2023-11-01: 1510 2023-11-20: 17:00 Success 0 hr 39 min

] Resources.. CPU: 31% | RAM: 16GB Free:50% | Disk: 282GB available | Swap: 41GB Free:75% // Database: database-v1 Size: 10.8GB Used:27%

To create the new scenario, press the © button. A dialog will appear that indicates the name of the scenario, the
database to which the results will be sent, the final year to include in the simulation, which region to use as the
debug region, whether to create the debug file, and check boxes allowing you to choose which files to save when
the scenario run is complete.

Many of these settings are available in the GLIMPSE options file, but this dialog gives the ability to override those
settings. The debug file includes detailed outputs for a specific region. Only one region or state can be selected
since the debug file is very large.

The “Use all available processors?” option allows you to indicate that GCAM should distribute the computational
load across all available processing cores. In general, this option should be selected. However, there may be
instances where unsolved markets occur as a result of the pre-emptive calculations that occur during parallel
computations. For scenarios that have unsolved markets for which the cause is unclear, repeating the model run,
but without the “Use all available processors?” box checked, may help pinpoint or eliminate errors introduced by
parallel calculations as the cause.

There is a box to add comments or other meta-data that describes the scenario.

202




GLIMPSE Users’ Guide v1.1 Appendix B: Tutorials

Figure B-3.6: The Creating Scenario dialog.

B Creating Scenario = X
Scenario name: GLIMPSE1.1-Tax-100C-5pct

Database: database-v1 (7 GB)

Final model year: 2050 ~

v | Create debug file? | CT -
v | Use all available processors?
Save files in scenario folder: (global setting)
v'| Debug file
v | Calibration log v'| Solver log

Comments:

Scenario based on GLIMPSE-1.1Reference that incoporates a carb

0K Cancel

Note that the database size is important. When the database reaches approximately 40 GB, it can no longer be
opened in Windows. If you attempt to create a new scenario and the database size is already 36 GB, a warning
message will occur. See the Users’ Guide for information on managing database size.

Once you press “OK,” the new scenario will be added to the Scenario Library. Double-clicking on the new scenario’s
name in the Scenario Library will display its configuration file.
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Figure B-3.7: The new scenario's configuration file.

M C\Projects\GLIMPSE-v1. \GLIMPSE-Data\GCAM-USA-TpM\ScenaricFolders\GLIMPSE1.1-Tax-100C-5pct\configuration_GLIMPSE1.1-Tax-100C-5pctxml - Notepad++ = [m] X
File Edit Search View Encoding Llanguage Settings Tools Macro Run  Plugins Window 7 + ¥ X
sHHE B s Mhiaciay %5651 FEENRHAa BEEEE

H configuration GLIMPSE1.1-Tax-100C-5pctxml E3

<?xml version="1.0" encoding="UTF-B" standalone="no"?>
[Fl<configuration> I
=M

T HHHEE 444444444 Scenario Meta
Scenaric

ta HHEHEEERERREERERAERES

$100/tC (1990$s), starting in 2025 and growing at 5 percent per year

5
Rule.txt
it AR AR AR AR AR AR RIS

El<Files>
24 «Value name="xmlInputFileName">../input/gcamdata/xml/modeltime.xml</Value>
E <value "BatchFileName">batch_ag.xml</Value>
26 <Value "policy-target-file">. . /input/policy/forcing target 4p5.xml</Value>
27 <Value "GHGInputFileName">../input/magicc/inputs/input_gases.emk</Valus>
2 <Value ric-n "0" name=" db-location" writ t="1">..\output\database-vl</Value>
29 <Value "0" name="restart" write-outpu ./restart/restart</Value>
30 <Value o-name="0" name="xmlDebugFileName" write-cutput="1">debug.xml</Value>

Markup Language file length : 18,391 lines: 243 n:1 Col:1 Pos:1 Windows (CRLF)  UTF-8 IN

=

components during the scenario’s creation.

Opening the scenario folder by pressing will show the XML-formatted files that were generated from scenario

Figure B-3.8 Contents of the scenario's folder.

— [m] X
_ GLIMPSE1.1-Tax-100C-5pct X +
|
@ New ~ % 18] )] G 0] Tl sort ~ = view - aee
|
< > v _ « ScenarioFolders » GLIMPSE1.1-Tax-100C-5pct v O Search GLIMPSE1.1-Tax-100... ©
~
MName Date modified Type Size
Q{ configuration_GLIMPSE1.1-Tax-100C-5pctacml 11/13/2023 3:21 PM XML File 18 KB
Q{ Tax_C_100dpt-5pct-2025.xml 11/13/2023 3:21 PM XML File 9 KB
Ziterns 1 item selected 8,60 KB [=|o

Close the text editor and scenario folder.

Next, start running the scenario by clicking on “GLIMPSE1.1-Tax-100C-5pct” and pressing play, > .
A black window will appear, providing diagnostic information about the run.

Once the run has completed, you will see its status updated in the Scenario Library.
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Figure B-3.9: After the new scenario run has been completed, its status is updated.

B3 GLIMPSE Scenario Builder — m] X

File Edit View Tools Help

Component Library Search: + / B X O Create Scenario GLIMPSE1.1-Tax-100C-5pct
Component Name Craated v Component Name -
Tax_C_100dpt-5pct-2025.csv 2023-11-13: 15:11 = ’ Updates-GLIMPSEv1.1-AddOnFiles txt
DeepDecarbAssumptions.txt 2023-10-31: 13:37 Policy-RGGI-hold.txt
Palicy-LDV-Short-Term-GHG-Rule.txt 2023-10-20: 09:52 ‘ Policy-State_RPS _targets.txt
Updates-GLIMPSEv1.1-AddOnFiles.txt 2023-10-20: 09:52 Policy-LDV-Short-Term-GHG-Rule.txt
Tutorial-tax-C-100dpt-5pct.csv 20232-09-15: 10:30 ‘ Tax C_100dpt-5pct-2025.csv -
Policy-IRA-basedOnCGS.txt 2023-09-06: 13:32 5 2
élnlinlr-n PastGCAMT7Release tyt 2023-09-05: 10:25 5 v @ A v

Scenario Library Search: /| / B D x % ﬁ " g O

Scenario Name Created Completed Status ProbMkts Runtime
GCAMT.0 2023-11-01: 15:10 2023-11-13:13:22 Success 0 hr 26 min
GLIMPSE-1.1-Ref 2023-11-01: 15:10 2023-11-03: 12:18 Success 0 hr 41 min

GLIMPSET.1-Tax-100C-5pct 2023-11-13: 15:21 2023-11-16: 14:49 Succe 0 hr 48 min

Resources... CPU: 28% | RAM: 16GB Free:43% | Disk: 293GB available | Swap: 32GB Free:55% // Database: database-v1 Size: 10.0GB Used:25%

B-3.3 EXPLORING THE RESPONSE TO THE TAX

The Modelinterface provides a variety of features for examining the differences between scenarios. Several
examples were earlier in this tutorial, including transposing plots so to compare data by series and creating
“difference” graphs. In this section, we use similar approaches to examine the impacts of the carbon tax policy.

First, start up the Modelinterface by clicking on “GLIMPSE1.1-Tax-100C-5pct” in the Scenario Library, then clicking

]
the Results button with the arrow, ﬁ . GLIMPSE will then access the scenario’s configuration file, read the name
of the database to which its results were stored, then open that database via the Modelinterface.

For this tutorial, we will be exploring national-scale impacts of the tax policy. Select “GLIMPSE1.1-Tax-100C-5pct ”
and “GLIMPSE1.1-Tax-100C-5pct ” in the Scenario pane. Next, in the Regions pane, select all states and the USA
region. Click the check box next to “Total” to obtain national totals.

Select “CO2 emissions by region,” then click the “Run Query” button. The results will populate the table after
several seconds.
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Figure B-3.10: CO, emissions for the two scenarios.

%ET] GLIMPSE Modelinterface [C:\Projects\GLIMPSE-v1.1\GCAM-Model\gcam-v7.0\output\database-v1] (] X
File Edit Tools Advanced Help
Scenario Regions Queries
GLIMPSE-1.1-Ref 2023- = Emlginq service UU{DUE Ev {edﬁ (sales]
" = building service output by tech (sales
GCAM7.0 2023-13-11T1. Africa_Eastern = Industry final energy by tech and fuel
GLIMPSE1.1-Tax-100C-5pct 2023-16-1 | is{eMelg1, 134 = Refined liquids production by tech (GCAM-USA) n
Africa Southern = Hydrogen production by tech
L = Transport final eneray by tech and fuel
Africa_Western = Transport service output by tech
Australia_NZ = Transport service output by tech (sales)
Brazil = Passenger car and truck service output by tech
= Freight truck service output by tech (no bus)
Canada = Emins i
Central America and Caribb BLCO2 emissions by region]
en ral njlenca and Caribbean =2 CO2 el ons by agaregate sector
Central Asia = CO2 emissions by sector
China = CO2 by resource production
EU-12 < CO2 emissions by sector (no bio)
= CO2 emissions by tech
EU-15 -+ = C0O2,NOx,502,PM2.5,VOC,CO,NH3 by region
Europe_Fastern 2 C02,NOx,502,PM2.5,VOC,CO,NH3 by aggregate sector
Europe Non EU = CO2,NOx,502,PM2.5,VOC,CO,NH3 by sector
pe_Non_ = C02,NOx,502,PM2.5,VOC,CO,NH3 by tech
European Free Trade Association = All emissions by region
India -~ = All emissions by aggreqgate sector
—— Indonesia | Run Query | Diff Query [@Total Collapse
[E CO2 emissions by region
Filter Graph Format
scenario region 2015 2020 2025 2030 2035 2040 2045 2050 Units
GLIMPSE-1.1-R... |Total [1420 [1280 [1270 [1200 [1180 [1170 [1160 }QSO MTC
GLIMPSE1.1-Ta... Total [1420 [1280 11230 [1140 [1050 1906 1789 683 MTC

Under the policy, CO2 emissions decrease to 685 MTC by 2050. This is 465 MTC less than GLIMPSE-1.1-Ref in 2050
and a reduction of 46% from 2020 levels. Pressing the “Graph” button shows each scenario’s CO2 trajectory on a

separate thumbnail. However, using the “More>Transpose” option generates the following graphic.
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Figure B-3.11: Visualizing the CO; trajectories for the two scenarios.
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Next, we will explore from which sectors GCAM is obtaining CO2 reductions.

Select and execute the “CO2 emissions by aggregate sector” query. Graph the results, then change the graph

formatted to stacked bar charts.

Next, using “More—> Difference”, generate a difference plot. When the popup appears, select one scenario then
the next, first click on “GLIMPSE1.1-Tax-100C-5pct,” click “OK,” then click GLIMPSE-1.1-Ref and click “OK".

This ordering — policy case, then reference case — is typical because values that go up as a result of the policy will

be shown in the positive direction and values that go down will be negative.

207




GLIMPSE Users’ Guide v1.1 Appendix B: Tutorials

Figure B-3.12: Difference graph showing the sectoral CO, response to the tax.
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In the graphic, we see that the tax has resulted in reductions in emissions from the electric sector that grow to
more than 220 MTC in 2050. Negative emissions associated with biomass growth grow to 159 MTC in 2050.
Emission reduction contributions from other sectors are comparatively small in this scenario.

Next, we will examine the electric sector and biomass responses further.

Run the “Electricity generation by aggregated subsector rnw detail” to view how electricity is being produced for
each scenario.

Graph and view the results as stacked bar charts.
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Figure B-3.13: Electricity production by technology category for the Reference and Tax scenarios.

m.u GLIMPSE Medelinterface [C:\Projects\GLIMPSE-v1.1\GCAM-| Mode\\gcam V7. O\DUtput\database vl] = o *
IFile Edit Tools Advanced Help

Regions __ Queries ]
South Korea - Biomass use by agareqate su:to(
Southeast Ask = Hydroaen use by agaregate sect
| Rt  End use eneray consumption In pulldings .
GLIMPSEL.1-Ta & REGIE Taiwan < End-use energy consumption in bullcinu! (detal\)
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Next, use “More-> Difference” to generate show the changes in electricity production under the task. The results
suggest that the tax may result in reductions in electricity production from conventional coal and gas, offset by
renewables, fossil production with CCS, biomass with CCS, and nuclear power. Overall, the quantity of electricity
produced does not change substantially since the height of the stacked bars above and below O for each time
period are roughly the same.
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Figure B-3.14: Difference graph showing the electric sector response to the tax.
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In this result, biomass use is increasing in the electric sector. Next, we will explore the degree to which biomass use
is increasing in other sectors as well.

Run the query “Biomass use by aggregate sector,” graph the results, and display them as stacked bar charts. The
results suggest that the greatest increase in biomass use is in the fuel production sector.
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Figure B-3.15: Difference graph showing the sectoral CO, response to the tax.
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The query “Refined liquids production by tech (GCAM-USA)” provides insight into how this biomass is being used.

Run that query, then generate a difference plot indicating how refined liquids production technologies are
responding to the tax. Here, we see a reduction in oil refining, which is being offset by an increase in bio-refining,

some of which integrates CCS.
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Figure B-3.16: Difference graph showing the sectoral CO, response to the tax.
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In the next part of the tutorial, we explore additional ways to identify the impacts of policy across scenarios.
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B-4 ADDITIONAL TOOLS FOR COMPARING SCENARIOS

B-4.1 OVERVIEW

The Modelinterface provides a variety of features for examining the differences from one scenario to another.
Several examples were provided earlier in this tutorial, including transposing plots so to compare data by series
and creating “difference” graphs. These options are particularly useful if you know ahead of time which results you
would like to examine. However, in some instances, it may be difficult to determine where to get started. Helping
identify major changes between scenarios is a strength of the “Diff Query” feature, which is discussed here.

B-4.2 USING THE DIFF QUERY

Using the “Diff Query” is similar to executing a query using the “Run Query” button.

First, select the scenarios and regions of interest. Here, we have selected GLIMPSE-1.1-Ref and our new carbon tax
scenario from Tutorial Part 3. For this demonstration, we will start with examining national totals, so select all of
the states and the USA region, then check the box next to “Total.”

The “Diff Query” option can be used for any query, but it is often most useful for queries that return results across
many sectors, including “Inputs by tech,” “Outputs by tech,” and “Prices for all markets.” For this tutorial, we have
chosen “Outputs by tech.”

Figure B-4.1: Selecting the "outputs by tech" query.
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Next, press the “Diff Query” button. After several seconds, a dialog will appear that provides options for how you
would like differences to be displayed.

The top area is where you select the which scenario differences will be calculated. Below that area, you can select
the smallest difference value (Minimum value) and smallest percent difference (Minimum percent) that you are
willing to display. Differences that do not meet these criteria are not displayed.

The final option allows you to display the query results as values or percent differences.
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Figure B-4.2: Selecting Diff Query options, including the Reference, difference criteria, and whether to
report differences as percents.
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Here, parameters that differ at least by “0.00001” and “30%” at some point over the modeled time horizon are
shown in the table as percent changes from GLIMPSE-1.1-Ref. Note that instances involving divide-by-zero are
reported as “1000” in the table.

Figure B-4.3: Diff Query results shown as percents.
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The items and values in the table provide valuable insights into the model’s response to the carbon tax. For
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example, by 2050 water heating by heat pumps has increased in the residential sector by 72% and 62% in the

commercial sector.

Applying the “Diff Query” to prices can also provide valuable insights. Prices are not additive (if a good is $1/unit in
state A, and $4/unit in state B, the sum of those values would not be $5/unit), however, so it is recommended that
the “Diff Query” be applied to prices for a single state or region at a time.

Here, we are examining the change in “Building service costs” in North Carolina, using a minimum percent

difference of 15%. These results could be useful from a policy design standpoint, particularly in determining how

carbon tax proceeds could be allocated to reduce impacts.

Figure B-4.4: Differences in energy service costs in buildings.
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B-4.3 ADDITIONAL ANALYSIS SUGGESTIONS

Use “Diff Query” to uncover to examine technology changes in the residential, commercial, and transportation

sectors.

If you apply the “Diff Query” to emissions by sector or emissions by technology, what do the results tell you about

potential low-hanging fruit for mitigating CO2 emissions?

Try graphing “value” and “percent” results of the “Diff Query.”
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B-5 MODELING AN EV MARKET SHARE TARGET

B-5.1 OVERVIEW

In this part of the tutorial, we use a combination of GLIMPSE’s “Market Share” and “Tech Avail” features to
simulate a scenario in which the EV sales share for onroad passenger cars and trucks increases to 100% nationally
by 2050.

B-5.2 CONSTRUCTING THE EV SALES TARGET COMPONENTS

Implementing the electrification target requires two steps: representing the market share constraint and adding a
complementary measure to eliminate non-EV technologies.

B-5.2.1 INTRODUCING A MARKET SHARE CONSTRAINT

We will begin by creating EV market share targets for passenger cars and trucks.

In the Scenario Builder, click on ”+ ” button to open the New Scenario Component Creator dialog, then click on
the “Market Share” tab.

Select the pulldown menu next to “Type?”. The menu shows several types of market share constraints, including a
Renewable Portfolio Standard (RPS), Clean Energy Standard (CES), and EV targets for various vehicles classes and
combinations, as well as options for light-emitting diodes (LEDs) and heat pumps.

Figure B-5.1: Options available in the “Type?” pulldown menu of the “Market Share” tab.
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Select the “EV passenger cars and trucks” category.

This selection results in the “Subset” and “Superset” pulldown menus being populated. Check the settings in those
pulldown menus.
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The “Subset” menu shows all “Car”, “Large Car and Truck” and “Mini-Car” technologies, but only the battery
electric vehicle (BEV) options have check marks next to them.

The “Superset” menu shows the same set of technologies, but all have checked boxes.

The selected items on these menus specify numerator (subset) and denominator (superset) for the market share
constraint. The settings were chosen automatically based on the “Type” selection. However, the specific
technology selections can be customized. For example, if you also want fuel-cell electric vehicles to be eligible to
meet the market share constraint, you can click the box next to the FCEV technologies in the subset menu.

Next, click on the “Constraint” pulldown menu. The options listed are “Lower” and “Fixed.” Choosing “Lower”
indicates that you would like the constraint to be a lower bound, meaning that GCAM can opt to exceed that
percentage. “Fixed” requires GCAM to hit the specified market share exactly, which can be more computationally
challenging. Select “Lower.”

Next, click on the “Applied to” pulldown menu. Here you have the option of applying the constraint to “All Stock”
or just to “New Purchases.” Select “New Purchases” since we are setting a sales target.

Then click on the “Treatment” pulldown menu. This allows the constraint to be applied “To Each Region” or
“Across Selected Regions.” The latter provides GCAM with more flexibility since it may choose to have some states
be above and others below the constraint as it seeks to hit the target at the lowest cost. Choose “Across Selected
Regions.”

Next, we will select the regions that will be constrained. On the tree at the right side of the dialog, click the triangle
next to the “USA” region. This will expand the region to show the 50 states and DC. The tree allows you to select
one or more constraints. In addition, the “Presets” option at the bottom will automatically check the boxes next to
specific regions, such as “New England,” “North America,” or “Europe.” Click on the check box next to “USA,”
which will select all the states.

The next step Is to populate the data table in the center of the dialog. One approach is to enter a year and value in
the text fields next to “Add,” then pressing the “Add” button. Alternatively, you can use the “Populate” options at
the bottom left to add data to the table. We use this approach in the tutorial.

Enter “2025” in the text field next to “Start Year.”
Next, for “Initial %" enter “15” and for “Final %” enter “100”

Press the “Populate” button, which will add your data to the table.
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Figure B-5.2: Options chosen for the passenger vehicle market share constraint.

| [ New Scenario Component Creator X
1 )
XML List | Pollutant Tax/Cap | Tech Avail | Market Share | Tech Bound | Tech Tax/Subsidy | Tech Param | Fuel Price Adj
|| Specification: Values:
{ Select region(s):
il Type? EV passenger cars and trucks hd giontsh
i Populate Delete Clear v B worki ~
Subset Filter:
Year Value ¥ ¥ USA
Subset: trn_pass_road_LDV_4W : Car: BEV : .. -
2025 0.150 M| AK |
Superset Filter: v AL |
2030 0.320
Superset: trn_pass_road_LDV_4W : Car: BEV : ... S v AR
2035 0.420
Constraint: Lower - V| AZ |
Applied to: New Purchases - 2040 0.660 M) CA
V| CO
Treatment: Across Selected Regions v 2045 0.830
v CT
Names: V| Auto? 2050 1.000 v DC
Policy: v DE |
Market: V| FL
v, GA
Populate:
v HI
Type: Initial and Final % v
v A
Start Year: 2025 v D
End Year: 2050 v IL
Initial (%): 15
o 100 hS Z Presets: Select (optional) -
inal (%):
Add
L J

| Save Close

Next, press the “Save” button to save this new policy representation to the Component Library. Name the new
component “EV-passenger-cars-and-trucks_All_Reg_100x50.csv”.

B-5.2.2 ADDRESSING NUMERICAL ISSUES USING TECH AVAIL

A next step could be to create a new scenario based upon GLIMPSE-1.1-Ref that includes the new policy
component. However, that scenario would experience solution problems in 2050 because of how the logit function
assigns market shares in GCAM (see Chapter 3 for a description of how the logit works). In summary, it is not
possible for GCAM to find a subsidy that would achieve a 100% market share since technology costs are
represented in the logit function as distributions with infinite tails. Instead, we must also introduce a
complementary measure that eliminates non-EV technologies in that year.

We can use a “Tech Avail” scenario component for this purpose. “Tech Avail” allows the range of years over which
a technology is available to be specified. For the years outside this range, the technology shareweight is set to zero
by GLIMPSE, effectively eliminating those technologies from their respective markets.

We start by filtering the list to show just the technologies within the passenger car and truck sector. From the
“Filter by Sector” pulldown menu, choose “trn_pass_road_LDV_4W.”
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The table is updated to show only the technologies available to the “Car,” “Large Car and Truck,” and “Mini Car”
categories. Only rows with checks in the “Never?” or “Range?” columns are being constrained, so currently all the
boxes are unchecked.

Clicking on the “Never?” checkbox the technology in that row is not available in any year. Clicking on “Range?”
results in the technology only being available between the “First” and “Last” years that are specified, inclusive of
those years.

Start by clicking the “Range” box next to all of the non-BEV technologies. Next, enter “2045” in the “Last yr”
textfield near the bottom and press “Set Years.” This will update the years for all technologies visible in the table.

Next, click on the checkbox next to the “USA” region.

Your dialog should look like this:

Figure B-5.3: “Tech Avail” setup to eliminate non-EV passenger car and trucks in 2050.
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Finally, press “Save” to save this new component to the Component Library. Name this component “EV-passenger-

cars-and-trucks_All_Reg_100x50-part2.csv”.

Add both “EV-passenger-cars-and-trucks_All_Reg_100x50.csv” and “EV-passenger-cars-and-
trucks_All_Reg_100x50-part2.csv” to GLIMPSE-1.1-Ref, then name the new scenario GLIMPSE1.1-PassEV100x50.
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Create the new scenario by pressing “ @".

When you are ready, add the scenario to the execution queue by pressing “ ”. After the scenario execution
completes successfully, move on to the next section of the tutorial.

B-5.3 VERIFYING THE PERFORMANCE OF THE POLICY

First, we will verify that the new policy files achieved their objective. Select the “GLIMSPE1.1-PassEV100x50”
scenario, select all states and the “USA” region, select the “Transport service output by tech (sales),” click on the
check box next to “Total,” then press “Run Query.”

After several moments the table will be populated with data representing new sales for each transportation
subsector (in units of capacity, which are million pass-km for passenger vehicles and million ton-km for freight).

We are interested in the “Car” and “Large Car and Truck” categories, so use the “Filter” option to view just those
subsectors. Note that the USA region of the model does not currently include “Minicar,” so there are no results for
that subsector.

Click “Graph” to visualize the data and choose “StackedBarChart” as the format.

Figure B-5.4: Sales (million pass-km) for the “Car” and “Large Car and Truck” transportation
subsectors.
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By examining the sales data, we can verify by that target was met.
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Table B-5.1: Onroad EV sales shares by subsector and total.

Category 2020 2025 2030 2035 2040 2045 2050

Car 1% 16% 32% 52% 71% 88% 100%
Large Car and Truck 1% 14% 32% 45% 58% 74% 100%
Total 1% 15% 32% 49% 66% 83% 100%

Note that while the overall sales target is met in each year, “Car” EV sales are greater than “Large Car and Truck.”
The bars for 2015 are considerably higher than the others because 2015 is the model’s calibration year and new
capacity added that year is equivalent to the entire stock.

Some interesting dynamics occurring in 2040 through 2050 in the “Large Car and Truck” subsector. We applied our
constraint across the “Car” and “Large Car and Truck” categories. However, there are differences in the costs of
electrifying vehicles in these two categories, resulting in GCAM choosing to electrify the “Car” category at a level
higher than the target and the “Large Car and Truck” at a level below the target. Furthermore, our constraint was
applied based on capacity in units of “million pass-km,” but cars are assumed to have an average ridership of 1.58
people per vehicle, while the “Large Car and Truck” ridership is assumed to be 1.66 people per vehicle. Finally,
note that our policy representation resulted in a small increase in the cost of onroad light duty travel, leading to a
small amount of mode switching to buses and motorcycles, as well as a small decrease in demand for passenger
travel overall.

B-5.4 EXPLORING THE RESPONSE TO THE EV MARKET SHARE TARGET

Based upon what you have learned through the course of these tutorials, explore the answers to some of the
following questions:

e How is electricity demand changing under this scenario?

e How is the additional electricity being produced?

e How is demand for refined liquids changing across sectors? Natural gas?

e How is refinery output changed? What is the impact on biofuel production?

e  What are the impacts on the price of electricity, refined liquids, and natural gas?

e How are CO2 emissions impacted overall and by sector? How about air pollutants?

Remember that it does not make sense to sum prices across states or regions.
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B-6 SIMULATING A NET-ZERO DECARBONIZATION TARGET

B-6.1 OVERVIEW

In this tutorial, you will use GLIMPSE to apply and evaluate a Net-Zero decarbonization target. The Net-Zero
trajectory was obtained from the Energy Modeling Forum 37 (EMF 37) exercise.® See Browning et al. (2023) for a
summary of EMF 37, including assumptions and results.>°

B-6.2 EXAMINING THE NET-ZERO TRAJECTORY

GLIMPSE’s Component Library includes the EMF 37 Net-Zero CO2 trajectory. In the Component Library, type “Net”
into the search text field to quickly find the component. Double-click “Policy-CO2Cap-netZero-after-land-sink-
2025start.csv” to open the component in a text editor.

From the meta-data at the top of the file, we can see that a cap on CO2 is applied across all sectors and states. The
cap begins with a value of 1160 MTC in 2025 and declines linearly to 218 MTC in 2050. Even through this is a Net-
Zero cap, CO2 emissions do not go entirely to zero because it is assumed that unmodeled land use change
practices would be able to achieve the remaining 218 MTC of reductions.

B-6.3 CONSTRUCTING AND RUNNING A NET-ZERO DECARBONIZATION SCENARIO

Move the GLIMPSE-1.1-Ref scenario to the Create Scenario pane of the Scenario Builder. Find the “Policy-CO2-Cap-
netZero-after-land-sink-2025start.csv” component in the Component Library and add this component to the Create
Scenario pane.

Next, find the “DeepDecarbonizationAssumptions.txt” scenario component in the Component Library and add that
to Create Scenario pane as well.

Double-click on the “DeepDecarbonizationAssumptions.txt” component to view it in an editor. You will see that
this component provides references several individual files located in the Contrib folder. Note that the list does not
include a file that represents direct air capture.

In the Component Library, search for “DAC” and add the “Tech-DAC.txt” file to your scenario.

Provide a new name for the scenario, such as “GLIMPSE-1.1-NetZero” then press the “Create Scenario” button to
add the new scenario to your Scenario Library. Use GLIMPSE to evaluate the scenario in GCAM-USA.

B-6.4 SUGGESTIONS FOR ANALYSIS

In the GLIMPSE Modellnterface, use the available queries to answer each of the following questions.
e Did GCAM-USA successfully meet the Net-Zero target trajectory?
e  From which sectors are CO2 emissions reductions being achieved?

e How did the total quantity of electricity that was produced change from the Reference scenario to the
Net-Zero scenario?

38 https://emf.stanford.edu/emf-37-deep-decarbonization-high-electrification-scenarios-north-america
39 https://www.sciencedirect.com/science/article/pii/S2666278723000119
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e How does the mix of electric sector technologies change between the Reference and Net-Zero scenarios?

e Examine electricity use by sector to examine the degree to which various sectors are turning toward
electricity for decarbonization.

e  Which technologies in the buildings and transportation sectors benefit the most (e.g., that show the
greatest increase in output) under the Net-Zero target? Which technologies see their adoption decline the
most?

e Does biomass use increase under the Net-Zero target? In which sectors is it being used and for what
purposes?

e How did hydrogen respond to the Net-Zero target? Which technologies are using hydrogen? How is
hydrogen being produced?

e How are refined liquids being production changing under the Net-Zero target? Which technologies play a
greater role in refined liquids production?

e  What are the air pollutant emissions implications associated with this Net-Zero pathway?

B-6.5 CONSTRUCT AN ALTERNATIVE TECHNOLOGY PATHWAY FOR DECARBONIZATION

A strength of GLIMPSE is that users can readily develop alternative scenarios, modifying assumptions. In this next
exercise you will create an alternative Net-Zero pathway that does not rely on CCS or on DAC.

First, begin with the GLIMPSE-1.1-NetZero scenario and remove the “DAC.txt” component from it.

Next, remove CCS options from the scenario. A Scenario Component already exists for this. Search the Component
Library for “CCS” and one of the options that is listed is “Tech-NoCCSinUSA_SW.csv”. This option eliminates CCS
technologies by setting their shareweights to zero. View the component’s meta-data by double-clicking the file.

Add the component to your scenario, give the scenario a new name, such as “GLIMPSE-1.1-NetZero-NoDACorCCS”.
Create, then run the scenario.

B-6.6 DEBUGGING UNSOLVED MARKETS

The Net-Zero target can be challenging for GCAM-USA to solve, particularly when options such as CCS and DAC are
not available. In developing this tutorial, GLIMPSE reported unsolved markets in 2030. Sometimes unsolved
markets indicates that the scenario itself is problematic (e.g., it includes constraints that cannot be met). Other
times, however, unsolved markets can be an artifact of minor numerical errors introduced in the solution process.
If small enough, these errors may not have been reported as errors were it not for the tight solver tolerances
needed to solve state-level market share constraints. As a result, very small errors can often be ignored.

If GLIMPSE reported unsolved markets, you can view an error report for the run. Click on the scenario name, then

-".
press the “Errors-Selected” button, Eﬂ . This action analyzes the scenarios “main_log.txt” file, extracting all
errors from the file. Please see section 4.3 for a description of how to interpret the error report.

A report for this scenario will produce a report similar to the screenshot below:
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Figure B-6.1: Example of the table used to report market solution errors.

I8! Error Report
GLIMPSE-1.1-NetZero-Period 7, 2030

GLIMPSE-1.1-NetZero:ERROR Medel did not solve period 7 within set iteration 10103

GLIMPSE-1.1-NetZero:ERROR Currently Unsolved Markets
GLIMPSE-1.1-NetZero:ERROR,Unsolved Part 1, Solvable Markets
GLIMPSE-1.1-NetZeroERRORX, XL, ¥R  ED, EDL EDR  RED,

brk, Supply, Demand, Mrk Type, Market,

GLIMPSE-1.1-NetZero:ERROR5.63559 , 5.63559 , 563559 ,-0.0157631, 0.0063687 , 00063687, 0.00177123, 0 ,8.91527 , 88995 ,Normal , Central East gridonshore carbon-storage,

3 GLIMPSE-1.1-NetZero:ERROR.1.46812e-08, 1.46753e-08, 1.46753e-08, -1.12055e-06, 5.49591e-06, 5.49591e-06, 0.00122389, 0 , 0.00091669, 0.000915569, Normal , AKPV_resource
‘GLIMPSE-1.1-NetZero:ERROR,0.0468481 , 0.0468291 , 00468291, -5.72671e-05, 0.000277672, 0.000277672, 0.0012239,0 , 0.0468481, 0.0467908 , Trial-Value, Alaska gridsolar-trial-supply '
‘GLIMPSE-1.1-NetZero:ERROR.0.14217 ,0.142114 , 0.142114 , -0.000177685, 0.000706462, 0.000706462, 0.00125137, 0 ,0.14217 ,0.141993 | Trial-Value, Central Southwest gridsolar-trial-supply,
GLIMPSE-1.1-NetZero:ERROR,7.13222¢-05, 7.12938e-05, 7.12938e-05, -7.59288e-06, 3.39298e-05, 3.39298-05, 0.00134545, 0 , 0.00565095, 0.00564336, Normal , KSPV_resource

| GLIMPSE-1.1-NetZero:ERROR,0.00111289, 0.00111244, 0.00111244, -6.35017e-05, 0.000248652, 0.000248652, 0.00133162, 0 , 0.0477511, 0.0476876 , Normal , OKPV_resource
GLIMPSE-1.1-NetZero:ERROR,0.00154779, 0.00154717, 0.00154717, -0.000269788, 0.00137725, 0.00137725, 0.00100821, 0 ,0.267861 ,0.267591 , Normal , TXPV resource

| GLIMPSE-1.1-NetZero:ERROR,1.9022 , 1.90297 , 1.90297 , 0.0316017, -0.038846, -0.038846 , 0.0011768, 0 , 26.8222 , 268538 , Normal , USAnatural gas

GLIMPSE-1.1-NetZera:ERROR.0.000390554, 0.000390398, 0.000390398, -4.66563e-05, 0.000246163, 0.000246163, 0.0010001

0, 0.0466647 , 0.0466181, Normal , TXCSP_resource .

| GLIMPSE-1.1-NetZero:ERROR,0.000330173, 000035004 0.00033004, -1.1958%-05, 5.11224e-05, 5.11224e-05, 0.00127268, 0 , 0.00940862, 0.00939666, Normal , OKCSP_resource

‘GLIMPSE-1.1-NetZero:ERROR,15.853 1

158524 , -0.0435111, -0.0749716, -0.0749716, 000741635, 0 ,5.91043 , 586691 , Normal , Central Northwest gridonshore carbon-: s(oreg?

GLIMPSE-1.1-NetZero:ERROR.9.68312 .9.58298 . 9.68298 , -0.0062894, -0.00442986, -0.00442986, 0.00356101, 0 , 1.77248 , 1.76619 , Normal , Central Southwest gridonshore carbon-storage,
GLIMPSE-1.1-NetZera:ERROR,1.15649 , 1.1491 , 1.1491 , -0.0429184, 0.0877668 , 0.0877668 , 0.00746302,0 , 5.79373 , 575081 , Normal , USAbiomass

GLIMPSE-1.1-NetZera:ERROR, Unsalved Part 2, Unsolvable Markets Not Cleared
‘GLIMPSE-1.1-NetZero:ERROR X, XL, XR, ED, EDL, EDR, RED,
GLIMPSE-1.1-NetZero:ERROR,

GLIMPSE-1.1-NetZera:Period 8, 2035

‘GLIMPSE-1.1-NetZero-Period 9, 2040

GLIMPSE-1.1-NetZero:Period 10, 2045

GLIMPSE-1.1-NetZera:Period 11, 2050

Evaluation:

Total errors=23

Major errars (>5.0%)=0

Moderate errors (>1.0%)=0

Small market errors (DMD <1.0€4)=
>>»>Verdict: Pass? (all errors are minor)

‘GLIMPSE-1.1-NetZero:ERROR,12.1709 , 121708 , 121708 , -0.0196431, 0.0159679, 00159679, 000228189, 0 ,8.6279 ,B.60826 ,Normal , Southeast gridonshore (arhun storage,
GLIMPSE-1.1-NetZero:ERROR,10.0161 , 10.0161 , 10.0161 ,-0.00160181, 0.0143133, 0.0143133, 000134355, 0 ,1.19382 , 1.19222 ,Normal , Florida gridonshore carbon-storage ,
GLIMPSE-1.1-NetZera:ERROR.20.8411 ,20.7082 , 20.7082 . -0.0250535, 0.0621782 , 0.0621782 , 0.00120357, 0 .20.8411 ,20816 .Demand ., USAtraded biomassDemand int .
GLIMPSE-1.1-NetZero:ERROR,1.45114 , 1.45058 , 1.45058 , -0.00396217, 0.00239971, 0.00239971, 0.00207652, 0 , 1.91204 , 1.90808 , Normal , California gridonshere carbon-storage,
GLIMPSE-1.1-NetZero:ERROR41.8352 , 41.8351 , 41.8351 , -0.00045393, -0.000948616, -0.000948616, 0.00353545, 0 ,0.128848 , 0.1283%4 , Normal , New England gridonshore carbon-storage.
GLIMPSE-1.1-NetZero:ERROR,5.76422 ,5.7708 , 57708 ,0.0231932, 0.00631338, 0.00631338, 0.00400752, 0 ,5.76422 , 578742 ,Price , USArefining
GLIMPSE-1.1-NetZero:ERROR,7.51964 ,7.51948 , 7.51948 , -0.0223037, -0.0267044, -0.0267044, 0.00345102, 0 , 648524 6646294 ,Normal , Central Northeast gndcnshcre carbon-storage,
GLIMPSE-1.1-NetZero:ERROR,11.0028 , 11.0024 , 11.0024 , -0.0113183, -0.00960317, -0.00960317, 0.002965 , 0 ,3.82862 ,3.81731 , Normal , Northwest gridonshore carbon-storage,
GLIMPSE-1.1-NetZero:ERROR17.979 ,17.979 |, 17.979 , -0.00102991, -0.000926843, -0.000926843, 0.00222924, 0 , 0463031 , 0462001 , Normal , New York gridonshore carbon-storage ,
GLIMPSE-1.1-NetZero:ERROR,5.01745 ,5.01738 , 5.01738 ,-0.0201973, -0.00775148, -0.00775148, 0.00298756, 0 , 6.78067 , 6.76047 , Normal , Texas gridonshore carbon-storage

brk, Supply, Demand, Mrk Type, Market,

Close

In this screenshot, twenty-three errors occurred in period 7, which is 2030. Comparing the values in the “Supply”

and “Demand” columns indicates that the errors were relatively small. The evaluation area at the end of the report

indicates that all of the errors were less than 1% and suggests that it may be possible to interpret the run as having

been successful.

A final step would be to evaluate the model outputs, looking for odd behavior (e.g., unexpected inflection points)

in the year 2030.

B-6.7 SUGGESTIONS FOR ANALYSIS

Use the GLIMPSE Modelinterface to explore how the results obtained in Section B-6.4 change when DAC and CCS

technologies are not available.
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